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About

Copyright

The information contained in this User Guide regarding the use of
LogTag® Analyzer software is intended as a guide and does not
constitute a declaration of performance. The information contained in
this document is subject to change without notice. Unless otherwise
noted, the example companies, organisations, email addresses and
people depicted herein are fictitious, and no association with any real
company, organization, email address or person is intended or should be
inferred. Complying with all applicable copyright laws is the
responsibility of the user.

No representation or warranty is given and no liability is assumed by
LogTag® Recorders with respect to the accuracy or use of such
information or infringement of patents or other intellectual property
rights arising from such use or otherwise.

Copyright © 2004-2018 LogTag® Recorders. All rights reserved.
http://logtagrecorders.com

Disclaimer

The LogTag Analyzer monitors temperature exposure and not the
quality of the goods it accompanies. Its purpose is to signal if product
quality evaluation/testing is required.

LogTag Analyzer User Guide

Typographical Conventions

Text in this font refers to buttons on a LogTag® product.

Text in this font refers to actions to be taken in LogTag® Analyzer,

as clicking a button, icon or menu item.
Text HpRiplSN{ly describes features of a LogTag® product.

An icon or menu in grey colour cannot be clicked and its
function is not available at this time.

An icon or menu in the theme colour can be clicked and its
function is available.
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to get extra information.

Text like this gives you tips on how to simplify tasks and how

Text like this highlights notes and key information that you
should be aware of.

Text like this shows important information about issues that

could cause you to inadvertently lose data.

Text in this font refers to features, tabs or dialogue boxes.

Links or references to other part in this document appear like this.
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Software License

To use the software you must agree to the license terms set out below.
LOGTAG RECORDERS END-USER LICENSE AGREEMENT

YOU SHOULD CAREFULLY READ THE FOLLOWING TERMS AND CONDITIONS BEFORE USING THIS
PRODUCT. IT CONTAINS SOFTWARE, THE USE OF WHICH IS LICENSED BY LOGTAG RECORDERS, TO ITS
CUSTOMERS FOR THEIR USE ONLY AS SET FORTH BELOW. IF YOU DO NOT AGREE TO THE TERMS AND
CONDITIONS OF THIS AGREEMENT, DO NOT USE THE SOFTWARE. USING ANY PART OF THE SOFTWARE
INDICATES THAT YOU ACCEPT THESE TERMS.

LICENSE: LogTag Recorders grants you a personal, limited, non-exclusive license to use the accompanying
software program(s) (the "Software") subject to the terms and restrictions set forth in this License
Agreement. You are not permitted to lease or rent (except under separate mutually agreeable terms set forth
in writing), distribute or sublicense the Software or to use the Software in a time-sharing arrangement or
in any other unauthorized manner. Further, no license is granted to you in the human readable code of the
Software (source code). Except as provided below, this License Agreement does not grant you any rights to
patents, copyrights, trade secrets, trademarks, or any other rights in respect to the Software.

The Software is licensed to be used on any computing device. You may reproduce and provide one (1) copy
of such Software for each computing device on which such Software is used as permitted hereunder.
Otherwise, the Software and supporting documentation may be copied only as essential for backup or
archive purposes in support of your use of the Software as permitted hereunder. You must reproduce and
include all copyright notices and any other proprietary rights notices appearing on the Software on any
copies that you make.

NO ASSIGNMENT; NO REVERSE ENGINEERING: You may transfer the Software and this License Agreement
to another party if the other party agrees in writing to accept the terms and conditions of this License
Agreement. If you transfer the Software, you must at the same time either transfer all copies of the Software
as well as the supporting documentation to the same party or destroy any such materials not transferred.
Except as set forth above, you may not transfer or assign the Software or your rights under this License
Agreement.

Modification, reverse engineering, reverse compiling, or disassembly of the Software is expressly
prohibited. Analyzing the input to and output from the Software is expressly prohibited except when this is
done solely to evaluate the subjective quality of the Software's visual and data analysis processes. You may
not otherwise modify, alter, adapt, port, or merge the Software except as specified in this License
Agreement.

EXPORT RESTRICTIONS: You agree that you will not export or re-export the Software or accompanying
documentation (or any copies thereof) or any products utilizing the Software or such documentation in
violation of any applicable laws or regulations of the United States or the country in which you obtained
them.

TRADE SECRETS; TITLE: You acknowledge and agree that the structure, sequence and organization of the
Software are the valuable trade secrets of LogTag Recorders and its suppliers. You agree to hold such trade
secrets in confidence. You further acknowledge and agree that ownership of, and title to, the Software and
all subsequent copies thereof regardless of the form or media are held by LogTag Recorders and its
suppliers.

TRADEMARKS AND COPYRIGHTS: "LogTag®" is a registered trademark (R) of LogTag Recorders. You may
not remove, alter, deface, overprint, or otherwise obscure any LogTag Recorders trademark, service mark,
or copyright notices included with this Software.

INTELLECTUAL PROPERTY: All intellectual property rights in and to this Software are and shall remain in
LogTag Recorders.

TERM AND TERMINATION: This License Agreement is effective until terminated. You may terminate it at any

time by destroying the Software and documentation together with all copies and merged portions in any
form. It will also terminate immediately if you fail to comply with any term or condition of this License
Agreement. Upon such termination you agree to destroy the Software and documentation, together with all
copies and merged portions in any form.

GOVERNING LAW: This License Agreement shall be governed by the laws of the State of California and by
the laws of the United States, excluding their conflicts of law principles. The United Nations Convention on
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Contracts for the International Sale of Goods (1980) is hereby excluded in its entirety from application to
this License Agreement.

LIMITED WARRANTY; LIMITATION OF LIABILITY: EXCEPT AS EXPRESSLY PROVIDED OTHERWISE IN A
WRITTEN AGREEMENT BETWEEN LOGTAG RECORDERS AND YOU, THE SOFTWARE IS NOW PROVIDED "AS
IS" WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED
TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE, OR
THE WARRANTY OF NON-INFRINGEMENT. WITHOUT LIMITING THE FOREGOING, LOGTAG RECORDERS
MAKES NO WARRANTY THAT (i) THE SOFTWARE WILL MEET YOUR REQUIREMENTS, (ii) THE USE OF THE
SOFTWARE WILL BE UNINTERRUPTED, TIMELY, SECURE, OR ERROR-FREE, (iii) THE RESULTS THAT MAY
BE OBTAINED FROM THE USE OF THE SOFTWARE WILL BE ACCURATE OR RELIABLE, (iv) THE QUALITY
OF THE SOFTWARE WILL MEET YOUR EXPECTATIONS, (v) ANY ERRORS IN THE SOFTWARE WILL BE
CORRECTED, AND/OR (vi) YOU MAY USE, PRACTICE, EXECUTE, OR ACCESS THE SOFTWARE WITHOUT
VIOLATING THE INTELLECTUAL PROPERTY RIGHTS OF OTHERS. SOME STATES OR JURISDICTIONS DO
NOT ALLOW THE EXCLUSION OF IMPLIED WARRANTIES OR LIMITATIONS ON HOW LONG AN IMPLIED
WARRANTY MAY LAST, SO THE ABOVE LIMITATIONS MAY NOT APPLY TO YOU. IF TEXAS LAW IS NOT
HELD TO APPLY TO THIS AGREEMENT FOR ANY REASON, THEN IN JURISDICTIONS WHERE WARRANTIES,
GUARANTEES, REPRESENTATIONS, AND/OR CONDITIONS OF ANY TYPE MAY NOT BE DISCLAIMED, ANY
SUCH WARRANTY, GUARANTEE, REPRESENTATION AND/OR WARRANTY IS: (1) HEREBY LIMITED TO THE
PERIOD OF EITHER (A) THIRTY (30) DAYS FROM THE DATE OF OPENING THE PACKAGE CONTAINING THE
SOFTWARE OR (B) THE SHORTEST PERIOD ALLOWED BY LAW IN THE APPLICABLE JURISDICTION IF A
THIRTY (30) DAY LIMITATION WOULD BE UNENFORCEABLE; AND (2) THE SOLE LIABILITY OF LogTag
Recorders. FOR ANY BREACH OF ANY SUCH WARRANTY, GUARANTEE, REPRESENTATION, AND/OR
CONDITION SHALL BE TO PROVIDE YOU WITH A NEW COPY OF THE SOFTWARE.

IN NO EVENT SHALL LOGTAG RECORDERS OR ITS SUPPLIERS BE LIABLE TO YOU OR ANY THIRD PARTY
FOR ANY SPECIAL, INCIDENTAL, INDIRECT OR CONSEQUENTIAL DAMAGES OF ANY KIND, OR ANY
DAMAGES WHATSOEVER, INCLUDING, WITHOUT LIMITATION, THOSE RESULTING FROM LOSS OF USE,
DATA OR PROFITS, WHETHER OR NOT LOGTAG RECORDERS HAD BEEN ADVISED OF THE POSSIBILITY
OF SUCH DAMAGES, AND ON ANY THEORY OF LIABILITY, ARISING OUT OF OR IN CONNECTION WITH
THE USE OF THE SOFTWARE. SOME JURISDICTIONS PROHIBIT THE EXCLUSION OR LIMITATION OF
LIABILITY FOR CONSEQUENTIAL OR INCIDENTAL DAMAGES, SO THE ABOVE LIMITATIONS MAY NOT
APPLY TO YOU. THESE LIMITATIONS SHALL APPLY NOTWITHSTANDING ANY FAILURE OF ESSENTIAL
PURPOSE OF ANY LIMITED REMEDY.

SEVERABILITY: In the event any provision of this License Agreement is found to be invalid, illegal or
unenforceable, the validity, legality and enforceability of any of the remaining provisions shall not in any
way be affected or impaired and a valid, legal and enforceable provision of similar intent and economic
impact shall be substituted therefore.

ENTIRE AGREEMENT: This License Agreement sets forth the entire understanding and agreement between
you and LOGTAG RECORDERS, supersedes all prior agreements, whether written or oral, with respect to the
Software, and may be amended only in a writing signed by both parties.

The software menus and texts as well as this agreement have been created in English and any other language
versions have been translated from the English version. In the event of a dispute, reference should be made
to the English language version, which is conclusive.

For further information about licensing please email licensing@logtagrecorders.com.



Chapter 1
Introduction

LogTag® Analyzer version 3 is a redevelopment of the current LogTag® Analyzer 2.x software, using Microsoft’s .NET technology.

It also allow easier integration into third-party developments and enables a path for supporting modern operating systems and multiple computing
platforms in the future, such as Linux or macOS.

Most aspects of the new version 3 have been kept the same as previous versions. If you are familiar with version 2.x, you will find it easy to make the
transition to version 3.x. There are a few new concepts, which you can find by browsing the pages in this User Guide. The main differences are listed in
the introductory guide What's new in LogTag Analyzer 3, available from http://logtagrecorders.com.

This guide will take you through the relevant steps to successfully use the LogTag® products. You will learn how to...
install the software,
configure LogTag® products for recording,
retrieve the recorded readings,
display and analyse the data and
configure the available options in the software so you can make best use of its features.

If you are an experienced users of a previous versions, you may skip some of the early chapters, if, however, you are about to use a newer version of a
LogTag® product or Interface Cradle we recommend you at least skim the installation chapter for any relevant changes.

This guide covers version 3.0 of the LogTag® Analyzer software. If you are unsure which version you are currently using, please read the section about
Finding your software version on page 19.

If you find a feature described in this guide that does not appear in your software, we recommend you update it as explained in the section about
Upgrading LogTag® Analyzer on page 20. You can always get the most up to date version of LogTag® Analyzer from the LogTag® Recorders website at
http://logtagrecorders.com.

This guide includes all the relevant information to install and use the product range supplied by LogTag® Recorders, however, the reader is expected to
be familiar with using a computer and the Windows® operating system.
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The LogTag® Recording System

LogTag® Recorders offer a range of recorder and indicator products for temperature and
humidity, which are complemented by software and interface products. Some of these products
can be used on their own, most often, however, you will use a combination of products to get
the best results.

LogTag® Recorders offer a variety of different models. The product range is constantly being
updated and new models added, so visit the LogTag® Website at http://logtagrecorders.com
frequently to get the latest information and news about upcoming product releases.

Typically LogTag® products are configured, put with goods that require monitoring and are
downloaded once the goods reach their intended destination.

Other applications may involve stationary recorders placed in warehouses or fridges, such as
the Vaxtag®, as can be seen here.

page 10
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Figure 2: Example of a stationary recorders application
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Recorders

LogTag® temperature and humidity recorder products are small, battery powered, credit card
size devices with built-in sensors and data logging memory. They record between 4,000 and
16,000 samples from anywhere between -80°C and +100°C, depending on the model. For
detailed information about each product visit the LogTag® Recorders website at
http://logtagrecorders.com/products

Indicators

LogTag® temperature indicators are even smaller devices, also battery powered, and contain a
statistics memory which can contain minimum and maximum values from anywhere between
20 days and three years. They feature a display for a quick assessment if goods have been
exposed to temperatures outside pre-configured temperature limits.

Software

Recorders and Indicators are downloaded using the LogTag® Analyzer software, which is also
used to configure recorders. This User Guide explains in detail how to configure and download

recorders and indicators, how to customise the settings and how to analyse and share the data.

START
sToe

S 1000005 @
LU TR o

Figure 4: Some of LogTag®s indicator products
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Interfaces LogTag

Unless your product is one of the USB Recorders you will need an interface to communicate TEMPERATURE RECORDER
between the recorder or indicator and the computer.

Recorders and indicators use two different types of interface cradle.

Most products use the standard interface cradle, where the LogTag® is inserted into the slot
from the top as shown to enable communication. You will be able to see the contact pins inside
the slot that meet with the matching contact pads on the LogTag®. When inserting a LogTag®
into the slot you feel a slight resistance as the contacts engage. Removing the LogTag® will
cause a slight clicking noise as the contacts snap back into their unloaded position.

The indicator products TIC20 and TICT use a special cradle in which the contact pins are exposed
at the top. To enable communication locate the indicator's lug on the interface's boss and
firmly press it down, so the contact pins pierce through the rear label. When using the TICT,
please remove the adapter from the bottom of the interface and place it as shown; this helps
correctly locating the contact pins.

New in 2018, the LTI/HID is the next generation USB interface that can be installed without
requiring a proprietary driver. It also features two indicators at the top (red & green), which
identify what actions the interface is currently performing.

Figure 6: TICT in LTI/USB-TICT interface cradle

Figure 7: New USB Interface LTI/HID

page 12
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Installing the software

To use your LogTag® products you need to install LogTag® Analyzer on your computer. This will
allow preparing your LogTag® for recording, downloading, analysing and sharing the data.

Experienced users may choose to skip this chapter. You should read it, however, if you are new
to using a computer or installing software.

System requirements

To ensure that the software will work on your computer following minimum specifications are
required:

PC capable of running Windows® 7 or later, or Windows® 2008 Server or later

60MB free disk space (plus 30MB if .NET is not yet installed)

Internet Explorer 8.0 or later

1 available serial port or 1 available USB port, depending on purchased interface
1024 x 768, or higher, screen resolution.

256 screen colours

The recommended specifications are:

Processor equivalent to Pentium IV or later
512MB of available RAM

Internet Explorer 9.0 or later

65535 (16bit), or more, screen colours.

If you are unsure of your computer's specifications, please refer to your operating system's
documentation or help function.
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Getting a copy of the software

The software can be download from the from the LogTag® Recorders website; navigate to
http://logtagrecorders.com/software/lta2/download and click the LogTag® Analyzer 3 link. .

Complete the registration details and click [Download ]
LogTag® Analyzer is available for download in a number of different formats:

ltanalyzer_30r8.exe

This is a single executable installer file and the most popular option; no other files are
required for installation of LogTag® Analyzer software on your computer.

ltanalyzer_30r8.msi

This file is used by Network Administrators - it requires additional files and is best suited
when distributing the software remotely to a number of PC's.

ltanalyzer_30r8.zip

You can download a zipped version of the file, which has a smaller download size. You will
need an unzipping tool such as Winzip® to extract the single executable installer.

ltanalyzer_30r18.iso

The ISO file can be used to generate a CD, if you need to distribute the software to PC's
without a network connection.

Click on the desired download link. Depending on the type of browser and its version you may
get different windows to start and process the download. Modern browsers like Edge, Internet
Explorer, Google Chrome or Mozilla Firefox typically have a special directory into which all
downloads are copied, but you can also select your own.
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Figure 9: Downloading using Internet Explorer

Opening ltanalyzer_30r8.exe 'El [
You have chosen to open
[57 ianalyzer_30r8.exe

which is a: Binary File (21.3 MB)
from: http://http://logtagrecorders.com

Would you like to save this file?

Save File | [ Cancel ]

Figure 10: Download Window - Mozilla Firefox
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unaltered, in the packaged format as originally downloaded from the LogTag® Analyzer website.
Itanalyzer_30rfexe L Pause Cancel
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Figure 12: Download progress using Firefox

? chrome

": Itanalyzer_20v8.exe

Figure 13: Download progress using Chrome



Introduction

The installation process

You will require local administrator permissions for the PC on which

you are installing LogTag® Analyzer.

To install the LogTag® Analyzer software, locate the installation file
downloaded in the previous step and execute it (typically by double
clicking or selecting the file in Windows® Explorer and pressing Enter).
To proceed through each step of the installation process, click. If
you want to change a previous step you can click. At any stage
during the process, if you want to stop installing the software, click
dCanceI |

1. Select the installer language

B LogTag Analyzer Setup

Please select a language:

H English {United States) v
o] | oo
2. Accept the Welcome screen by clicking .
E LogTag Analyzer Setup

Welcome to the LogTag
Analyzer Setup Wizard

The Setup Wizard will install LogTag Analyzer version
3.0.6. 14 on your computer. Click Next™ to continue or
“Cancel” to exit the Setup Wizard,

< Badk Next > Cancel

LogTag Analyzer User Guide

3. Accept the End-User License Agreement and click

B LogTag Analyzer Setup x
End-User License Agreement
Please read the following license agreement carefully

Last updated: 1 December 2014

LogTag Analyzer License

LOGTAG RECORDERS LIMITED END-USER LICENSE
AGREEMENT

(@) 1 aecept the terms in the License Agreement

() 1 go not accept the terms in the License Agreement

< Back Next > Cancel

4. Select the installation folder. You can type a folder name or

page 16

browse to an existing folder. If the folder does not exist, it will be

created for you.

B LogTag Analyzer Setup = =
Select Installation Folder
This is the folder where LogTag Analyzer will be installed.
To install in this folder, dick Text™. To install to a different folder, enter it below or dick
owee”,
Folder:
Ct\Program Files (x86)\.ogTag Recorders\LogTag Analyzer3\ Browse...
< Back Mext = Cancel
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Note: You can change the document storage location in LogTag®
Analyzer 's option settings once you have started the program,
but you cannot change the program location. We recommend
you leave all options at their default setting, especially if you
are unsure of what option to select or what effects changing the
option would have.

5. Select, which files you wish to associate with LogTag® Analyzer
(these files will, for example, automatically open in LogTag®
Analyzer when you double-click them in Windows Explorer).

. If you are installing LogTag® Analyzer for the first time we
suggest you select all file types.

« If you are upgrading from version 2, and you do not wish to
use version 2 any longer, you should also select all file types.

« If you are upgrading from version 2, and you are planning on
operating both versions, you can decide if you wish to
associate the files in the right column with the new version
(select those file types) or leave them associated with the
older version (clear those file types).

You can change this later by right-clicking a file, and clicking

Open with.

Click once you have made your selection.

LogTag Analyzer User Guide page 17

B LogTag Analyzer Setup x
Select File Associations
Select the extensions you want assodated with LogTag Analyzer

Please select the file types you want to automatically open with LogTag Analyzer:

A1 i O .sitd

B .muttix O .aswml
.
O mudt

< Back Next > Cancel

The installer now has all the information and is ready to proceed.

Click to start the installation.

B LogTag Analyzer Setup x
Ready to Install
The Setup Wizard is ready to begin the LogTag Analyzer installation

Click "Instal™ to begin the installation, If you want to review or change any of your
installation settings, dick "Back”, Click "Cancel” te exit the wizard.

< Back [ mstal | | Cancel
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7. The installer is copying the required files to your PC. through the Microsoft Windows® Update feature, as an optional

hardware update, or as part of an upgraded installer file (see Upgrading

LogTag® Analyzer on page 20).

Installing LogTag Analyzer H Once the installation process has completed the installer file is no
longer required and can safely be deleted.

B LogTag Analyzer Setup x

Please wait while the Setup Wizard installs LogTag Analyzer. This may take several
minutes.

Status: Extracting files from archive
|

8. When the installation is complete, click to exit the installer
program.

B LogTag Analyzer Setup X

Completing the LogTag
Analyzer Setup Wizard

Chck the "Finish” button to exit the Setup Wizard.

The drivers required to operate your USB interface are installed as part
of the main installation process. From time to time updated drivers
may be released by LogTag® Recorders. These drivers will be available
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Finding your software version

Click the About LogTag® Analyzer... command in the Help Menu to display the About window.

This window displays the full version number of the software being used. You can use this to B About Analyzer 3.0.6
check if the same software version is installed on multiple computers or to find out which user

guide to use.

. . o -
When the software is updated, the version number of the software is increased. . Logqu Anqlgzer

You can also find major and minor version of LogTag® Analyzer in the title bar:
Version 3.0.6

LogTag Analvzer software provides an easy o use,

powerful platform for configuring, downloading and
displaving data from LogTag products.

- 0O

LogTag Analvzer
LogTag Recorders Ltd
Copyright (c) 2002-2016,LogTag Recorders Ltd

Close ‘ ’7 Help ‘

Figure 14: About LogTag® Analyzer
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Upgrading LogTag® Analyzer

LogTag® Recorders will publish updates to LogTag® Analyzer to introduce new or enhanced
features, or to support new LogTag® models. LogTag® Recorders recommend that you always
use the latest version of the software.

When you first install LogTag® Analyzer, the Automatic Updates function is enabled, which
means you will automatically be notified when an update is available. When the notification is
displayed, you can choose whether or not you wish to download and update the software at this
stage.

If you have disabled the automatic update function you can still get updates via the Help menu
by clicking Check Internet for updates. Neither of these two options will transmit any
information about you or your system to LogTag® Recorders, so you can rest assured your
privacy is maintained.

To download the update click on . The download progress will be displayed and you
will be notified when it is complete.
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4 newer version of Analyzer (3.0 Build 4) is available for downboad. Click the = Download™ button if you want
ta download the saftware now.

If in fulur you s8@ this message you know theie & an vpgiade available!
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—
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Figure 16: Downloading the Update
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Clickwhen the file has finished downloading and follow the on-screen instructions.

Installing a newer version will update all the relevant program files. It will not affect any of
your LogTag® data files or your custom settings of the software. You may however need to
check any shortcuts to the program you made, as the location of the program files can change.

If you are unable to use either update option on the previous page you can download an
upgrade installer file from the LogTag® Recorders website. We recommend you register your
email address on the Software download page so you can be notified by email when an update
is available. If a newer version is available, you can download the updated version of the
installer file to your PC and then proceed with the installation process. The older version of the
software will be replaced with the new version.

You cannot cross-upgrade from LogTag® Analyzer version 2 to LogTag® Analyzer version 3
using an automated upgrade function. If you are currently using version 2 and you wish to
upgrade to version 3 please download the software and use the installation process as described
in Downloading and Installing on page 1.

page 21
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Version 3.0.3
A nawer version of Analyzer (3.0 Build 4) iz available far download. Chek the " Download™ buttan o you want
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Figure 17: Ready to install



Chapter 2
Using LogTag® Analyzer

This chapter explain in detail how to use the software to configure and download recorders and indicators, how to analyse the results and how to share
them with other users.

The User Interface .. o 23
Initial SO LU ..o 41
AAVANCEA SO U ... 41
Connecting the Interface ... .. . .. 42
Configuring a LogTag® for recording . ... ... ... 43
Results from LogTag® RecOrders ... ... o 75

Analyzing the results
Sharing recorded data with others ... .. i 115
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The User Interface

Once you have started LogTag® Analyzer, the
main window will open. From here you have
access to menu commands, toolbar
commands, option settings and many other
controls.

You can find more information about the Toolbar
different areas here:

« Information about Menu commands on

File Edit Wigdow Auto-download is

LogTag User Server  Halp

& EaG B B 2HO ,00HEH ©

Wizard  Open  Save Menu BT R Zoom Cut n  Provious  Mest A M gl Optians

page 26

. Information about Toolbar commands on
page 34

. Information about The Status Bar on
page 37

For Help, press FL, To use a LogTag, press 2. Select Theme = (%] Select Display TimeZone = ] LogTag Configured Time (Display Clock Adjusted) Pending E:mail=1 Uploads: 0

Figure 18: The workspace
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When you open a file, it completely fills the
docking canvas.

You can now zoom in and out, show and hide
various elements of the chart, view the
information in different forms and save or
export the file to different formats

When you open additional files, they each
open in a new file window tab.

Clicking a tab displays the corresponding file
window. The window's title bar shows the full
file title, while the tab may only show
abbreviated information, depending on how
many files are open.

File windows are initially docked, which
means they are attached to the canvas. When
they are docked, they move with the main
program window. File windows can also be
floating, which means you can move them
anywhere on your PC's screen, even outside
the program window and on to a second
screen. To float a docked window, simply click

and hold the file's tab, and drag it downwards.

You can now independently move and resize
the window.

LogTag Analyzer User Guide

Flle Edit LogTag Window User Server Help

ieaBs Bl B

wizard Open Save  Print Properties Signatures Send Mail Upload Copy

‘oamozozls Started 18-06-2015, Finished 20-06-2015.1td X |

P HY

Zoom Out Real Time  Elapsed
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Figure 19: Workspace with two files open
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This allows you to have multiple windows on
your screen.

To re-dock a floating window, click and hold
the file's title bar and drag it on top of any
docking icon:

. E Docks the window to the top of the
canvas

-
o L= IDocks the window to the bottom of
the canvas

4
. @ Docks the window to the left of the
canvas

. Docks the window to the right of the

canvas

. Docks the window to the existing

window tabs

You can also dock a file window to another
floating window, and use the Tile function to
display windows side by side, separated by a
movable divider.

toging [~ Jwacan

Tne o aa

Wasw  Ges few

=
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Figure 20: Multiple floating windows
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Menus and Toolbars

At the top of the screen below the title bar is LogTag® Analyzer's menu system and toolbar. The toolbar provides quick access to some of the more
commonly used functions. The menu system contains lists of all the operations and commands that are available while using the software.

Menu System

File Edit LogTag Window  User Server Help Auto-download is

& B BEEran 8 P EITL,P00BEBENM © & &

: = / / ram o ©

Wizard Open  Save Print Properties Signatures Send Mail Upload Copy Zoom Out Real Time Elapsed Zoom Previous Next Average Multi  Single Optiors  Logon  Logoff
Toolbar

Figure 21: Menu and toolbar

Menu commands

The menu system has been separated into groups of related commands. Each of these menu groups is explained in more depth in the subsequent
sections. The software will only display the menu groups and commands within each menu group that are appropriate depending on what you are
currently doing with the software.

You may also see that some of the menu commands have a reference after the command name, for example F2 or Ctrl+O. These represent key strokes
on the keyboard that instruct the software to perform the appropriate command, without the need to select the menu or toolbar command. When only
one key reference is mentioned, for example F2, then pressing that single key on the keyboard will cause the appropriate command to be performed.
If there is more than one key reference mentioned, for example Ctrl+O, then to cause the command to be performed you must press and hold down
the first key mentioned while pressing the other key once. When letters are used in the key reference, for example Ctrl+Q, it does not matter whether
or not the caps lock is on or off.
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File Menu

The File menu contains commands that relate to a LogTag® file. When clicking on File (or pressing ALT-F on the
keyboard), a menu similar to the one on the right appears.

The following table outlines the commands you can select along with a brief explanation. Some commands do not
appear if no file is open.

Table 1: File menu - available commands

Command Explanation

E This will display the Open file dialogue, which will allow you to open files that were
previously saved with any version of LogTag® Analyzer, such as *.1td, *.1tdx or

Open... * sltd files and multichart files such as * multi or * multix.

Initially, the folder defined in Edit - Options - File and Folder Settings will be
displayed. When you open a file after you browsed to a different location, LogTag®
Analyzer will remember this location for the next time you wish to open a file.

If a Multi Chart file is selected, the LogTag® Analyzer software will automatically
show the opened file as a new Multi-Chart (see Multi-Charts (Combining Charts into
a Single View) on page 91).

B This will save any changes you have made to the LogTag® file (or Multi Chart
configuration) to your disk drive.

Save

B This will display the Save As file dialog, which will allow you to save a copy of the

file currently being displayed in the same or a different folder with the same or a
Save As... different file name.

This will close the currently active file. You may be asked to confirm if you wish to

a save any changes, such as annotations or zoom settings. If no files are currently open

Close this command will not be visible.

[ﬂ This will send an email with the currently active file attached to a list of recipients
or upload the file to a pre-determined FTP site, as detailed in Sharing recorded data

Upload with others on page 115.

'B' This will open a window allowing you to print the currently active window to a

= printer. This command is further explained in the section Printing the results on
Print... page 110.

'B' This will open a window allowing you to print all currently open windows to a

= printer. This command is further explained in the section Printing the results on
Print All... page 110.

WM =D e BhE §EBEEEp

%

Open Ctri=0
Save Ctrl=S
Save As

Close

Print Ctrl =P
Print All

Print Preview

Page Setup

Send

Upload
Properties

Digital Signatures
Select Recent File

Exit

Figure 22: File menu
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Command

i
Print Preview

‘!'h
I page Setup...

R

Send...

E|

Properties...

>
Digital
Signature...

Select Recent File

%)

Exit

LogTag Analyzer User Guide

Explanation

This will change the display mode of the software to show you a copy of how a
printout of the currently selected file and window would look like. In "Print
Preview" mode you will not be able to zoom in or out of a chart. Click to exit the
"Print Preview" mode and return to normal display mode.

This will open a window allowing you to view and adjust one or more of your page
settings, like printer margins and page orientation.

This will help you send, by email, the currently open and selected LogTag® file to
another user without the need to exit to your email software or to deal with file
attachments. This command is explained in further detail in the sectionSending a
file by email directly from LogTag® Analyzer on page 115.

This will open a window that will display the information about the file that is being
displayed and currently selected. This same window and information will be
displayed if you view the properties of the file from Microsoft Windows Explorer.

This will open a window to display a list of digital signatures that have been
included with the file. It also allows you to add and print this list of digital
signatures. Further explanations can be found in the section about "Digital
signatures on page 79.

This sub-menu, when clicked, shows a list of the most recent files you have viewed.
To re-open one of these files, simply click on the entry (name of the file). The
number of files included in this list can be adjusted in Edit - Options - File and
Folder Settings.

This command will exit the LogTag® Analyzer software. Any files currently open will
be closed automatically. If a user is currently logged on to the User Server, the user
will be automatically logged off.
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Edit Menu

The following table outlines the commands you can select along with a brief explanation. Some commands do not

appear if no file is open.

Command
]
Copy
{-')\
Zoom Out

Real Time

©

Elapsed Time

@

N
Zoom to Marks

o

Previous group of
Marks

©

Next group of
Marks

©

Options...

Table 2: Edit menu - available commands

Explanation

Places a copy of the contents of the currently displayed window onto the clipboard,

LogTag Analyzer User Guide

which can then be pasted into any Windows® application. The Copy command
behaves slightly differently for different tabs, please refer to the descriptions

covering individual tabs for further details.

This will undo the last zoom operation. If the chart is displaying all the readings
recorded by the LogTag®, this command will not be available.

Clicking this menu item will make the time axis represent date and time the data
were recorded. This is useful when you want to inspected at what date and time a
certain event occurred.

Clicking this menu item will make the time axis represents the elapsed time since
the recording began. This is useful when you want to inspected how long into a trip
a certain event occurred.

When this command is enabled, the chart is automatically zoomed to show readings
recorded between inspection marks. The section "Starting and using the LogTag®"

explains in further detail how inspection marks are recorded. -

This command will show the readings recorded between the first inspection mark

shown and the previous inspection mark recorded. This command will only be

available if the "Zoom to Marks" command is enabled and the first reading recorded
is not currently visible.

This command will show the readings recorded between the last inspection mark

shown and the next inspection mark recorded. This command will only be available

if the "Zoom to Marks" command is enabled and the last reading recorded is not

currently visible.

This will open a window allowing you to customize the software. This command is

further explained in the chapter "Customizing the software".

A

f

000 PQH

Zoom QOut

Real Time

Elapsed Time

Zoom to Marks

Previous group of Marks

Next group of Marks

Options
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LogTag® Menu

LogTag Analyzer User Guide

The LogTag® menu contains commands for interaction with LogTag® products.

When you click LogTag (or press ALT-L on the keyboard), a menu similar to the one on the right appears.

The following table outlines the commands you can select along with a brief explanation.

Command
B
Configure

e

Download

@

Hibernate

o
Quick Re-
configure

Ex

Profiles

Al

Wizard. ..

Table 3: LogTag menu - available commands
Explanation

This will display a wizard to help you through the necessary steps to configure
LogTag®s for their next use. This command is explained in more detail in the
chapter Configuring a LogTag® for logging on page 1.

This will display a wizard to help you through the necessary steps to retrieve a copy
of the recorded readings stored inside the LogTag®(s). This command is explained in
further detail in the chapter Results from LogTag® Recorders on page 75.

This will display a wizard to help you through the necessary steps to set LogTag®s to
"Hibernation" mode. This command is explained further in the chapter Hibernation
- Prolonging battery life on page 68.

With this command you can re-configure a recorderwith the same settings as for the
previous trip. This command is explained in further detail in the section Quickly re-
configuring a LogTag® on page 64

With this command you can configure a recorder with a configuration profile
previously created. This command is explained in further detail in the section about
Configuration Profiles on page 70.

This will display a wizard to help you through the necessary steps to retrieve a copy
of the recorded readings stored inside the LogTag®(s) and then prepare the LogTag®s
for their next use. This command is explained in further detail in the chapter
Configuring a LogTag® for logging on page 1.

E@ Configure
@ Download

{E Hibernate

‘(:;g Quick Re-configure

D’ Profiles
K

Wizard

F3

F4

F5

F6

F2
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Figure 24: LogTag Menu
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Window Menu

The Window menu contains commands that relate to the management of windows open in LogTag® Analyzer,
which display the contents of a LogTag® file.

Commands available in the Window menu:
Table 4: Window menu - available commands

Command Explanation

o Opens a new window that contains a copy of the information of the currently selected window. This command is
' useful when you need to closely inspect and analyze different sections of the same file.
New
Window
@ Closes the currently selected window.
=
Close
r Closes all open windows.
Close All
= Maximises all windows inside LogTag® Analyzer's docking canvas, with a tab for each window.
Dock All
r‘_'| Un-docks all windows, so they can be positioned freely around the computer monitor.
Float All

Current This sub-menu, when clicked, shows a list of the currently open windows. Click on an entry to bring the window
Windows  to the front. If you want to change the currently selected window to one of the windows listed, just click/select
the appropriate entry on this list.
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Figure 25: Window menu
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User Server Menu

The User Server menu contains commands that allow you to log on and off. When clicking on User Server (or
pressing ALT-U on the keyboard), a menu similar to the one one on the right appears.

The following table outlines the commands you can select along with a brief explanation. Some commands do not
appear if no file is open.

Command

[ ]
L&)

User logon

[ ]

L €

User logoff
|

=

—

Change
Password. ..

<

Settings. ..

Table 5: User Server menu - available commands

Explanation

This allows a user to log on to and use the Analyzer software. When the software is connected to the User Server
software, users must log on to the software prior to being permitted to use the software. Therefore, this
command will only be available if the Analyzer software is connected to the User Server software. If a user is
already logged on to the software, then this command is not visible. The section User Server explains in more
detail how to get the Analyzersoftware to connect to the User Server software.

This allows the currently logged on user to log off the Analyzer software. The username portion of this
command will represent the name of the user currently logged on. If there is no currently logged on user, this
command is not visible.

This allows the currently logged on user to modify their password that they use to logon to the
Analyzersoftware. This command will only be available if the Analyzersoftware is connected to the User Server
software and the User Server administrator has granted the appropriate user permissions.

This will open a window allowing you to enter the settings required to connect to or disconnect from LogTag®
User Server.
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Help Menu
The Help menu contains commands that provide you with help and assistance when using the LogTag® Analyzer
software. m
L. . Help Topics
When clicking on Help (or pressing ALT-H on the keyboard), a help menu appears.
The following table outlines the commands you can select along with a brief explanation. J} User Guide

Command Explanation

o

Help
Topics

) 1
User
Guide

oy
LogTag®
Home
Page

Q

Request
help

)

Check
Internet
for update

About
Analyzer

Table 6: Help menu - available commands

# Analyzer Home Page
Opens a window that contains the online help. o Request Help

@ Check Internet for updates

Opens the online user guide for viewing. Requires PDF viewing software (such as Acrobat Reader) that can read
version 1.6 compliant PDF files to be installed on the computer. o About Analyzer
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Figure 27: Help menu

This will open your default Internet browser software and display the LogTag® Recorders Internet site,
http://logtagrecorders.com. This command requires that your computer be currently connected to the Internet to
successfully display the LogTag® Recorders Internet site.

This will gather non personal information from your system to include in the email to be sent to software
support at LogTag® Recorders, so that the support team will be informed of the relevant information about your
system in order to provide you with quality and useful assistance. This command is explained in further detail in
the section about Getting more help on page 170.

This is a simple way of checking to see if there is a newer version of this software available for download. This
command is explained in further detail in the section about Upgrading LogTag® Analyzer on page 20.

Display the version information for LogTag® Analyzer.
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Using LogTag® Analyzer

Toolbar commands

The icons on the toolbar give you access to some of the most frequently used commands.

A@BE=s = QM

Properties Signatures Send Mail Upload Copy Zoom Qut Real Time Elapsed

Wizard

Print

Figure 28: LogTag® Analyzer toolbar

Ll

Wizard
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Print

Properties

Signatures

=

Send Mail

1]

Uplaad

Table 7: Toolbar icons and their function

Wizard

Invokes the LogTag® Wizard. For more details please
refer to Using the LogTag® Access Wizard on page 64.

Open
Displays the file open window. This allows you to open
previously saved LogTag® data files.

Save

Save a copy of the LogTag® data to a file on your disk
drive.

Print

Opens the WIndows Print dialogue so you can print the
LogTag® data to a printer. Please see Printing the results
on page 110 for further details.

File properties
Displays file properties about the currently selected file.

File digital signatures

Displays information about any digital signatures
included in the currently selected file. Here you can also
add new digital signatures to files or print copies of the
digital signatures.

Send mail

Creates a new draft email and attaches a copy of the
currently selected fileso it can be sent to a recipient of
your choice. Please see Sending a file by email directly
from LogTag® Analyzer on page 115

Upload

Uploads the file in the currently active window to an FTP
server, or sends it by email. Please see Automatic

Zoom

LogTag Analyzer User Guide

Real Time

&

Elapsed

/G)

Zoom Out

/®

Zoom
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emailing and uploading to FIP sites on page 116

Copy

Places a copy of the currently displayed information to
the Windows™ clipboard, so you can paste it into another
Windows™ application.

Real Time

When this icon is active, the time axis represents the
elapsed time since the recording began. This is useful
when you want to inspected how long into a trip a certain
event occurred.the data were recorded.

Clicking the icon switches to date and time display.

Elapsed Time

When this icon is active, the time axis represents the
date and time. This is useful when you want to inspected
at what date and time a certain event occurred.

Clicking the icon switches to elapsed time display.

Z0oom out

Zooms out one level of the chart in the currently active
window. If you are displaying a chart and this function is
not available, then all available data are already being
displayed and you cannot zoom out any further.

Zoom to inspection marks

This zooms the chart so readings are shown between the
oldest reading recorded and the first inspection mark
that exists in the data. If this function is not available
then there are no inspection marks in the data currently
being displayed.

The next two commands will not be available until this
command is activated.
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o

Previous

MNext

Average

Multi

=

Single

©

Options

@ ]
«© W

Logon Logoff

Previous inspection mark group

This zooms the chart so readings are shown which were
recorded between the first inspection mark currently
being displayed and the previous inspection mark.

This function is disabled when either the oldest reading
is already being displayed, or the "Zoom to inspection
marks" function has not been activated.

Next inspection mark group

This zooms the chart so readings are shown which were
recorded between the last inspection mark currently
being displayed and the next inspection mark.

This function is disabled when either the newest reading
is already being displayed, or the "Zoom to inspection
marks" function has not been activated.

Average

Combines all open file windows into a single Multi Chart
window and activates the average tab, or, if already in
multichart, activates or disables the average tabs. It is
recommended to deactivate this feature when processing
large data sets, as Minimum, Maximum and Average
Charts can require considerable computer resources when
activated.

Multi Chart

Switches into Multi Chart mode, which displays all
currently open charts together in one window using the
same time axis.

Single Chart

Opens all charts displayed in a multi chart in their own
individual tabs (the original multi chart remains open).

Options

This will open a window allowing you to customize the
software. You can find a detailed overview over all
settings in the chapter Customising the Software on
page 120.

Log on/Log off

These icons are only displayed if LogTag® Analyzer
requires a connection to LogTag® User Server software in
order to operate and are used to log on or off. Please see
Connecting to LogTag® User Server on page 164 and User
Server on page 154.

LogTag Analyzer User Guide
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If you are working with a small computer monitor, not all icons may be visible.
In that case click the down arrow next to the group where the icons are missing,

and you will get an expanded view of the toolbar.

Auto-download is

n &
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&

|
o Elapsed
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Print preview toolbar
The print preview feature -available through the File menu- will . ]
display a view of the data as it would appear printed out. When the e |
software is displaying a file in print preview mode, an additional
toolbar will appear, similar to the picture one on the right: LogTag
Table 8: Commands available in the print preview toolbar o i -
Command Explanation L i =1 | =
B o . A - s :
& This will refresh the displayed data. ) I I1 ] [ ] . . | L
Refresh . : ll']' — N 7
a . : i - : ! - ™
M 45 of13dp M This allows you to navigate between pages. These " : ! : 1 ] »
o controls are disabled if there is only one page to 2 | | T LN \ Iy
Page Navigation be displayed. Hi n :II e e il I Bl
- | i : I ! ™
= This will open the operating system's print '_} 4 RN ! 'R i \ . -
Print. .. dialogue, allowing you to print a copy of what Tl ] " T H | ?ﬂ : -
yhou see in the preview. This command is further “Til ] Y T A A TR I M
explained in the section about Printing the results ALl ST A ﬂ'e's'é“ v ! L
on page 110. LR R.;_ L { I L) | o
: . R LR Tt
Here you can select the zoom level with which the e
preview window displays the data. This works LI
much the same as in other windows applications.
It does not influence the printed data, just how B ooy T A b ChagM] —
you view them in the preview window.

Figure 29: Print preview

View Zoom

FE This function allows you to export the currently
Acrobat (PDF) file previewed data to one of the listed formats. These
CSV (comma delimited) formats are additional to the export formats listed
Excel §7-2003 in Exports and Reports on page 147
Rich Text Format
TIFF file
Web Archive

Export (Save As)

Close the preview window with the Close button .
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The Status Bar

The status bar is located at the bottom of the LogTag® Analyzer
program window.

Colour Theme Selection Display Time Zone

Pending E-mait: 1 Upload0 |

| Fer Hetp, press F1. To use a LogTag pressF2.  Select Treme = (D) Sebect Disglay TimeZene = LagTag Configured Time (Displuy Clock Adjusted)

Upload Status

The status bar shows information about some of the software's active
tasks and settings, and what you can do. You can also select the Theme
and the Time Zone for the data display.

page 37



Using LogTag® Analyzer

Themes

You can change LogTag® Analyzer's on-
screen appearance by applying a theme. The
theme is selected in the Status Bar by clicking
Select Theme. Following Themes are currently

included with LogTag® Analyzer:
Default Theme

Windows 8/10 style theme
i - - =EH

SRR T SR R SRR
Avaintie Profies
; ETRETT, Y
 —
XD () o batais DeacrgtonPaaear
Delsts
—_—
— ey R
R Q =

Windows Theme

Windows 7 style theme

ok e Frien

D ble-chck. on 8 el 10 confgum Loy Tige mth e ek setinGe
sl Profies

[ Modd  Amritam - |

e i TRTREE AW L

o Peslis Wo s

LTS Tt TRoM At

UTsein; e WTRDaE A e
Ex
from

Pt i

0....;;““ ST e

LogTag Analyzer User Guide

Blue Theme

Dominantly blue colored theme

Cartgoratiin Pratiee = =
Biautie.cha an s 6k b sanfigure Loglge e the protis Lattnge
mntatie Poties
[ vt = ) Commgarisaen
[t brome | Shem st o
sz Prosie HAXD e [ElRrtain DesriptionPaimerd
TRELTE Tt uTRER L
Tk TR o teem
(™
Deiere
Tuctie bir
Impart Lipost Seseciect dai003 Bom fie
v € coen @ =

Silver Theme

Silver theme

Cardgution Frolicy

— -
Daubde ch o @ Befile ta songure Loglegs wimThe Grotile | attngs
mpdanie ot e
Hame Mg Amrtie [+ 0_—..“..-...,-.,,\
tar e THELTHER W

Black Theme

For those who like it dark.
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Dates and Times

Every LogTag® product contains a real time clock, which it uses to
determine the recording start time, when to take a reading and when to
stop recording.

Often, the recorders are used for transit monitoring applications, where
goods are transported between different countries, and frequently
different time zones.

Time zone information is included in the recorders' memory, allowing
you to relate shipments from different time zones to each other.

During configuration with a PC, the clock of each recorder is set to the
computer's time, and the local time zone of that computer is also
stored in the recorder's memory. When the recorder is downloaded by
the recipient, LogTag® Analyzer is able to use the time zone
information from the recorder and the information from the PC used for
downloading to display the data in a variety of different time zones.

Table 9: Time zones for data display
Time zone

Local PC Time All times are displayed in the time zone of the computer

Zone used for viewing the data. This is the most commonly
used option, as it displays the dates and times on screen
in your local time zone.

What is displayed

Note, that this is not the same as the download
time zone, if you were sent a file from a
recorder downloaded in a different time zone.

Download Time All reading times are displayed relative in the time zone
Zone of the computer used for downloading the data.

Configuration
Time Zone

All reading times are displayed in the time zone of the
computer used for configuring the LogTag®.

You would use this option if you wanted to view the data
in the same way the sender of the recorder would see it.

UTC/GMT Time All times are displayed in Greenwich Mean Time

Zone (Universal Time Coordinated).
This is the best option when comparing different
recorders from different senders in different time zones.

LogTag Analyzer User Guide

The currently used time zone is shown on the status bar:

I For Help, press F, Touse a LogTag pressFL  Select Theme = () Select Display TimeZone = [Ltg'[ag Configured Time (Display Clock ﬂﬁJu:l!d] Pending E-mails: 1 Uploads§ .
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< 7

The default time zone used when first opening a file is set in the
options settings. If you quickly want to switch to another time zone,
without affecting all other charts, you can click on Select Display Time
Zone and choose the desired the time zone from the list.

I For Help, press F1, Touse a LogTag pressFL  Select Theme -|\/ Select Displey TimeZone = | LogTag Configured Time (Display Clock Adjusted) Pending E-mails: 1 Uploads§ .

_

For additional time zone settings please see Time zones on page 151

Upload Status

When either automatic or manual uploading or emailing of files is
enabled, the upload status is displayed at the bottom of the LogTag®
Analyzer window in the status bar.

| For Help, press F1. To uaea Loglag. press F._ Sebect Theme = () Select Disglay TimeZons = LogTag Configured Teme (Display Clock Adiusted) | Panding E-meds 1 Ugloads:0 |

Figure 30: Status bar showing one pending email.

The email counter will decrease as emails are sent. Similarly, the
upload counter will decrease as files have finished uploading to FTP.
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Colour Picker

In a number of different places throughout the software you can set a colour for lines, text or
shade areas. This is done with the help of a colour picker, which works similar to selecting a
colour in other windows applications such as Microsoft Word.

To change a colour for an item, click on its colour selection box.

Basic Colour Selection

The basic colour selection window will appear. If it doesn't, the colour for this item cannot be
changed.

The colour currently selected for the item is displayed on the right. Click on any of the colours
in the honeycomb to select it. The New colour is now shown on the right above the old colour,
S0 you can compare the two.

You can click the colour picker # and then click on any part of the screen to select that colour.

You can enter a hexadecimal RGB colour code directly into the field labelled #. This can be
helpful if you have a corporate colour scheme you are trying to match.

Advanced Colour Selection

You can click on the Advanced tab in the colour selection window to bring up a more refined
selection mechanism. Here you have more detailed control over the colour, and can also apply
transparency.

Move the slider up or down to select the basic colour hue. Then set luminosity (horizontal
movement) and saturation (vertical movement) in the colour square and click on the desired
colour. Change the alpha value to change transparency (0 = fully transparent, 255 is fully
opaque). The corresponding hexadecimal RGBA colour code is displayed in the field labelled #,
where you can also enter a hexadecimal RGBA colour code directly. As with the basic window
the colour picker is also available.

Basic | Advanced

Curent
* FFD2D2

F
oK Cancel
Figure 31: Basic Colour Selection
Basic | Advanced
AL DR [mg =
Mewr
JG (20 &
& [ma =
L -
; Cusrent
eH 0 « % FFD2D2
s 17 >
,’l
TERE T
1
[+ 4 Cancel

Figure 32: Advanced Colour Selection
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Initial Set-up

Before you start configuring and downloading recorders we recommend

you customize some of the settings by clicking Options from the Edit

menu.

« Define the display language and temperature units used (General
Settings on page 122)

« Choose how time and date are displayed (Date and Time Format on
page 150)

« Select how LogTag® Analyzer names downloaded files and where
these are stored (File and Folder Settings on page 139)

« Decide which communication ports LogTag® Analyzer uses
(Communication Ports on page 153)

Sometimes your network administrator will ask you to import settings
from a configuration file. You can read how to do this in the section
about Importing and Exporting Option Settings on page 156.

Advanced Set-up

Once you are familiar with the basic settings, you can refine your
work-flow.

« Share data with colleagues and project stakeholders by exporting
and emailing them (see Sharing recorded data with others on
page 115)

« Enable the report logs, so you can track which recorders you have
configured, and what settings were applied

« Automate your work-flow with auto-downloading and auto-
reconfiguration (see Automation on page 131)
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Connecting the Interface

L Tip: You can skip this step if you only use USB Recorders. J

The standard interface cradles available from LogTag® Recorders
connect to a USB (Universal Serial Bus) port.

These ports are typically located at the rear of workstations, but you
typically find ports at the front or sides, particularly if your computer
is a laptop. If you are using a USB hub we recommend it has its own
power supply.

LogTag® Analyzer can communicate with multiple interface cradles at T, @ ,ﬂ

the same time; you may connect as many USB interface cradles as the [q | H !

computer supports, although we find that connecting more than 4 '

interfaces becomes impractical. 2xUSH Rer ZxUBE Fort

If you install LogTag® Analyzer on a computer with no internet
connection you must ensure USB interface cradles are not connected
until the software installation is completed, since the required drivers
are installed as part of LogTag® Analyzer.

If the software cannot identify a connected USB interface cradle there
may have been a problem during the installation of the driver
software. Please refer to the FAQ on the LogTag® Recorders website for
further information.

LogTag®'s range of USB recorders do not require an interface to
communicate with LogTag® Analyzer.

Figure 33: Rear of PC with 4 USB ports

LogTag® Recorders also offer a serial (RS232) port interface. This can
be useful for heavily virtualised environments suich as Citrix or
VMWare. Please contact LogTag® for more information.
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Configuring a LogTag® for recording

Some of the LogTag® products are delivered to you ready to start, but
most of the time a recorder will need to be configured before it can ¥ Locate condled LogTag(s -

. . . . N e software will locate the LogTag products for you so you can update their
record tempefatufe or humldlty data. Durlng the Conflgufatlon process ‘:_." tg::;ﬁfﬁgr}WML configuration settings for next use, Note, NO logged data will be downloaded
of a recorder you define the settings that affect how the LogTag® rpmiteghauibintive:  (IRSREEAMIE
records data dU]fiI'lg its next t]fip) such as: Note: Single use LogTags, limited use LogTags, LogTags with locked

. . i ions, and LogT: ith low ba displ lock bol and
. how and when to start recording, how many readings to record and S e s e s
at which interval USB:03101C06 —
. . . TRIX-16 SN:1001016028 |’ Click on an interface to the left to load that LogTags current configuration.
« whether to StOp feCOIdlrlg after a defined number of feadlngs or to /= Interfaces with compatible LogTag that can be configured at the same time will
4 SERIAL: COMT be automatically included.
record continuously HAXO-8 SHA0T0002%4 |
« what alerts to process and at which temperature limits | The process of configuration allows you to define a number of paramerers,

including:

. if password protection is required for configuring or downloading
« What information to show on the recorder's display

- How leng it should record darta for,

- The frequency used to sample the data,

To start the configuration process, insert the recorder to be configured
into the interface (or a USB socket if you have a USB recorder) and click AL RS L e D
Configure ffom the LOgTag menu or p]feSS F3 - Whether to record continuously or take a set number of readings.

Note: By default the Auto Download feature is enabled, which

means LogTag® Analyzer will download any previously G e © o H ' R @ =
recorded readings. Please see Enable automatic download of
readjngs from LogTag@ on page 131 for an overview of this Figure 34: Locating recorders and loading initial parameters
feature.

The LogTag Configure window will be shown, and LogTag® Analyzer B comtgure N Z

will check all connected interface cradles and USB ports for attached B powniosd F4

recorders. Every LogTag® found will be listed in the Progress Pane on [ =

the left side, showing the progress of retrieving its configuration

Settings. @ Quick Reconfigure F&

When all recorders have been found, the configuration settings [ rone: i

currently stored in the recorder in the first interface found are shown B were P2

in the Parameter Pane on the right. These are either the factory pre-
set data, or the parameters used when this recorder was last
configured. Model number and serial number of this recorder are
shown in the Parameter Pane.

Figure 35: LogTagMenu Configure
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Note: You can attach different recorder models at the same
time, you can, however, only recorders of the same model will
be eligible to be configured at the same time.

g In the example shown the first detected recorder was a HAXO-
8 in the RS232 serial interface. Therefore the configuration
parameters for this HAXO-8 are shown.

If you wish to configure any of the other recorders found, you
can click on that recorder's progress bar, and the parameter
pane will now show the corresponding configuration data for
that recorder.

(. J

You can now adjust the configuration parameters for the next trip.

Command Buttons

When you have entered or adjusted the settings as desired, click
Configure] to upload these new configuration data to the LogTag®. In
addition to the (Configure) button following other actions are available
in this screen:

.

Scans all connected interfaces and USB ports again. Click this button
if you have inserted additional USB recorders you wish to configure,
or not all connected USB recorders appear in the Progress Pane.

« (Save Profile

You can save the parameters as entered to a Configuration Profile.
Please see Configuration Profiles on page 70

Cancel
You can abort the configuration process by clicking this button.

.

Clicking this button brings up a browser window, showing help for
this topic.

LogTag Analyzer User Guide

Action Pane Serial Number

Parameter Pane

Configure LogTagis) HAXO Settingsfrom SN:1010080254

« Locate cradled LI gTag(;]
\ User information.

‘/ Load LogTag(s) current [Bescraption:
configuration

LogTag Battery: OK

Prepare LogTagi(s) for next use |

Logging Paramsters

Click on LogTag below to select
Push button start

modelis) 1o be configured show

LogTag's current<onfiguration
SERLAL COMT @ | () Record readings continuously, overwrite oldest when memery full

HAXO-8 SN:1010080254 ’] -'é:. Record readings 5o that:

v | [/] Enabile pre-start loaging

Readings recorded will span at least |2
Mumber of feadings to record 8000

Days
maximum is 8003

a4

USE: 03101C06

IC il
HAXO-8 SN:1010080258 ’I Regord a reading every OROGI0 = | 30 Seconds.
Begin recording after a delay of  00:00:00 = | Mone.
LogTag USE-HID

UTRID-16 SN:5040000038 ilﬁ} [] Ensble the O (Gresn] indicator I I
[+#] Enaie the lert (Red) indicator, wher: : :

LogTag USE-HID Readingsbelow 0.0 =
UTRIX-16 SN:5040000030 2 sre[]2

oraboye (1000 T %RH
= | consecutive alert readings (1 Minute)

LogTag USE-HID aper[ ] |2 = | alert readings have occurred [1 Minute)

USRIC-4 SN-5200000002 E [] Leave slert indicator enabled evtn i réadings return t non-alert range
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Figure 36: Configuration screen for a HAXO-8

6 Help
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. [Repeat Confiqure]
This button is available only after one or more recorders have been
configured. Clicking this button will scan all interfaces and USB
ports for recorders again, and upload the entered configuration data
to each eligible recorder.

.

Clicking this starts the configuration process from the beginning.

Progress Pane
Each recorder found will be listed in the Progress pane.

When you see this icon displayed in the progress bar, the parameters
g entered for conﬁiuration will be applied to this recorder when

clicking

When vou see this icon, the recorder will not be configured when you
@ click , since the model is different from the one for which

you have entered configuration parameters.

trips remaining. This applies to single use recorders or recorders that
have a locked configuration. You will see this on SRIC-4, SRIL-8,
USRIC-4 and USRIC-8 recorders when you attempt to configure them
for a second trip.

8 A recorder showing this icon cannot be configured, as there are no

This recorder has a low battery. Some models cannot be configured

when they have a low battery.

q This icon is displayed after the recorder has been successfully
r@ configured. This recorder can now be started, or will start

automatically, depending on the chosen start options.
The progress bar will also show the word Configured

g This icon is displayed after an unsuccessful attempt to configure the
@ recorder. Further error messages will be displayed to indicate why

the recorder was not configured.

While the software is sending the new configuration data to each
LogTag®, progress bars in the Progress Pane will identify the recorders
that are being configured.

LogTag Analyzer User Guide

USB:03101C06 |
Recorder Model Ml w " !
e s sioas (1 N
Progress Bar Recorder Serlal Number

Figure 37: Progress Pane Indicator
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Once finished the progress bar shows Configured. USE: 03101C06

If you use (Repeat Configure] to configure a different LogTag®, you may HAXO-8 SN:1010080258 F\@ m

update its configuration without having first saved previously recorded
data.

Configuration Com plete
As soon as a recorder is configured, previous data can no longer be
downloaded. Please ensure you have downloaded the readings

before configuring to avoid data loss.

If additional recorders of the same model have been located, these
recorders will also be configured with the new data.

If you select Retain Description/Password, existing descriptions and
passwords for each recorder will be retained, instead of using the
details from the configuration parameters entered. Note that you will
still need to provide a password for recorders that have an active
configuration password protection.

The next sections describe each configurable option; please note,
however, that not every option is present for each of the LogTag®
models.

To configure recorders you can also use pre—-configured profiles, or
quickly re-configure a LogTag® with the same settings as used for the
previous recording. For more details on these options please
Configuration Profiles on page 70 and Quickly re-configuring a
LogTag® on page 64

Working with more than one LogTag®

At some stage you may need to perform a similar task on multiple
LogTag®s, whether it is retrieving readings or preparing them for a
new trip. LogTag® Analyzer has been designed to make working with
multiple LogTag®s easy.

1. You can connect multiple interfaces to your PC, so more than
one recorder can be configured or downloaded at the same time.

2. Use the Auto-download feature. To retrieve a copy of the
recorded readings from multiple LogTag®s, simply insert each
LogTag® into the Interface cradle. The software will
automatically retrieve the recorded data from the LogTag®, save
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it to disk and then display the information for you (Automation
on page 131). You can repeat this for each LogTag® without
needing to interact with the software.

3. Use the Repeat feature in the configuration window without
having to re-enter the same parameters more than once, even
with different descriptions or passwords.

4. Use a pre-configured Profile (Configuration Profiles on page 70)
or the Quick Reconfigure feature (Quickly re-configuring a
LogTag® on page 64)
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User Related Configuration Parameters

User related configuration parameters are entered at the top of the
Parameter Pane:

User Informiation
Deseription: LogTag Battery: OK

Password: ' 'Connqme reguires & password

[IDowrload requires a password

Description

(optional)

This can be used for identification of the load in transit to be monitored,
or simply an identifier that describes the purpose of the monitoring.
Bill of Loading information, Shipper, commodity, contact name and
other relevant information can be placed here.

The Description can be up to 38 characters long (36 for recorders with a
display) and can contain a mix of letters, numbers and special
characters. The selected input language of the computer's operating
system determines which special characters can be selected.

If a user decides to make use of special characters, extra information
about the language used is stored inside the recorder. Users will then
need LogTag® Analyzer 2.3 Release 7 or later so the User ID is correctly
displayed.

If you use the special character sets for languages such as Greek or
Chinese the maximum number of characters that can be used will be
reduced due to the increased memory required to store the characters.

Please Appendix on page 160 for a more detailed explanation.

s D
To view the PDF file generated by a USB recorder, the fonts
used must be present on the receiver's computer. PDF Reader
software typically only installs a small number of fonts, none
of which support an extended character set. Therefore, you can
only use ASCII characters in the User ID field when configuring
a USB recorder.

LogTag Analyzer User Guide
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Configure requires a password
If you select this option, any user wishing to configure the recorder in
the future must provide this password. A new entry field appears,

where you can specify which password you wish to use.

Passwords are case sensitive ("Bob" and "bob" for example are
different passwords).

If you enter a new password, or change an existing password, you will
need to verify the password when you click‘

If you use special character sets for languages such as Greek or
Chinese, the maximum number of characters that can be used will be

reduced due to the increased memory required to store the characters.
Please Appendix on page 160 for a more detailed explanation.

Due to the restrictions in the Description field you can only use ASCII
characters in the password field when configuring a USB recorder.

Download requires a password

If you select this option, the LogTag®'s recorded data can only be
downloaded after entering the correct password.

Only one password can be provided for each LogTag®. The same
password applies to the Configure and Download actions.

Battery condition

If the battery in the LogTag® reports 'low' the recorder is should no
longer be used. The software will display a warning in the top right
corner.

LogTag Battery: Low

Some LogTag® models display the remaining percentage in this screen
once it falls below half capacity. Some models cannot be configured any
longer once their battery capacity falls below a pre-determined
threshold.

Remaining Starts
If the recorder you are configuring has a limited number of starts, this
will be indicated here.

Starts remaining: 1

Upgrade logger

Some recorders can be upgraded, for example to allow a download
password, not possible up to now. This upgrade can be applied, if you
select Upgrade logger. Please note that older software will then most
likely no longer be able to communicate with this recorder.
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Logging Related Configuration Parameters

Logging related configuration parameters are entered in the middle
section of the Parameter Pane:

Logging Parameters
Push button start v D Enable pre-start logging

(_J) Record readings continuously, overwrite oldest when memory full

(@) Record readings so that:

Readings recorded will span at least |0 Days

Number of readings to record 10 maximum is 8003

Record a reading every | 00:00:30 ~  30Seconds.

Begin recording after a delay of  00:00:00 + | Mone.

Start method

(mandatory)

This is used to determine how and when the LogTag® will start
recording its next trip.

« Push button start

When the 'Push button start' option is selected, the LogTag® will
start recording when the START button has been pressed and held
until both the OK and Alert lights alternately flash on and off.

« Date/Time start

When the 'Date/Time start' option is selected, the LogTag® will
automatically start recording at a specified date and time. Two
additional entry fields will appear, one for selecting the date, the
other for the time. Enable pre-start logging and Begin recording
after... (delayed start) options are not available with a date/time
start.

Pressing the START button prior to the start date/time will have no
effect.

Note: When using the Date/Time start option, the start time
must be at least two minutes into the future. This delay
allows you to complete the remaining configuration options
and gives the software enough time to upload the
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[ configuration to the LogTag® before it starts. ]

« Push button start from hibernation

When the 'Push button start from hibernation' option is selected,
the LogTag® will start as if programmed for 'Push button start'. The
difference is that once the configuration is successfully uploaded to
the LogTag® it will be placed into hibernation. When the
START/Mark button is pressed and held, the LogTag® will wake from
hibernation and start recording with the parameters as configured.

Note: When using this start option, the real time clock
inside the recorder is suspended until logging starts. When
downloading at the end of the trip, the reading times are
back-calculated based on the time of the computer on which
the unit is downloaded. It is therefore necessary that
computer is set to the correct time, so the downloaded data
have the correct date/time.

8 J

Please see Hibernation - Prolonging battery life on page 68 for more
information.

Not every LogTag® model can support every start mechanism. If a start
option is not listed when configuring a particular LogTag®, this option
is not available for this model.

Enable pre-start logging

(optional)

When you enable Pre-start logging, the recorder starts taking readings
as soon as the configuration data have been uploaded. If you forget to
press the START button, the data for the trip will still be available. This
insures no critical data are lost. This option is further explained in the
section Pre-start data collection on page 66.

Pre-start readings will not be recorded if the start method is
'Date/time' or 'Push button start from hibernation'.
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Record readings continuously, overwrite oldest when memory
full

(mandatory 1)

When you select this option, the recorder initially fills the complete
memory with readings, then overwrites the oldest data when the
memory is full. For a more detailed explanation see Continuous
operation on page 1

Record readings so that:

(mandatory)

If this is selected, the recorder stops logging taking after a pre-
determined number of readings. The following two fields determine the
time these recordings will cover.

Please note that some LogTag®recorder models can be stopped
manually, so there may be fewer than expected readings.

Readings recorded will span at least X days
(mandatory 2)

If you know how many days of data you want to record, enter this
number here. The shortest possible recording interval that covers this
period will be automatically calculated, based on how frequently the

recorder takes a reading.

Number of readings to record (maximum is Y)

(mandatory)

This field will display the calculated number of readings if you select a

time period and an interval. Alternatively, you can select the number of

readings desired, and the time period will be calculated based on the

interval. Y represents the maximum number of readings the LogTag®
can store, however with a selected interval and a selected time span,
you may not need to use all of the available memory.

1 You must select either continuous recording, or recording for a defined time span

2 The entries are interdependent, changing log interval may change the number of days the recorder can

take readings for
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Record a reading every X

(mandatory)

This determines how frequently the LogTag® records and stores
humidity or temperature values. To change the number, use the up
down and arrows. Highlight the seconds, minutes or hours value to
change only those values. You can then also enter a value manually.

Begin recording after a delay of X

(optional)

Enter the time that passes after a user has pressed the START button
on the LogTag® until the start of the recording. This feature is useful
for example, when the LogTag® could falsely trigger an alert because
the environmental conditions to be monitored are quite different to the
environment in which it is started.

If pre-start logging is enabled, the LogTag® will still continue
to record pre-start readings during this delay period.
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Prioritising Communication over File Download

When this feature is enabled, a USB recorder P iningig Ao from v e nly
will try to establish communication with v
LogTag® Analyzer before starting to generate e abied | Driver nstallaton Wt or Communication with Log1ag Analyzer
the on-board files, such as *.pdf, * Itd and T il Pl gneration background atvy
* csv. This is particularly beneficial for re- - N
usable USB recorders such as the UTRIX-16, pluggedin lgﬁ:;‘x‘i‘ﬁﬂ“g
where you do not need to see the PDF file ] Analzyer and access data
again when re-configuring the unit. The time v e oot enabled | Drivr Installation Wait for e generation acive

LogTag Analyzer not running Device Enumeration Analyzer

between inserting the recorder and being able
to communicate with LogTag® Analyzer no

Recorder User can access PDF
longer needs to account for the extra step of plugged in from drive eter
. . . . User can access data
generating any files on the unit itself and in Loglag Analyver
providing them via a new drive letter. o it | Do e

Some existing models already support this Figure 38: Timing comparison when inserting USB recorders
feature. If it is disabled, you can enable it,

but please keep in mind that the recorder

will then become incompatible with

LogTag® Analyzer 2.6 and earlier.
Subsequent disabling of the feature will
NOT make the recorder compatible with
earlier version again.

New models may already have this feature
enabled ex factory.



Using LogTag® Analyzer

Configuring Alerts

The LogTag® can display a visual alert if one or more of the configured
alert trigger conditions have been met. Each alert trigger condition
consists of a threshold value, an activation type (which can be instant,
consecutive or accumulative 3) and a delay time, if it is not an instant
alarm.

If an alert trigger condition requires readings to exceed an upper
threshold temperature it is called an upper alert. If an alert trigger
condition requires readings to go below lower thresholds it is called a
lower alert.

The threshold parameters are shown in LogTag® Analyzer when the
LogTag®'s readings are downloaded and displayed.

Alert related configuration parameters are entered in the bottom
section of the Parameter Pane:

@

[

Enable the OK (Green) indicator
Enable the Alert (Red) indicator, when:

Readings below |-20.0 & oraboye 500 7 |°C
Afer[ ]2 < | consecutive alert readings (None)

Afer[ ]2 % | alert readings have occurred (Mone)

[ Leave alert indicator enabled even if readings return to non-alert range

[ |lear and reset alert when START MARK button pressed

Temperature Alarm Settings | Humidity Alarm Settings

== D

« Instant = one temperature reading is above (below) the threshold
Consecutive = temperature readings are above (below) the threshold for the time defined in the
activation delay without interruption

« Accumulative = temperature readings are above (below) the threshold for the total time defined in

the activation delay time, but may not necessarily be sequential.

LogTag Analyzer User Guide

Here you will find one or more tabs, depending on the recorder model
you wish to configure. Switch tabs by clicking on the tab's label.

HAXO-8 recorders for example show two tabs, one for temperature alert
conditions, one for humidity. Note that some values apply to both tabs
simultaneously, such as the OK indicator field.

Standard Alert Related Configuration Parameters
Enable the OK (Green) indicator

This determines whether or not the green LED should blink while the
LogTag® is recording.

Enable the Alert (Red) indicator when...

This defines whether or not the red light should activate when an alert
condition has been detected. An alert occurs when one or more of the
conditions described below have been met. When an alert condition has
occurred, this indicator will flash at a regular interval.

Readings below X or above Y (inclusive)

You can set the upper threshold limit and lower threshold limit by
entering the appropriate information in the boxes, or by moving the
value slider, or both. If readings stay inside the range specified by X and
Y the alert indicator will not activate. If a reading of X and below, or Y
and above is recorded, the alert indicator may light up, depending on
the alert conditions. Charts will display alert readings according the
settings made in the Charts section of the Options Screen.

The values entered in these boxes are included in the alert range. In the
example later in this section 7 consecutive readings of 45°C will trigger
an alert, whereas 7 consecutive readings of 44.9°C will not trigger an
alert. Please set your alert values with this in mind.

Some recorders models allow you to enable upper and lower alerts
independent of each other; this is useful in situations where one of the
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alert thresholds is irrelevant to your recordings and, if left activated,
may falsely activate the alert LED. In this case there will be one check
box for each alert, similar to this image:

After X consecutive alert readings (W minutes)

Tick this box, and enter a number into the adjacent field if you want to
trigger an alert condition once X number of consecutive alert readings
are recorded. Note that the number of minutes shown will depend on
the number of alert readings you enter into the box AND the recording
interval already specified. For example, if X is 3 and two readings are
above the upper threshold limit but the subsequent reading is below
the upper threshold limit and still above the lower threshold limit then
the alert indicator will not activate. Maximum value is 256, minimum is
2.

After X alert readings have occurred (W minutes)

Tick this box, and enter a number into the adjacent field if you want to
trigger an alert condition once a total number of alert readings have
been recorded, regardless of whether they are consecutive or not.
Maximum value is 256, minimum is 2.

You can increase or decrease the values with the arrows next to the
fields. Please note these are linked and certain combinations may not
be allowed.

Leave alert indicator enabled even if readings return within
alert range

If this option is enabled, the alert indicator will remain active, even if
the current reading does not meet the alert conditions specified by the
previous controls.

If this option is disabled then the alert indicator will remain active only
if the current reading meets the alert conditions specified by the
previous controls.

Please note, however, that this setting is only applicable if an
immediate alert is configured; if consecutive or accumulative alert
settings are configured this box has no effect, and the alert indicator
will always remain visible once an alert has occurred.
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Clear and reset alert when START MARK button pressed

If this feature is enabled, any user can turn off an active alert by
pressing the LogTag®'s START MARK button. It will also reset the
internal alert counters as if no alert condition had occurred at all while
the LogTag® was recording.

Should the LogTag® subsequently detect a further alert condition, the
alert will activate again.

Once theLogTag® has finished recording, pressing the START MARK
button will not clear and reset any active alert.

If the LogTag® being configured does not support this feature, it will be
disabled and its setting cannot be changed.

Example:

You wish to configure a LogTag® so alert conditions are indicated if 5
continuous readings are out-of-range or 7 total readings are out-of-
range. Alert parameters should be set as follows:

—

Readings below (0.0 3 oraboye (450 = °C

Enable the OK (Green) indicator
Enable the Alert (Red) indicator, when:

aner[V] 7 % | consecutive alert readings (35 Minutes)
aer[w]| 10 3| alert readings have occurred (50 Minutes)

/| Leave alert indicator enabled even if readings return to non-alert range

Dgear and reset alert when START MARK button pressed

This table shows how different conditions would result in the Alert
Indicator flashing or not:

Table 10: Alert examples
What the LogTag® recorded  What the LogTag® indicated

2 readings out-of-range, return  Neither alert condition is met.

to normal, 2 readings out-of- The maximum number of consecutive out-

range, return to normal, 2 of-spec readings is only 2 (5 required.)

readings out-of-range, return to The total out-of-range events equals 2 + 2

normal + 2 = 6. The alert condition is 7 total, so
the alert does not go off.

No Flashing Red Alert Indicator
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What the LogTag® recorded | What the LogTag® indicated

4 readings out-of-range, return  The first alert condition is not met, as the

to normal, 4 readings out-of- the maximum number of consecutive alert

range condition readings is only 4 (5 required.)
The second alert condition however IS met
since the total alert condition readings
equals 4 + 4 = 8. The alert condition is 7
total. so the alert DOES go off.

Flashing Red Alert Indicator

4 readings out-of-range, return  Neither alert condition is met.

to normal, 2 readings out-of- The maximum number of consecutive alert

range condition readings is only 4 (5 required.)
The total number of alert condition
readings equals 4 + 2 = 6. The alert
condition is 7 total, so the alert does not go
off.

No Flashing Red Alert Indicator

6 readings out-of-range, return = The second alert condition is not met, as
to normal the total out-of-range events equals 6 (7
required.)
The maximum number of consecutive alert
condition readings however is 6, the alert
condition is 5 consecutive readings, so the
alert DOES go off.

Flashing Red Alert Indicator
Please note following special conditions:

1. If you wish an alert to be indicated on the first reading that is
recorded out-of-spec, place a tick in the box next to "Enable the
Alert (Red) indicator when" and remove the ticks in both boxes
next to the "After X consecutive alert readings" and "After X alert
readings have occurred".

2. You can not enter a number into the "After X consecutive alert
readings" field which is larger than the number in "After X alert
readings have occurred", since the latter alert condition would
always be met first.

3. Similarly, you can not enter a number into the "After X alert
readings have occurred" field which is smaller than the number in
"After X consecutive alert readings". The software will adjust field
values as appropriate.
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Advanced Alert Settings

Some recorders support more detailed alert settings than described
before. If LogTag® Analyzer encounters one of theserecorders,
additional tabs are visible in the Parameter Pane:

Temperature Alarm Settings | Advanced Alarm Settings
You can access the extra tab by clicking on the tab's label.

In the advanced settings the red alert indicator can now be configured
independently for upper and lower alert values.

Readings above X
Readings below Y

(inclusive)

In addition to entering the threshold levels, tick the boxes next to
"Readings above" or "Readings below" to enable the alert conditions for
only the upper or only the lower threshold settings, or for both. If both
boxes are ticked, the behaviour is the same as for the standard alert
settings. The charts will display alert readings according to the settings
made in the Charts section of the 'Options' Screen.

After X consecutive alert readings (W minutes)
Readings above
Readings below

Tick the boxes next to "Readings above" or "Readings below" to
establish whether only readings above and including the upper
threshold or only readings below and including the lower threshold
should count towards the consecutive alert readings. If both boxes are
ticked, the behaviour is the same as for the standard alert settings. If
the Alert Indicator is disabled for either the upper or the lower alert,
the respective box for the consecutive alert is grayed out and cannot be
ticked.

After X alert readings have occurred (W minutes)
Readings above
Readings below

Tick the boxes next to "Readings above" or "Readings below" to
establish whether only readings above and including the upper
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threshold or only readings below and including the lower threshold
should count towards the total number of alert readings. If both boxes
are ticked, the behaviour is the same as for the standard alert settings.
If the Alert Indicator is disabled for either the upper or the lower alert,
the respective box for the alert total is grayed out and cannot be ticked.

The advanced settings tab is displayed automatically if an advanced
configuration is already found in the recorder to be configured. If you do
not wish to use the advanced settings, click the Temperature Alarm
Settings tab.

Example:

You wish to configure a LogTag® so an alert is displayed if 5 continuous
readings are out-of-range or 7 total readings are out-of-range, but only
if the temperature goes to 20°C and above. You wish to see in LogTag®
Analyzer if the product has gone to 0°C and below, but you do not wish
to trigger an alert for this condition. Alert parameters should be set as
follows:

Enable the OK (Green) indicator
Enable the Alert (Red) indicator, when:

Readings abowe [/] | 20.0
Readings below ] [0.0

*]ec
B

*C

After 2 « | [_|Readings above atter 2 + | | Readings above
I:‘Readings below DReadmgs below
consecutive alert readings (Mone) alert readings have accurred (10 Minutes)

/| Leavealertindicator enabled even if readings return to non-alert range
Dgear and reset alert when START MARK button pressed

Figure 39: Advanced Alert Settings - Sample settings

The following table shows how different conditions would result in the
Alert Indicator flashing or not:

Table 11: Advanced alert examples
What the LogTag® recorded | What the LogTag® indicated

2 readings of 20°C or above, Neither alert condition is met.
return to normal, 8 readings at ~ The maximum number of consecutive out-
0°C or below, return to normal, of-spec readings is only 2 (5 required, the 8
4 readings of 20°C or above, readings below 0°C do not count towards
return to normal alert readings).
The total out-of-range events equals 2 + 4
= 6. The alert condition is 7 total, so the
alert does not go off, as again the 8
readings below 0°C do not count towards
alert readings.

LogTag Analyzer User Guide page 55

What the LogTag® recorded  What the LogTag® indicated

No Flashing Red Alert Indicator

4 readings of 20°C or above, The first alert condition is not met, as the

return to normal, 4 readings of  the maximum number of consecutive out-

20°C or above of-spec readings is only 4 (5 required.)
The second alert condition however IS met
since the total out-of-range events equals 4
+ 4 = 8. The alert condition is 7 total. so
the alert DOES go off.

Flashing Red Alert Indicator

Separate alert conditions are useful if you expect the monitored product
to encounter temperatures lower than the lowest possible alert
temperature. In this case a flashing alert indicator may not necessarily
indicate an unfavourable condition was encountered. In programs where
such conditions are monitored the lower alert should be turned off.

Display Recorder Advanced Settings

TRID30-7, TRED30-7 and TRED30-16R recorders have different
configuration tabs:

Alarm Settings | Advanced Settings

Alarm settings

The Alarm settings are similar to the Advanced Alert Settings, hence
they are not explained again here. There is however one notable
exception; for each range (above or below) you can only select either
accumulative or consecutive readings, but not a combination of both.
This does give you the option to select a different number of
cumulative readings for above and below ranges.

Audible Alarm (if available)

When you select this option, the recorder will sound an audible alarm,
if a visual alarm is triggered. This option is currently only available in
TRED30-16R recorders. Please refer to the Product User Guide or Data
Sheet of your specific model to establish, if it has a beeper fitted.
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Please note, that continual activation of the audible alarm will
reduce the working life of the battery. When an alarm event is
triggered, the alarm should be cleared as soon as possible.
Please refer to the TRED30-16R Product User Guide for more
information.

Display Temperature In

Select if you wish to show the temperatures on the display in
Fahrenheit or in Celsius. This setting does not influence how
temperatures are displayed on screen when viewing data in LogTag®
Analyzer. For USB Display Recorders this is located in the File Settings
tab, as it influences both the

Advanced alarm options
gear and reset alarm when STOP/Clear button pressed

[#] alarm remains on even if readings return to non-vislation range
Pause alarm/statistics processing for |2 3| readings when button pressed (10 Minutes)
Show alarm screens during review

Advanced logger options

Switch off display after 30 seconds (Power save) Allow logging stop with STOP button

Shaw total summary days collected Allow reset of logger with START button

Figure 40: Advanced alert options for display recorders

Clear and reset alarm when STOP/CLEAR button pressed

If this option is enabled, any user can turn off an active alarm directly
on the LogTag® by pressing the STOP/CLEAR button. This will turn off
the alarm symbol and reset the internal counters as if no alarm had
occurred while the LogTag® was recording. When the LogTag®
subsequently registers a further alarm condition, the alarm will activate
again. Once the LogTag® has finished recording, pressing the
STOP/Clear button will not clear and reset any active alarm.

An alarm will always be registered in the day summary and
cannot be cleared, regardless of whether the alarm symbol was
cleared or not.

Alarm remains on even if readings return to non-violation range
If this option is enabled then the alarm symbol will stay on, even if the
current reading does not meet the alarm conditions specified by the
previous controls.

LogTag Analyzer User Guide

If this option is disabled then the alarm symbol will stay on only if the
current reading meets the alarm conditions specified by the previous
controls.

P N
Please note: Unlike for units without a display these settings
also apply if consecutive or accumulative alert settings are
configured. If the Alarm conditions are no longer met, all
counters are re-set and an alarm is triggered when the alarm
condition is met again. In any case, an alarm will be registered
in the day summary, regardless whether conditions re-set or
not.

| J

Pause alarm/statistics processing for X readings

If this option is enabled, pressing either button on the LogTag® while
recording excludes the next reading from the alarm and statistics
calculations; PAUSED will now be shown on the display. This allows the
user to review the statistics or clear an alarm without causing an
invalid reading, alarm or statistic.

Switch off display after 30 seconds
If this option is enabled, the display will turn off after 30 seconds to
save battery power.

Allow logging stop with STOP button

If this option is enabled, the LogTag® can be stopped by pressing the

STOP button. The recorder will no longer take any readings, however

you can still review the day statistics and download the logged results
to a PC with LogTag® Analyzer.

Allow reset of logger with START button

If this option is enabled, TRID30-7, TRED30-7 and TRED30-16R recorders
can be reset to the same conditions as if they had been freshly
configured by LogTag® Analyzer. You can then start another trip by
simply pressing the START button.
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When this option is enabled, anyone with access to the
recorder can erase all recorded readings and statistics

without saving the data to a PC first. Please use this option
with caution!

A warning box will be displayed to remind you this is enabled and can
result in loss of data.

Warning: Enabling the ‘reset with START button' option allows
the user to erase all recorded readings and statistics, Are you
sure you want to continue?

Show total summary days collected

If this option is enabled, the LogTag® shows the number of days for
which statistics have already been collected on the display.

Please refer to the LogTag® Product Specification & User Guide
documents for TRID30-7,TRED30-7 and TRED30-16R recorders on the
LogTag® Recorders website at http://logtagrecorders.com/products for a
detailed description of the functionality of these products.

Note: When referring to TRID30-7 and TRED30-7 products,
versions with both the fixed (F-suffix) and replaceable (R-
suffix) battery are included, unless a suffix is specifically
mentioned.

Show alarm screens during review

This option only applies to the UTRID-16. If selected, up to 6 additional
screens are shown when reviewing the data on the display. These
screens show the temperature alarm threshold, and the time above or
below that threshold. If the box is cleared, only the minimum and
maximum screens are shown.

For more information please refer to the UTRID-16 PDF Recorder User
Guide, available from the LogTag® Recorders website.
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Advanced USB Recorder Settings

LogTag® Analyzer allows you to set additional options for USB
recorders, which decide...

« which type of files are generated at the end of the trip

. settings for time, temperature units, MKT parameters and

« how the individual elements of the generated PDF file will be
displayed.

Note: The appearance of the PDF file can only be defined
during configuration of the recorder. It is not possible to alter
the appearance once the USB recorder has completed its trip.

Additional tabs are displayed in the Parameter Pane:

Alarm Settings File Settings Advanced Settings

File settings

Generate data list Date Format: Time Format /S\caleVAms
(®) DDMMAYY (0) 12-hour (am/pm) | | (&) Range of readings

[ show upper atarm line (") Range of sensar

[ show lower alarm line
Show Y axis grid lines
Show X axis grid lines
Show MKT [83.144 K/mal

|| Prioritise download overfile generation

Files to generate: [W/]PDF [W/]LTD [ ]csv

() MM/DDAYY (®) 24-hour ~
(_) Custom range

PDF temperature unit: | Celsius v Upper Limit: 1.0

PDF Time Zone: |UTC <1200 v Lower Limit: 0.0

Use local PC time zone (UTC +12:00)

PDF Brandname:

Alarm Settings | File Settings | Advanced Settings

Figure 41: File Settings tab for USB recorders

Generate Data List

The PDF file always contains a one page overview report. Please refer to
the individual USB Product guides for information about the contents of
the report.

Select this check box to show additional data list pages with a single
row for each reading, along with the with date, time and temperature
values, plus any special events that were recorded against this reading.

When you clear this box only the report summary page will be created.

LogTag Analyzer User Guide

Show upper alarm line

Show lower alarm line

Select which alarm line will be displayed on the PDF. Clear the boxs if
you don't wish to see the alarm lines.

The chart will not automatically zoom to include the alarm
lines, if they lie outside the selected Y-axis scale. If you wish
to always see the alarm lines, set a custom range Y-axis zoom
which includes the alarm values.

Show Y-axis grid lines

Show X-axis grid lines
Select which grid line will be displayed on the PDF. Clear the boxes if
you don't wish to see the grid lines.

The position of the grid lines is automatically determined; it depends on
the Y-axis settings and the time span covered by the readings.

Show Mean Kinetic Temperature (MKT)

Selecting this box calculates and displays the MKT value on the PDF
report. If selected, you can accept the suggested default value of the
Activation Energy of 83.144 KJ/mol, or type a custom AH value in the
text entry field. This value is then used for the MKT calculations.
Typical values range from 60.000 to 100.000 KJ/mol.

When you use LogTag® Analyzer to download a USB recorder, the
custom value can also be used for the MKT calculations in the software.
This is controlled by a setting in the customisation for the Mean Kinetic
Temperature (on page 113)

Prioritise Download over File Generation

When enabled, the recorder attempts communication with LogTag®
Analyzer before generating on-board files. Please seePrioritising
Communication over File Download on page 51 for a more detailed
explanation of this feature.

Files to generate
Select either check box if you want the USB recorder to automatically
create the corresponding file type every time it is plugged into a USB
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port. The files are then accessible on a read-only drive or mounted
device via your file system.

LogTag Analyzer User Guide

The files created by the USB recorder are not automatically
copied to a permanent storage volume on your computer. If
you wish to retain the files you need to manually copy them to
a location such as your Documents folder.

If you clear all check boxes, no files will be generated and you will need
to access the data with LogTag® Analyzer.

Date format

Select one of the options that corresponds to the date format you wish
to use for the PDF report. You can choose between DD/MM/YY and
MM/DD/YY formats.

Time format

Select one of the options that corresponds to the time format you wish
to use for the PDF report. You can choose between 24 hour and 12 hour
(am/pm) formats.

PDF Temperature units

Select the temperature units used on the PDF report and in the CSV file
from the drop down list. For UTRID-16 recorders this also determines
the unit shown on display. It is not possible to configure different units
for PDF and Display.

PDF Time Zone

You can clear the Use local PC Time Zone box and choose a different
time zone. This is useful if you ship to receivers in a different time
zone and you wish them to see the times in their local time.

If you choose your own time zone settings you will need to adjust the
time zone for daylight saving yourself. For example, if you want the
PDF data to show the correct time for a user in New York, set the time
zone to UTC - 5 during Standard Time and to UTC - 4 during Daylight
Saving.

[ Note: The time zone displayed in the PDF cannot be adjusted }

by the receiver! To view the recorder's data in other time zones
the receiver will need to download it with LogTag® Analyzer
and adjust the displayed time zone. See Date and Time Format
on page 150 for further details.

Use local PC Time Zone
When selected, the PDF file will display times and dates in your local
PC's time zone. The time is automatically adjusted for daylight saving.

Y-axis scaling
Select one of the options that corresponds to the scaling you wish to
use for the chart with the recorded readings.

« Range of readings; this scales the chart so the maximum and
minimum temperature displayed is just above/below the
highest/lowest recorded temperature reading. If you choose this
option the maximum screen area is used to display all recorded
readings.

« Range of sensor:; this scales the chart to show the full temperature
measurement range of the recorder.

« Custom range: When you select this option, the entry fields for the
two temperature values become active. Enter the values you wish to
use as maximum and minimum values for the chart's y-axis.

If readings outside your selected custom range are recorded
during the trip, the scaling is adjusted so the chart always
displays all recorded readings.

USB Recorders
There is a short delay after a USB recorder is plugged in, before it can be
accessed by LogTag® Analyzer. This has two causes:

« As soon as the USB recorder is plugged in, it generates any files it
has been configured for. This process is skipped for units that are
factory-new, as there are no files to generate, however with
subsequent configuration for multi-use devices this process can take
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some time, especially if the unit has a full memory buffer and has
been configured to create PDF, CSV and LTD files. While the files are
being generated, the green LED is permanently lit.

. After file generation is complete, the recorder starts a registration
process with the operating system called USB Device Enumeration. It
will take a few seconds while the operating system loads the
required drivers. When this process is complete, the green LED
blinks.

LogTag® Analyzer can only detect and communicate with the USB
recorder once all files are generated and it has completed USB
enumeration (see note below).

e N
Note: Newer USB recorders suppress file generation while
LogTag® Analyzer is running (see Prioritising Communication
over File Download on page 51). This speeds up communication
between software and recorder and is particularly useful for
multi-trip recorders, as they can be re-configured quickly
without having to wait for all files to be generated. If you wish
to access the files on the device itself please close LogTag®
Analyzer and wait for the drive letter to appear.
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Multi-Alarms in USB Recorders

USB recorders can be configured for up to 6 different alarm trigger Temperature
conditions, depending on the model.

« USRIC-4 has a single primary upper and a single primary lower

alarm.
« USRIC-8 and UTRIX-16 allow four freely configurable alarms in Upper threshold Alarm 6

addition to the primary upper and lower alarms.

Upper threshold Al

« UTRID-16 allows a total of three upper and three lower alarms. N
Initially, start with the primary upper and lower alarms trigger Upper threshold Alarm 4 |\ "0
conditions and activate additional conditions separately. For each ) By G

threshold value you enable, you can set the usual values such as Primary upper threshold

threshold temperature, activation type and alarm delay value.

You need to observe some basic rules when entering alarm conditions Ronral i rawgge

into the configuration screen in (missing or bad snippet):

. A primary upper alarm must be entered before more upper alarms Primary lower threshold

Primary lower alarm range
can be entered.

Lower threshold Alarm 3

« A primary lower alarm must be entered before more lower alarms
can be entered.

« Any additional upper alarms must have higher threshold values
than any previously entered alarm. Figure 42: Alarm ranges for USRIC-8M

. Any additional lower alarms must have lower threshold values than
any previously entered alarm.

« You can enter a different number of upper and lower conditions, or

s FoarthUpper Alarm (5) E ater ]2 S Accumulative v
Only upper) or Only lower Condltlons) O none at au You Can) Third Upper Alarm (5) V150 3| Aﬂer! & % | | Accumulative * | violation readings (30 Minutes)
however, not make all alarms upper alarms, and you cannot make Second Upper Alarm () 7o 2]« atter [¥]12 %|[Accumulative | violation readings (1 Hour
all alarms lower alarms either. PrimaryUpperAlamm  (pper V|80 T °C after /|12 3 || Consecutive v | violation readings (1 Hour)
« Threshold values for adjacent alarms can be equal and combined PomeryLowerAtam  Lower [/ 20 T|cc amer[v]12 < [conseatie v | violation readings (1 Houn
Second Lower Alamm (3) 00 F|C arter [ ]2 % Accumulative v

with different alarm types and delay time values. For example, you
can enter a primary upper alarm with an 8°C threshold and 10
accumulative readings, plus an alarm with an 8°C threshold and 5 Figure 43: Representation in LogTag® Analyzer
consecutive readings. In this instance the alam will be triggered, if

either 10 readings in total are above 8°C, or 5 consecutive readings

above 8°C have occurred.
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Any alarm condition that is activated will be shown on the PDF and in
the software.

USRIC-8M and UTRIX-16M models @

For a short period in 2017, USRIC-8 and UTRIX-16 models with multiple

alarm threshold values were sold with the suffix M after the model S M=
name, i.e. USRIC-8M and UTRIX-16M. Effective November 2017 this
suffix has been dropped from the model designation, and all USRIC-8

and UTRIX-16 models now support multiple alarm threshold values.

Models without the M suffix delivered before this date only allow Figure 44: Entry line for alarm trigger conditions

simple alarm settings with one upper and one lower alarm (they can
also not be upgraded).

If you are configuring earlier USRIC-8 and UTRIX-16 models
that do not support multiple alarm thresholds you will not be
able to select the (Advanced Alarm Settings )

For any recorders that do not support the advanced alarm
settings, only primary upper and lower alarms will be set. The
remaining alarms will be disregarded.




Using LogTag® Analyzer

For the UTRID-16 a slightly different screen is shown. Here, the alarm
symbols that appear on the LCD are depicted next to the entries in the
software. The rules above are the same with one notable addition, that
a maximum of three upper and three lower alarm conditions can be
entered.

LogTag Analyzer User Guide

Temperature

Tertiary upper alarm range

Secondary upper alarm range
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Primary upper threshold

Primary lower threshold

Tertiary lower threshold

Figure 45: Alarm ranges for UTRID-16

TertiaryUpper Alam i‘
SecondaryUpper Alam 4 A
PrimaryUpper Alarm A
PrimaryLowerAlam =~ W
SecondaryLowerAlam ' W
TertiaryLower Alam  § W

Figure 46: Representation for UTRID-16
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Using the LogTag® Access Wizard
You can use the LogTag®Access Wizard by either clicking on the toolbar icon (as shown) or by
selecting Wizard from the LogTag® menu.
The LogTag® Access Wizard performs following tasks:
1. All connected interface cradles and USB ports are checked for attached LogTag® products.
If any of them contain previously recorded data these are downloaded and saved.
2. The configuration window is displayed.

The Wizard performs the functions Downloading and Configuring in sequence, so you do not
lose any data.

Note: While the wizard is visible the Automatic download feature will be temporarily
disabled. You will also not be able to access the Wizards while an automatic download
is in progress.

When the wizard completes, you can click |Restart Wizard |, and the process will start from the
beginning.

Quickly re-configuring a LogTag®

You can configure a LogTag® recorder without first displaying the configuration screen. To do
this, you can click Quick Re-Configure from the LogTag menu, and you will see the Upload
configuration screen, where a recorder will simply be re-configured with the settings used for
the previous trip.

You can also press the F6 function key.

There are certain rules when using this function:

« You can use multiple interfaces. Each LogTag® detected in an interface is re-configured with
the same data used for its previous trip. Recorders do not have to be of the same model, and
can each have different configuration settings.

« Re-configuration is only possible for recorders which used the "Push button" or the "Push
button from hibernation" start method for their previous trip. If the recorder's previous trip
was started by the date/time start method the quick re-configure option will result in an
error message being displayed.

« If a recorder requires a password for configuration you will be requested to provide this
password. If you enter an incorrect password, the configuration process will be aborted.

Ll

Wizard

Figure 47: LogTag Access Wizard from toolbar

|E@ Configure 3
!@ Download F4
[_]l Hibernate 5
igj Quick Re-configure 6
F;l Profiles 7§

| i F
|m Wizard 5 2

Figure 48: LogTag Access Wizard from menu

[F@ Configure F3
F\@ Cownload F4

@ Hibernate F5 -

@ Quick Re-configure F&

Q Profiles [}H
@ Wizard F2

Figure 49: LogTag® quick-reconfigure function
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« If the LogTag® is still logging when you reconfigure it, you will be asked to confirm whether
or not you wish to stop the current trip.

Automatic Re-Configuration after Download

To process recorders even faster, you can set-up an option to re-configure a recorder with the
same settings after it has been downloaded by using the automatic download option.

This feature is set up in the Automation section of the general options by selecting Re-
configure with same settings after automatic download.

Once enabled, a LogTag® is automatically downloaded once inserted in the interface cradle, and
immediately re-configured for logging, using the same settings as for the trip just completed.
You will receive a confirmation once the configuration is complete.

If the recorder is still logging during download, you also need to acknowledge that it must stop
recording before a re-configuration can proceed.

Please note this option only works when a LogTag® is automatically downloaded when inserted
into the interface, i.e. the "Enable automatic download of readings from LogTags" option must
be enabled, and the download triggered by inserting the recorder into the interface. This does
not apply when the LogTag® is downloaded through the menu of by pressing F4.

A If the LogTag® you have downloaded does not have a configuration password and has
also finished logging, the only visual feedback on the PC will be after the recorder has
already been re-configured for a new trip. You will only be able to access the data from

the trip just downloaded on the PC, but not within the recorder. Therefore, if the file
location for storing data is not accessible at the time of downloading, the re-
configuration will not proceed..

Continuous operation

All LogTag® products have a limited amount of memory to store the readings they record. When
selecting the option to Record readings continuously, the LogTag® will not stop once the
memory is full; instead it will replace the oldest reading stored with the newest reading.

Not every model supports continuous operation. If you configure a LogTag® and you cannot
select this option, your model does not support this feature.
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re-configured. Are you sure you want to continue?

Figure 50: Confirmation request to allow stopping the recorder
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Pre-start data collection

LogTag® products support a feature called pre-start logging, which can be selected during
configuration.

When pre-start logging is enabled, the LogTag® will automatically start recording as soon as
configuration is completed. It will record at the same sampling interval as defined in the
configuration and will continue to record until the user starts the LogTag® by pressing the
START/MARK button. Once the LogTag® has been started, it will record started readings as per
the configuration settings. While the LogTag® is recording pre-start readings the Alert LED will
not activate, even if an alert condition is present.

Pre-start logging is useful as a fail-safe recording setting so if the LogTag® is not started at the
appropriate time, the readings will still be available to view later.

When the readings are retrieved from the LogTag®, any pre-start readings will be separately
displayed, so the user can quickly identify the readings recorded before and after the LogTag®
was started.

All LogTag®s have a finite amount of memory to store the readings they records. Therefore,
while the LogTag® is recording pre-start readings the LogTag® will operate in its 'continuous
operation' mode, which is explained further in the section Continuous operation on the
previous page. Once the memory within the LogTag® is full, the oldest pre-start reading will be
overwritten with the latest pre-start reading, or the latest started reading if the recorder has
been started.

Once started, the recorder will first fill any remaining memory, then overwrite the oldest pre-
start readings until the complete memory is filled with started readings.

If a LogTag® has been configured to start recording at a certain date/time, or for push button
start from hibernation, no pre-start readings will be recorded.

Restricting Access

You can enable a password protection feature, which requires any user to enter the correct
password when they next configure the LogTag® for recording. This prevents a user from
accidentally erasing data

During configuration, select Configure requires a password. A password entry field appears,
where you can enter a password.

A confirmation of this password is required.

Password:

[ ]configure reguires a password
|| Download requires a password

Figure 51: Password entry
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Tip: Sometimes users tick the password required box, but don't enter a password. Such
a "blank" password is valid, hence the password request dialogue will appear when re-
configuring such a unit. In this case simply selecting will advance to the next
screen. A warning message will inform you when you are using a blank password.

Protecting Recorded Data

Not only can you protect a recorder's configuration, most models can also be set up so they
require a password before you can access recorded data. This function can be enabled in the
main configuration screen by selecting Download requires password. The same password is used
to protect configuration and download.

The features can be used independently. You can use a download password without a
configuration password, and vice versa, or use both passwords, or none.

Password Rules

The password can be up to 6 characters long (16 characters for USB recorders) and can contain a
mix of letters, numbers and special characters. The selected input language of the computer's
operating system determines which special characters can be selected.

If a user decides to make use of special characters, extra information about the language used
is stored inside the recorder. Users will then need LogTag® Analyzer 2.3 Release 7 or later so the
password is correctly interpreted.

This feature is not available in USB recorders.

If you use special characters for languages such as Japanese or Chinese the maximum number
of characters that can be used will be reduced due to the increased memory required to store
the characters.

Please see Code Pages on page 161 for a more detailed explanation.
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Verify Access Password

If the Configure requires a password option was enabled or the password was changed during
the configuration process the user is required to verify the password before it will be stored in
the LogTag®. A window similar to this will appear:

Once a password has been stored in the LogTag®, it can only be accessed by providing the
correct password. Therefore, if you forget the password you will no longer be able to access the
LogTag® Passwords are case sensitive - the passwords "Bob" and "bob", for example, are
different.

Hibernation - Prolonging battery life

If your LogTag® is not going to be used for extended periods of time you should hibernate it.
While in Hibernation the LogTag® will consume minimal power, which will extend the battery
life when compared with leaving an idle LogTag® operating.

While a LogTag® is hibernated it will...
not record and store any new readings.
not activate the Alert and OK lights.
not respond to the START/MARK button being pressed.

The only exception is when the LogTag® has been configured for Push button start from
hibernation in the configuration screen. In this case pressing the START/MARK button will
'wake' the product and commence logging according to the configured settings. Not every
model supports this feature.

To 'wake' a hibernated LogTag®, go through the usual process of Configuring a for logging (see
page 1).

To hibernate a LogTag®, select Hibernate... from the LogTag menu.

You can also use the F5 function key.

The password for the LogTag(s) has

changed. Please verify the new
password to be used.

Description:  Password Update
Password:

@D o Q) cocel @ nev

Figure 52: Password confirmation

[ conigue F3
[ pownioaa F4
Iiz Hibernate ]
[@j Quick Re-configure® ~ F6
[ ) Profiles F7

@ Wizard F2

Figure 53: Hibernating a recorder
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You will see the window one on the right when hibernating a recorder.
One of the following icons will show next to each of the items in the list:
« (no picture) indicates the LogTag® is still in the process of being hibernated.

« ¥ The LogTag® was successfully set to hibernation.
. X The software was unable to set the LogTag® to hibernation.

Once a LogTag® has been successfully hibernated it should be removed from the Interface
Cradle before pressing any other button. As soon as the software communicates with a
hibernated LogTag® (for example through automatic download) it will be returned to normal
operation.

The extent to which Hibernation will prolong the battery life of a LogTag® varies between
different models and versions of LogTag® products. Some LogTag® models do not support
Hibernation.

Starting and using the LogTag®

Once a LogTag® has been successfully configured, it must be started to take readings.

A recorder can start automatically at a date and time set during configuration, or manually by

pressing the START button on the recorder.

The different start methods are explained in more detail in the section about Configuration
Parameters.

For exact procedures how to start a recorder or indicator product please refer to the individual

Product User Guides and Quickstart Guides, available for download from the product web pages

at http://logtagrecorders.com.

a

The software will locate the LogTag products for you and set them to
Hibernate mode. Please do not remove LogTagi(s) or disconnect

interface(s) during this process.

Only LogTagi(s) with a tick has(have) been hibernated.

|

UsE
USE
USB
use
USB
UsB
use

G Again

-
Location

Interface Model LogTag ID
tHID 5034000005
LTI/HID 5999000002
LTI/HID 5040000036
LTHID 5040000030
LTI/USB OOFEOFD6 Not found
LTYHID 5040000038
LTIYUSB 03101C06 1060026140

0 Close
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Configuration Profiles

To simplify the task of configuring multiple recorders with the same
parameters, you can store the settings you would enter during
configuration (such as alert limits, logging interval, number of
readings etc...) in a Configuration Profile, then use the profile to
configure recorders as required.

Configuring a recorder with a pre-defined profile requires only three
steps:

1. Select Profiles from the LogTag menu
The window now displayed gives you an overview of the profiles
already installed. You can also add new profiles or edit and delete
existing ones.

2. Select the profile you wish to use in the Configuration Profiles
main window

3. Click on Configure loggers

The next few pages detail the steps required to add and manage
configuration profiles.

LogTag Analyzer User Guide

@ Configure F3
F@ Download F4
@ Hibernate F5
@ Quick Re-configure F&
‘@ Profiles F7

[
Wizard F2

Figure 55: LogTag Profile Menu

Configuration Profiles ==

Double-click an a profile to configure loggers with the profile settings
Available Profiles il

Name Model Attributes ~ ° Configure Loggers
| Trix Profile | TRIXTREX Riwl J
Haxo Profile HAXO B Retain Description/Password
UTRID Testing UTRID R

1

]

Profile Grid
Delete

M

2 VNS WIC - Users'User\ Documents Data'Configuration Profiles’Profiles Jtpx @

Reload from file \

Import l l Export Selected l

@ e | o]
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Filename

Profile File
Controls

Dialogue Controls

Figure 56: Configuration Profiles Main Window
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Profiles Grid

When you first select this feature the profiles grid will be empty. You will fill the grid by adding Name Model Attributes =
profiles, or importing profiles. Trix Profile TRINTREX R/
Profiles from the grid can then be used to configure recorders. A single click on the column title Haxo Profile HAXO R

will sort the profile using this column. Double-clicking on a profile will configure all recorders UTRID Testing UTRID R

currently in connected interfaces using the parameters stored in the configuration profile. You
can select multiple profiles for export or deletion when you hold down the CTRL key while
clicking, but you cannot edit or apply more than one profile at the same time.

11

1|

Figure 57: Profiles in the profile grid

Profile Control Buttons

Clicking on a profile row and clicking (Configure LogTags ] will configure all recorders currently
attached, using the parameters stored in the profile (you can also do this by simply double- ot one -
clicking the profile name). =

To be configured, recorders must have the same model name as in the profile.
Use the control buttons to add new profiles and to edit or delete existing profiles.

Clickingwill bring up the Edit Profile window without any parameters. Type a Profile
Name into the text entry field and select a Model from the list.

Once you have selected a model, the configuration parameters for this model appear. They are
the same parameters as already described in Configuring a LogTag® for recording on page 43

@

Figure 58: New profile window
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The same window will be displayed when you click. Every entry field is now populated with
the saved value for this profile. Any entry field can be edited, with the exception of the model
type and the profile name.

Click to store the profile in the Profile file, to discard any changes and to
display the help screen for this window.

Profile Storage File Name and Path

The collection of profiles displayed in the profiles grid is saved in a single file on your PC, which
is called the Profile File. This file is typically stored in a folder called LogTag Configuration
Profiles inside the My LogTag Documents folder. Every time you open LogTag® Analyzer this
profile file is activated.

You can select alternative collections by opening different files. This can be useful if for
example you want to keep different profiles for different customers, or you prefer to separate
and organise your profile collections.

You can click on the [ button and select a different profile file. If you have unsaved changes
you will be asked to confirm if you want to first save these changes. An explorer window will
then open, where you can select a new profile file.

Note: To create a new profile file, export one or more profiles to a new profile file. You can
then open the new profile file and add, edit or delete profiles as usual. Alternatively, you can
download an empty profile file template from
http://logtagrecorders.com/download/software/analyzer/Blank_Profile.ltp.

Profile File Controls

If you have stored your profiles in different profile files, you can transfer data between
different files with the (Import] and (Export] buttons.

When you click on the button, a file explorer window will open. Browse to the profile
file from which you want to import the profiles and confirm your selection by clicking (Open)
All profiles from the selected profile file will be imported into the currently active profile. If a
profile is imported that has the same name as an already active profile, you need to confirm
whether you wish to skip the import of this profile or overwrite the active profile with the
imported profile.

You can export selected profiles to a new file by highlighting a profile and clicking [Export] A
file explorer window will open, where you can enter a new profile file name (the file will be
created when you click, or overwrite an existing profile. If a profile is exported, and a
profile file already exists, you need to confirm whether you wish to cancel the export of this
profile or overwrite the profile file. You can export more than one file at the same time by
selecting the desired files while holding down the CTRL key.
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consecutive alert readings (None)
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v

uires a password
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= | 5Minutes
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Figure 59: Editing a TRIX-8 profi
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Configuration profile TRIX a
Do you want to replace it?

Iready exists.

Figure 60: Prompt when overwriting an existing Profile
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You cannot amend a profile file by exporting a profile to it. Exporting a profile will
always overwrite the target profile file.

Profile Dialogue Controls

Clicking will store the profile in the location entered above. Clicking will
discard any changes and return you to the main window.

Please note there are some restrictions when you work with configuration profiles:

Configuration profiles cannot use the date/time start mechanism. If a defined start time
were to be applied to a profile, this time would most likely have passed by the time the
profile is applied. If you need to configure a number of recorders and you want them all to
start at the same time you should use the standard configuration method and the

unction.

You cannot configure one type of recorder model with a profile written for another model.
You cannot have multiple profiles with the same name.

If you have exported a profile to a profile file, cancelling the main edit window will not undo
the changes.

If you try to apply a profile to a recorder with a password protected configuration, this same
password must be provided in the profile. There is no separate password confirmation
dialogue.

Recorders that can be upgraded to use a download password will automatically be upgraded
when a profile is applied using this feature.
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Sometimes a recorder cannot be configured using a particular profile. In this case one of the
following errors will be displayed:

Message

"Logger does not
support advanced
alert settings"

"Logger cannot
record more than
X readings"

"Password in
profile does not
match logger
password"

"A password
cannot be applied
to this logger"

"Logger only
supports latched
master alarm"

"Profile logger
type does not
match"

"Lease expired.
The max. number
of starts has been
reached."

Table 12: Profile error messages
What it means

You have selected a profile which has separate upper and lower alert settings, but
the recorder you wish to configure does not support this. You will need to use a
different profile, or use a different recorder if this feature is important for this trip.

You have selected a profile that requires the recorder to take more readings than fit
into its memory. You will need to use a different profile, or use a different
recorderif this feature is important for this trip.

You have selected a profile with a password, and the password currently stored in
the recorder is different. You will need to use the normal configuration process to
remove the password; after that you can use the profile function to configure the
recorder with the new password. If the recorder does not allow the password to be
changed, you will need to use a different profile.

You have selected a profile with a password, but the recorder is factory configured
so the user cannot change or enter a password. You will need to use a different
profile that doesn't have a password protection, or use a different recorder if this
feature is important for this trip.

Recorders typically can have a setting applied that allows an alarm to reset if
conditions go back to within specification. Some older TRID30-7 recorders do not
support this feature, and if you attempt to configure such a recorder with a profile
using this setting you will see this error. You will need to use a different profile or
use a later model TRID30-7 if this feature is important for this trip.

You are trying to configure a unit with a profile that was created for another model.
A profile is specific to a recorder model, so you will need to use a different profile.

You are trying to configure a unit which has no more trips left. You will need to use
a different recorder.
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Results from LogTag® Recorders

Once a LogTag® has finished its trip, you can
« download the data to a PC
This section explains this in more detail.
. view and analyse the information
Read about this in the section Analyzing the results on page 82
. print the information or save it to other formats.
You can find details in Printing the results on page 110

LogTag® products store all recorded data in their internal, non-volatile memory. You can
download the data as many times as you want, as long as the recorder is not re-configured or
hibernated.

When you download the data, a file is automatically created in a pre-defined folder. Typically
this is the C:\Users\User\Documents\My LogTag Documents folder, but you can customise this
location to your requirements File and Folder Settings on page 139

Downloading data stored in a LogTag® does not erase the data from memory, however if you
have enabled the "Automatically re-configure..." option you will no longer be able to access the
data in the recorder once this process has started.

If the LogTag® is currently recording while you retrieve the information, it will continue to
record without interruption. If the recorder is in the process of taking a log you may see a
slightly longer download time as communication pauses to allow the log to be taken.

There are three ways to retrieve the recorded results from a LogTag®:
« Vvia automatic download

Slot the LogTag® into the interface cradle, or plug it into a USB port while the LogTag®
Analyzer software is running (even when minimized). If the automatic download feature is
enabled, the software will automatically retrieve the recorded readings, save the information
to your disk drive and display the information. While the software is retrieving the readings
you will see an animation. A new animationm will be displayed for every new recorder
attached.

You can also enable the option to automatically re-configure the LogTag® with its current
settings (see Automatic Re-Configuration after Download on page 1).
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o A new LogTag has been detected in the interface. Please
wait while its readings are downloaded.
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Downloading a LogTag® automatically
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» via the menu system [_ Configure F3
Click Download from the LogTag menu. ‘
You can also press the F4 function key. [F@ Download F4

« Using the Wizard @ R % =
Click the LogTag® icon on the toolbar or click on Wizard from the LogTag menu.

The wizard retrieves the readings stored in the LogTag® and then offers to configure the @ Quick Re-configure F&

LogTag® for its next trip.

al' Profiles F7
Wizard F2

Figure 61: Download Menu
Progress Pane

When you initiate the download manually, rather than using the auto-download feature, the _

LogTag Download window will be displayed. Each recorder found will be listed in the Progress v —— e e e
pane, much the same as in the Configuration Window. Vo i s s G e S e e
Please enzure the following are {omest
When you see this icon displayed, communication was established, but no data were 88 et | rold o e OB e S Ccas o
downloaded. The most likely cause is that there are no readings in the recorder. ieareg D -
ATRIC-NE SHESO4000000E tﬂ
T nowrioaded
Siaseanty 1
@ When you see this icon, no recorder was found in the attached interface. -
M!?;:EII;;JW‘ =
9 : LogTag USBHID- r
rl Data from this recorder was downloaded, but the recorder has has a low battery. It should (hmruulbensi SRS
_ not be used for another trip o g
(o) This dicon is displayed after the recorder has been successfully downloaded and the data e T
saved. < —
_@ . & e 0 o @ -
The progress bar will also show the word Downloaded
Q . . .
rl This icon is displayed after an unsuccessful attempt to download the recorder. Further error Figure 63: Progress Pane when downloading data
_® messages will be displayed to indicate why the recorder was not downloaded.

When the recorder has completed its trip and you wish to see the recorded readings, place the
LogTag® into the Interface Cradle.

If the LogTag® is still recording it will continue to do so. A USB recorder, however, will not
record temperatures while plugged in; instead it will record Paused readings.
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The software will automatically download any readings and save them in a file.

Once the readings have been successfully downloaded, the software will display the
information. The chapter Results from LogTag® Recorders on page 75 explains in more detail
what information is displayed and how you can influence its appearance.

Your LogTag® may now also be reconfigured for another trip with the same settings as before,
if you have this option activated (see Reconfigure with same settings after automatic download
on page 131.)
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0 A new LogTag has been detected in the interface. Please
wait while its readings are downloaded.
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Figure 64: Downloading a LogTag®recorder
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LogTag® Data files

Every time you download a LogTag® Recorder to your computer the data are automatically

saved to a file with a *.1tdx file extension (LogTag® Data Extended). This file is then opened,

and presented to you on screen. When you download a LogTag® product, and view the data, you

are therefore viewing the file that was saved when the LogTag® was downloaded.

The *.1tdx file is unique to LogTag® products and can only be read by LogTag® Analyzer

software.

You can customise a number of options for this file in the Edit - Options window:

« You can define the file's name, for example by specifying details about the recorder from
which the data were downloaded (File Name on page 140)

« You can decide if existing files with older data should be overwritten or kept (Uniqueness on
page 145)

« You can automatically have files sent to email recipients and FTP sites (Automation on
page 131)

« You can decide which additional other file formats are created, for example PDF files
(Exports and Reports on page 147)

You can also combine data from multiple files as on the next page.
Please refer to the respective sections in this user guide for more information.

Note: If the recorder you are downloading has not taken any readings, a message such
as the one one on the right will be displayed.
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The following LogTag has no readings stored in its memary.
The logger has not been configured or started.
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Figure 65: No Readings to download!
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Digital signatures

Support for digital signatures is primarily provided for compliance with
the US FDA 21 CFR Part 11 regulation - Electronic records and electronic
signatures. Various industries, however, may find inclusion of digital
signatures beneficial towards their quality control and assurance
systems.

Digital signatures allow users to record an event in a LogTag® Analyzer
file along with their digital signature. To add digital signatures to data
files, LogTag® Analyzer must be connected to the LogTag® User Server
software. For more information how to connect see User Server on
page 154, or contact your local network administrator.

To add a signature to a file, open the file it and click on Signatures
located on the toolbar, which will display the File Properties window
with the Digital Signatures tab already activated.

Then click New to start adding a digital signature.

Once the Add Digital Signature dialog box appears, enter your LogTag®
Analyzer user password and select the meaning for the digital signature
that is being added.

Click to permanently add the digital signature to the file or
d

anceljfo abort. Multiple digital signatures from the same or different
users can be added to a single LogTag® Analyzer file.

How secure is my data

LogTag® files are encrypted and contain checks to detect if the file
changed since it was originally created. If the software detects that a
file has been tampered with, or has become corrupted, the software will
not open the file.

LogTag® devices will also insert error detection codes automatically
during recordings, which are used to detect data errors. When these
detection codes for a block of recordings fail the integrity validation, the
relevant readings are marked as non validated readings. Non validated
readings are displayed differently to validated readings to indicate that
they have failed their integrity test.

Non validated recordings typically occur in the scenarios following
scenarios:
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1. One or more readings in the non validated block of readings is not
the genuine recorded value.

2. A communications or hardware failure has occurred during the
transfer of the data from the LogTag® to the computer. Try
downloading the recordings from the LogTag® again; make sure
the contacts on the back of the LogTag® are clean, the contact
pins in the Interface Cradle slot are clean and return evenly to
their normal position when the LogTag® is removed.

Since the software does not modify any of the recorded data within a
LogTag® file at any time, if the software can open the file, regardless of

long ago it was created, the contents of the file will still represent
t @ original recorded information retrieved from the LogTag®.

gnatures

herefore, the files created by the LogTag® Analyzer software meet all
%l %reer?ag: ?ifgl%tség??fgeregﬁ:f%?%aﬁ data secguriftgy as sety forth in the US FDA 21
CFR Part 11 regulations. The firmware code that is embedded in the
processor chip of each LogTag® cannot be extracted or reverse-
assembled. Accordingly, data sets that are recorded in the memory of
the LogTag® cannot be downloaded or modified except by being
transferred to a LogTag® file. There is no way to interfere with the
process of the transfer of information between the LogTag® and the

software in such a way that data integrity would be compromised.

Saving a Multi Chart file

If the main LogTag® Analyzer window currently displays a Multi Chart
(see Combining charts onto a single chart), you can save it by clicking
2 on the toolbar or selecting Save from the File menu. Select a file

name and location for your Multi Chart file. The file extension for Multi

Chart files is * multix.

A Multi Chart file contains a copy of each individual file that makes up
the chart along with any zoom settings, annotations and the
information that describes which relation the data files have to each
other.
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To open a previously saved Multi Chart configuration file, click on the
£ toolbar icon or select Open from the File menu , then select the

"* multix" file to be opened. To save a Multi Chart file under a
different name, select the Save As command from the File menu and
enter a new file name.

Note: You can save a Multi Chart file as a PDF, but not as any of the
other export file types.

LogTag® indicator products such as the TICT or TIC20 do not have
date/time related readings and therefore do not appear on a Multi-
Chart.

Selected LogTag® Data files (*.sltd)

The file type *.sltd is a legacy file type, which you can open with this
version of LogTag® Analyzer. In this file LogTag® Analyzer version 2.X
allowed you saving data zoomed to a particular time window. When
opening a * .sltd file, LogTag® Analyzer version 3.X will extract the data
for the complete trip and present the data zoomed to the time window
stored in the file.

Since the new * ltdx format has this function built in, the support for
saving this file type has been discontinued.
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Calling up previous results
To open a stored file, click the Open toolbar icon or click Open... from the File menu. This will

& OpenFile(s)

display the Open file dialogue.
1 H : . . . « -1 « logTagRec... > Documents v © | Search Documents o
Browse to any location accessible by the Windows® Operating System, including network and .

A K . i C \ rganise ¥ New folder - M @
ftp locations. Select the desired file and chck. Please refer to your operating system's N N e - Date modifie &
help for more lnformatlon ; Desktop ls\. USRIC-8- 4035011749 Started , Finishe... e

. 2 Documents S UTRIX-16- 5040000030 Started 16-11-2...
With LogTag® Analyzer you can open ltd Egmm; ~
. i i ) B2 TIC20-W2- 1082001064 Started , Finish...
The files that have most recently been opened are listed in the Select Recent File sub-menu the J’ :‘ B TIC20-W2- 1082001054 Started., Fiish...
. . . . &= Pictures
bottom of the File menu. After the software has been installed for the first time, there are two B Vicos 'f“;jzmw’;’: e
files in this list, even though no files have been opened yet. These are sample files, which have 4 Local Disk (C) e : — o
been installed along with the software, so that users can see an example of how a LogTag® file File pame | <] [LogTag AnalyzerFles Cita, "
looks. These files are not required for the correct operation of the software and therefore may Caneel

be deleted at any time.

You can also open files directly from Windows® Explorer or your email software by double
clicking on the file or right clicking and selecting Open. When opening files from email
programs that store attachments in temporary folders such as MS Outlook, you may be asked to
store the file in a new location when performing further actions such as selecting multi-charts
or uploading to FIP sites.

If the software is unable to open the file, it will display an error.

Unsupported LogTag version, You may need to update your
software,

Figure 67: File Open dialogue window

Figure 68: File not compatible with current version of LogTag® Analyzer
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Analyzing the results

Data are displayed and analysed in file windows, which appear inside the main LogTag®
Analyzer window. Each file window displays the data of a single recorder and has a series of
View tabs along the bottom. Clicking on a tab changes the way the information is displayed;
different windows can display different tabs.

You can activate Multi-Chart display, and all open file windows are combined into a single
window. You can find more information about this feature in Multi-Charts (Combining Charts
into a Single View) on page 91.

These are the different ways to display the information in the file windows.

Table 13: View Tab summary

Tab selected Information displayed

Report Tab A summary display of the downloaded data, including a summary of the important
trip information and an overview graph.

Chart (or Log A display of the data in a humidity and/or temperature versus time chart.

Chart)

Data A listing (spreadsheet style) of the time versus humidity and/or temperature data.

Summary A summary of the data, including averages, ranges, alert results, LogTag®
identification data, and other information.

Day Summary A summary of the day statistics for display recorders.

Day Summary A display of the minimum/maximum data in a temperature versus time chart; for

Chart the iSo°Tag indicator only.

Not all tabs may be displayed. You may for example see only Report, Chart, Data and Summary,

if the LogTag® does not have a statistics memory.

The readings range determines which section of the trip is shown in the view tabs. Click on the
drop down arrow and select the range you wish to display. Note that you can only make this
selection in the Chart and Data view tabs.

Report | Chart | Data Summary Day Summary All Readings

Cewioe YR i orse

Figure 69: View tabs and reading range selection
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Table 14: Reading range selection
Tab selected Information displayed

Pre-Start Readings The file window only shows data for pre-start readings, but omits any
readings taken after the recorder started. This cannot be selected if the
recorder has not taken any pre-start readings.

Started Readings The file window only shows the data for readings taken after the recorder
started, but omits any readings taken prior to the start. This cannot be
selected if the recorder has only taken pre-start readings

All Readings The file window shows the data for all readings taken by the recorder.
The most used tabs will typically be the report tab or the chart tab, as the information displayed

in either of them gives an instant overview of the data, whether just recorded and downloaded
from a LogTag®, or retrieved from previously stored data files.

Note: Indicator products such as the TICT or TIC20 only display the Report and Day
summary tabs. The iSo°Tag indicator displays Report, Log Chart, Data, Day Summary
and Day Summary Chart tabs. A reading range selection is not possible for these
products.

The following sections describe each type of information display (Report, Chart, Data,
Summary, Day Summary and Day Summary Chart) in more detail.
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Chart Display

Clicking on the Chart tab presents the
information in the file window as a 2-D line
chart with markers. When you first start
LogTag® Analyzer, this tab is activated by
default, but you can change this in the
Options .

You can see how temperature (and humidity
if applicable) changed during the trip.

If you want to see parts of the graph in more
detail, you can zoom in and display a smaller
section of the data. Move the cursor to the
upper left corner of the area you wish to
magnify, hold down the left mouse button
and move the cursor so it covers the area you
wish to see.

Temp *C .

LogTag Analyzer User Guide

HAXO-8: 0013350720 Started 05/12/2007, Finished 05/21/2007
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When you release the left mouse button, the
area highlighted now fills the window.
Depending on the zoom level not every data
point may have a marker displayed. LogTag®
Analyzer intelligently adjusts the display of
markers so the graph line is still visible. These
markers can also be turned off, and their
appearance can be altered. You can learn
more about this in the Charts Section. You can
also see a number of other marks. Inspection
marks are recorded in the LogTag®'s memory
each time its START/MARK button is pressed.
Download marks are recorded in the
LogTag®'s memory each time it is downloaded
toa PC.

When the mouse pointer is moved over the
chart, a tooltip is displayed near the mouse
pointer (as shown in the example). It displays
the reading closest to the mouse pointer
position. If the readings are very close
together, you may want to zoom in further
and then inspect individual readings with the
help of tooltips.

When elapsed time is chosen for the x-axis
display, the tooltip will also show the elapsed
time.

You can also add annotations (Chart
annotations) to the chart.

LogTag Analyzer User Guide
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The chart area displayed in the window can be copied to the clipboard by...
right-clicking anywhere on the chart and clicking Copy from the shortcut menu.
Pressing CIRL-C
Clicking Copy from the Edit menu.

This picture can then be pasted into any Microsoft Windows® application.

The chart is copied to the clipboard at its current zoom range.

You can change the appearance of all charts permanently by changing the options in Charts. If
you wish to temporarily change the appearance of only a single chart in the file window you
can use the Chart Control Panel, or the shortcut menu when you right-click on the chart.
These controls influence general items on the chart, such as turning on and off marks and grid
lines; these can be useful for finding information on the chart easier. Clicking on an enabled
item will disable it and vice versa.

The shade controls can be used to highlight the alert and non alert areas of the chart for easier
identification.

You can use the zoom controls to define which part of the data is displayed on screen (see
Zoom Control) and the Annotation menu to display text on the chart (see Chart annotations).
To close a window, click the x on the file window tab. You can also click the * on the right side
of the window. When you right-click on a file window tab, you can also close the file itself, but
also close all other files, or close all files.

The Chart Control Panel

The chart control panel provides you with an easy way to turn elements of the chart on or off,
to annotate the chart and to manipulate which part of the data is being displayed.

The upper part of the chart control panel contains some of the functions you can also find on
the toolbar. These are replicated here to give you easy, convenient access in one location. These
include scaling functions, time axis and inspection mark zoom.

(=)

Zoom Out

Y

:: Zoom Readings
#|  Manual Scaling
bk

Real Time
Elapsed Time

Zoom

Previous

00 QI

et

Figure 72: Upper Chart Control Panel
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The lower part of the Chart Control Panel controls what additional information is displayed on
the chart. The default values for the various grid lines, markers and shadings are set in Edit -

Options - Charts.

~

defaults.

The options you set in the chart control panel are stored with the chart, provided you
save the file after you have made the changes in the chart.

At a later stage, if you wish to return to the default settings you can click Reset do

You may also receive charts from other users with settings different to your own. These
charts can also be reset to default values using this method.

Feature
Align charts
(multi-chart only)

Reset do defaults
Annotate chart
Show annotations
Inspection Marks
Reading Marks
Download Marks
Paused Marks
X-Axis Grids
Y-Axis Grids

Show only validated

Table 15: Additional information for Charts
What this feature does

Shifts all charts so their first readings align on the canvas. Please see
Aligning Charts on page 94 for more information.

Changes the appearance and position of all charts so they correspond with the

settings made in Edit - Options - Charts.

Opens the Annotation Panel and allows you to annotate the chart. Please see
Chart annotations on page 97 for further details.

Select, if you wish to show the chart's annotations, clear, if you wish to hide
them.

Select, if you wish to show each recorded Inspection Mark in the chart, clear,
if you wish to hide them.

Select, if you wish to show the chart's Reading Marks, clear if you wish to
hide them.

Select, if you wish to show each recorded Download Mark in the chart, clear,
if you wish to hide them.

Selec,t if you wish to show each recorded Paused Mark in the chart, clear, if
you wish to hide them.

Select, if you wish to show the X-Axis (vertical) grid lines, clear, if you wish
to hide them.

Select, if you wish to show the Y-Axis (horizontal) grid lines, clear, if you
wish to hide them.

Select, if you wish to show only validated readings on the chart, clear, if you
wish to hide them. Please see How secure is my data on page 79 for further
information about non-validated readings.
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Feature What this feature does
Above Alert Shade Select, if you wish to show readings above the upper alarm limit with a
(single-chart only) different background colour, clear, if not.

Recorders with more than 2 alarms may show more than one
background colour. Please note these cannot be turned off

individually.

Non Alert Shade Select, if you wish to show readings in the non-alert area with a different
(single-chart only) background colour, clear, if they should appear with a white background.
Below Alert Shade Select if you wish to show readings below the lower alarm limit with a
(single-chart only) different background colour, clear, if not.
Temp alert range/ If the button shows Temp alert range, the alert shading uses the temperature
Hum alert range maximum and minimum alert values for the shading. If the button shows
(HAXO-8 single-chart Hum alert range, the alert shading uses the humidity maximum and
only) minimum alert values for the shading.

The Y-Axis gridlines also adjust so they align with the corresponding

divisions.
Hide/Show (/ =4) Clicking hides the Chart Control Panel when it is currently shown, clicking

=4 shows the panel when it is currently hidden.

Manual Scaling

Sometimes you will want better control over the temperature and humidity scale, or the time MasiSae W

window in which readings are displayed, than you can achieve with the mouse zoom. () Range of sensor

To do that, you can enter the zoom values directly: O Range of readivgs
. . . . . (@) Custom range

Right-click anywhere on the chart area and select Manual Scaling. The dialogue as shown will &

. From *C ToC
be displayed. 20 2] e B 00 =
You can select:

. .. . from to
« Range of sensor; the chart is zoomed to the minimum and maximum values for each sensor. pop . . e
These values are dependent on the recorder model. = =

« Range of readings; the chart is zoomed so the axis covers the minimum and maximum @) Date Otrdex
reading values (with a small margin added). e Wedne s Fetran 7. 2012 [§O0 O ;| EEnees
fo: Thursday, February 3, 2012 v 2204 @ :_ 5853 4

« Custom Range
When selecting this option you have complete control over which part of the graph is
displayed. @ « Q) conce @

You can specify

[C] apply to all open charts

Figure 74: Manual scaling window
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o The temperature (and humidity ranges if applicable) for the y-axis.

o the date and time range for which the readings will be shown. Please note that you
cannot enter dates and times outside the span of the recorder's logged data.

o Alternatively you can specify an index range for the readings. You can see each reading's
index in the data tab. This is useful if you wish to display a certain part of multiple files
that do not cover the same date and time range.

Initially the dialog shows the current zoom settings.

If you select the check box Apply to all open charts, these settings will be applied to all

currently open charts as follows:

« The Y-axis scaling (temperature and humidity) will be applied to every open chart. Range of
sensor and Range of readings use the currently active chart's sensor range or reading range
for all charts. If you want each chart to display its own sensor or reading range, please select
the corresponding option in Default Zoom in the chart options.

« The X-axis scaling (time) will be applied to every chart with readings inside the selected
time frame, including pre-start readings.

If a chart's readings fall completely inside the specified range, the X-axis will not be scaled.
If a chart's readings fall partially inside the specified range, the X-axis will be scaled so only
those readings inside the range will be displayed.
A chart will always display the readings at the time they were recorded. As a result the first
and last readings may not always align perfectly with the selected time frame, particularly
with long log intervals.

« No scaling will be applied to files where the active tab is the summary tab, day summary tab
or one of the data list tabs.

The zoom range is also not applied to TIC20 and TICT indicator products.

If you clear the check box Apply to all open charts, the chosen settings will only be applied to
the currently active chart.

Click to apply your selected settings, or to abort.
@

To return to the previous zoom level, click Zoom Out from the Edit menu, click zemos on the
toolbar or right-click anywhere on the graph area and select Zoom out. You can do this

individually for each chart. You can also right-click and select Zoom Readings.

Inspection and download mark zoom

You can also zoom directly to certain parts of the chart by using the inspection mark zoom icons
on the toolbar and in the context menu. Note that these controls are disabled when a Multi-
Chart tab is active.
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Zoom

o

Previous

Zoom Qut

Zoom to inspection marks

This zooms the chart so readings are shown between the oldest reading recorded and the first
inspection mark in the data. If this function is not available then there are no inspection
marks in the data currently being displayed.

The next two commands will not be available until this command is activated.

Previous inspection mark group

This zooms the chart so readings are shown which were recorded between the first inspection
mark currently being displayed and the previous inspection mark.

This function is not available when the oldest reading is already being displayed.

Next inspection mark group

This zooms the chart so readings are shown which were recorded between the last inspection
mark currently being displayed and the next inspection mark.

This function is not available when the newest reading is already being displayed.

Zoom out

Zooms out one level of the chart in the currently active window. If you are displaying a chart
and this function is not available, then all available data are already being displayed and you
cannot zoom out any further.
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Multi-Charts (Combining Charts into a Single View)

You can overlay data from multiple recorders

in one view. When you click mm in the
toolbar, all file window tabs containing data

for a single recorder are combined into one
window, where you can access a Multi-Chart
and a Multi-Report by clicking the
corresponding tab.

Charts will be shown in different colours, as
chosen in the colour palette in the Options for
Charts, where you also define the composition
of the Chart Legend. The legend contains an
entry for each chart showing the chart's
colour and the description defined in the
settings.

You can annotate a Multi-Chart in the same
way you annotate a single chart.

You can also view Min, Max and Average
Charts, and select other options.

When you close a newly created Mutli-Chart,
it will either be stored automatically, or you
will be asked if you want to store the chart.
This depends on the settings made in File and
Folder Settings (as described on page 139).
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Hiding and Showing Charts

In the Multi-Chart window you can hide each
chart individually. Right-click anywhere on
the chart, point to the entry of the file you
wish to hide and click to clear the tick. To
show the chart again, repeat the procedure
and select the name again.

Opening additional files

If you open additional files, these will initially
be shown in separate file window tabs,
including data from freshly downloaded
LogTag®s. You can add the data for these files
to an existing Multi-Chart.

Right-click anywhere on the Multi-Chart and
point to Attach Document. Click on the name
of the file you wish to add.

Removing files from the Multi-Chart

If you wish to permanently remove a file from
the Multi-Chart , hide the chart as described
above

Before closing a Multi-Chart with hidden
charts, ensure that you have a copy of the
files for the hidden charts. Once saved, the
hidden files will be permanently removed
and cannot be recovered.
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More than one Multi-Chart window

If you open at least two additional files, you
can generate a second Multi-Chart by clicking
the Multi-Chart icon from the toolbar. All
files shown in separate windows will be
combined into a new Multi-Chart window.The
new Multi-Chart window additionally contains
all charts from the original Multi-Chart, but
they are initially hidden. They can be shown
as described on the previous page.

Extracting individual files from a Multi-Chart

A Multi-chart contains the complete data sets
for each of the recorders from which is was
generated.

You can view the data for each individual
chart in a single-chart window by extracting
them to a *.1tdx file.

Right-click anywhere on the chart, point to
Open Document.and click on the file you wish
to extract. A new file window tab will open,
showing the contents of the extracted file,
which is saved in the same location as the
Multi-Chart.

LogTag Analyzer User Guide
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Aligning Charts

Select Align Charts from the Chart Control Panel to automatically align all charts in the current
Multi Chart window to the earliest start time:

« When Started Readings is selected, the charts are aligned so the first started reading is
shown at elapsed time zero. Charts with no Started readings (i.e. charts with only pre-start
readings) are hidden in this view.

o When Pre-start Readings is selected, all charts with Pre-start readings are aligned so the
earliest Pre-start reading is shown at elapsed time zero. Charts with no pre-start readings
are hidden in this view.

« When All Readings is selected, all charts are aligned so the earliest reading is shown at
elapsed time zero, regardless whether this is a Pre-start reading or a Started reading.

Every chart is assigned a different colour based on the Chart palette and elapsed time is shown.

If you use the toolbar Icon to switch to Real Time, the charts will be shown in their
original relative position.

Shifting Charts

For easier data comparison, chart start times can be shifted while you are viewing the Multi
Chart display.

To shift a chart, move the mouse pointer over the chart until a tooltip from that chart is
displayed. Right-click, then click Shift Chart. A dialog box will be displayed, where the new start
time and date can be selected.

Click the down arrow next to the date to display a calendar where you can select the new start
date. Highlight the hours or minutes from the time and use the up and down arrows next to the
time to change the numbers.

You can revert the chart to its original display by clicking Original start time.

To apply the selected start date and time click .

Min/Max/Average Chart Display
=]

|
When you click the Average icon .= in the toolbar, the currently active Multi-Chart file tab will
now show charts for the calculated values of minimum, maximum and average readings,

instead of the individual charts.

Select naw start date and time for Warming Drawer
Example

Sunday, October 1, 2017 w | | 15:49 ® .

O Criginal start time

m 0 Carcel e Help

Figure 77: Shifting a chart
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Switching from Average display to Standard display and vice versa, or changing the Readings
Range will force the Multi-Chart to be re-drawn according to the default settings. You can then
use the standard zoom controls to show the portion of the charts you want to see.

You can annotate the Average Chart in the same way as any other chart tab; such annotations
will be visible in the other chart tabs and are stored with the multi chart when saved. An
annotation that is linked to a data point on the chart will still be shown, even if the data point
itself is no longer being displayed.

Please note the following behaviour:

Zoom settings will not transfer to the Average tab.
Download marks and inspection marks will not be displayed in the "Average" tabs.

Non-validated readings and re-calibrated readings will not be displayed with the special
attributes, even if set in the options. If you have chosen to show non-validated readings,
they are included in the minimum/maximumy/average calculations, otherwise not.

To avoid memory overflows, the maximum number of data points or recorders that can be
shown in the average chart is restricted. If you try to show average charts outside these
limits, you will see this warning message:

If one or more of the charts have sections with readings outside the LogTag®'s sensor range,
LogTag® Analyzer is unable to calculate the minimum, maximum and average values, and
those sections of the graph will not be displayed. This will likely result in a "broken" graph
line, regardless of whether show readings beyond specifications in the Charts section in the
Options Window is enabled or not (Charts on page 126).

Due to the large number of calculations performed in this feature, specifically when opening
large numbers of charts spanning long periods, having the Average displayed can occupy
large amounts of memory and run slow. Therefore we recommend only turning the feature
on when required.

Clicking on the Average Icon in the toolbar again will turn the average display off. Selecting the
single charts command in the toolbar will open each chart in the Multi-Chart in a separate File
Window, however the Average Chart tab will not be closed.

Analyzer does not currently support Average functionality
for data sets greater than 100,000 readings or more than 200

loggers.
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Behind The Scenes

To create some meaningful results, LogTag® Analyzer uses a special trend line process to
calculate the minimum, maximum and average values across multiple charts, rather than a
histogram. It is important you understand this mechanism, so you can interpret the displayed
readings correctly.

This is an example of two LogTag®s, one with a 5 minute log interval (A) and the other (B)
logging every 2 minutes.

Before the data are displayed in an average tab, LogTag® Analyzer normalises every chart's
readings so they fall in line with the logging interval of the LogTag® with the shortest log
interval, in this case unit (B). It does not shift any charts, but rather calculates a theoretical
value for those reading times by linear interpolation. Interpolation determines probable
environmental conditions, i.e. what the LogTag® would have recorded had it taken a reading at
that time.

Without this method, it would not be possible to compare LogTag®s with different log intervals,

or units that have the same log interval, but were started at different times.

As a result of this process, absolute values for minimum and maximum may not always be
shown if they do not fall on normalized times, as seen in the example at 10:35 - despite 21°C
being the maximum it will not be displayed as it is not a normalized value.

Note: The charts in above example are based on LogTag®s started at the same time. If unit
(A) had been started earlier, depending on the start time unit (B) may also have its readings
interpolated. To ensure the chart with the shortest log interval always has its real values
shown, please use the Aligning Charts function from the context menu.
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Chart annotations

You can include additional information in your chart tab by adding textual and graphical
annotations. Annotations are stored in the *.1tdx file and will be shown again when you next
view the file. Annotations will be printed, and will also be shown on anyone else's computer, if
you are sharing annotated files. You can place up to 58 individual annotations.

If a chart's annotations are currently shown, you can hide them by right-clicking anywhere on
the chart and clearing the tick for Show Annotations. You can show them again by selecting
Show Annotations. You can also perform both actions via the Chart Control Panel.

Adding Annotations
To start annotating charts, right-click anywhere on the chart and select Annotate Chart from
the menu. This will open the basic view of the Annotations Panel.

You can also open this by clicking Annotate Chart from the Chart Control Panel.

When the Annotations Panel is open, an annotation will be placed at the position of the mouse
pointer every time you click the mouse button on the chart canvas. You can choose different

types of annotations with different behaviour. The next table explains what each of the options
in the Annotations Panel mean and how they influence the look and position of the annotation:

Table 16: Basic annotation options

Option Selection What it does

Anchor type Chart Point If a Chart Point annotation is placed, the annotation will always
be linked to the time stamp of the reading on which the mouse
pointer is positioned when placing the annotation. If the chart
is zoomed or panned, and the data point is not visible, the
annotation is also not shown. When a chart becomes part of a
Multi-Chart, all Chart Point annotations for the single chart are
also visible in the multi-chart.

Chart Point Annotations are good for marking specific times on
the chart with additional information.

Background If a Background annotation is placed, the annotation will always
be linked to the position on the canvas in which it was placed.
Even if the chart is zoomed or panned, the annotation will
always stay in the relative position from the canvas edges.
Background annotations are good for placing information
relating to the entire chart. The Statistics Information for
example is placed on the canvas using a background
annotation.

Copy
Delete Annotation

Annotate Chart M
Lag

Zoom Cut
Zoom Readings

Manual 5caling

Show &nnotations

Inspection Marks

JIE

Reading Marks

Figure 82: Chart Right-Click Menu

Annotations Advanced

Anchor Type: | Chart Paint w
Add DataPoint Information[w/]

Type: | Callout Rectangle W

Figure 83: Chart Annotation Panel
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Option
Add DataPoint
Information

Add Series
Information

Type

Selection
Enabled
Disabled

Enabled
Disabled

Callout Rectangle

Callout Ellipse

Line

LogTag Analyzer User Guide

What it does

This option can only be selected when the Anchor type is Chart
Point. If enabled, text will automatically be added to a Callout,
showing date, time, value and type of reading. If disabled, the
Callout will be empty.

This option can only be selected when the Anchor type is
Background. If enabled, text will automatically be added to a
Callout, showing the charts series information from the legend.
If disabled, the Callout will be empty.

1130/ 3012 10:48:-31 AM 197 °C
selected from the drop down, a
rectangular callout shape is used
when placing the annotation. If the Anchor type is Chart Point,
a pointer to the related reading is also added, To add text or

change the automatically placed text double-click the
annotation.

When this annotation type is

When this annotation type is
selected from the drop down, an
elliptical callout shape is used
when placing the annotation. If
the Anchor type is Chart Point, a
pointer to the related reading is also added, To add text or
change the automatically placed text double-click the
annotation.

L1/ 20) FONR 10 A1 AN
187 "C

LA 0050 Trip A G

When this annotation type is
selected from the dropdown, you
place a line on the drawing canvas:

« Move the mouse pointer to where you wish the line to start

o Press and hold the mouse button
o Move the mouse pointer to where you wish the line to end
e Release the button
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Option Selection What it does

Arrow When this annotation type is selected
from the drop down, you place an
arrow on the drawing canvas:

o Move the mouse pointer to where you wish the arrow head
to start

e Press and hold the mouse button

o Move the mouse pointer to where you wish the arrow tail to
end

« Release the button

Rectangle When this annotation type is
selected from the drop down,
a rectangular shape is placed
on the drawing canvas. This
rectangular area is useful for
highlighting sections of the chart, but please note that you
cannot place text inside this shape.

Chart Statistics This annotation is only available as a Background annotation.
When it is selected from the drop down, a rectangular callout is
placed on drawing canvas, and text will automatically be added
to the callout, showing the information defined in Chart
Statistics on page 125, for example range of readings or
min/max/average values.

Tip: If you wish to place a rectangle with text inside,
place a Chart Statistic Annotation and replace the text
with your own.

You can refine the appearance of annotations in the advanced view of the Annotations Panel.
This view can be activated by clicking the Advanced button when the Annotations Panel's basic
view is shown.

You can click Basic to return to the basic view. If you close the Annotations Panel while in
advanced view, next time you open it, it will also show the advanced view.

You will be familiar with these options from many other Windows programs:

Annotations | Sasic |

Anchor Type:  Chart Palint w
Add DataPoint Information|[w/]

Type: Callout Rectangle v
Style
Linewidth |1 =
Color . Line Style |Solid  »
Transparency 100 5 Line Calar .
Font
Font Color: D Size (10 %
Font: | Segoe Ul [
Font Style: | Normal b4

Figure 84: Advanced View of the Annotations Panel
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Table 17: Appearance settings

Group Selection What it does

Style Line width These parameters define the look of the shape object that is placed with
Line Style every annotation. Line width, style and colour define the outline of the
Line Colour object, colour determines the object's fill colour and transparency
Colour defines how opaque or transparent the object will be. 100 is equal to the

Transparency object being fully opaque, 0 to the object being fully transparent.

Font Font Colour These parameters define the properties of the font used for text inside
Size the callouts. Note that only a small selection of system fonts is
Font available.
Font Style

Note: Mouse zooming and panning is disabled when making annotations. You can,
however, still use manual scaling to zoom to the desired section of the chart.

To stop annotating the file, close the Annotations Panel; right-click anywhere on the chart and
select Annotate Chart from the menu. You can also close it by clicking Annotate Chart from the
Chart Control Panel or by clicking the Annotations Panel's Close button . If you change file
window tabs, the Annotations Panel closes automatically.

Editing Annotations
To change the position of an annotation, use the mouse and point to the annotation. When the

pointer has changed to %, press and hold the mouse button, move the annotation to the
desired location and release the button.

To change the size of an annotation, click inside the annotation. The sizing handles appear. Use

the mouse and point to one of the handles until the cursor changes (TE, =, I'?""21, o or +). Press
and hold the mouse button and drag the handle to the desired size.

To edit the text of an annotation, double click the annotation.

Deleting Annotations

To delete an annotation, click inside the annotation and press the Delete key. You can also
right-click inside the annotation and click Delete Annotation.
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Report Display
The Report display tab provides a convenient and quick way of seeing
all important information for a trip in one single screen.

The graph area shows the same chart segment as the one you see in
the chart tab. The zoom controls do not work in the report tab, so if
you wish to show only a particular segment, you need to zoom to this
segment in the chart tab before viewing the report. Annotations are
visible, but the chart cannot be annotated when in the Report Tab.
When you click the Receiver notes button, an entry dialogue box will
open, where you can add formatted text:

Wi velE ..

Aae YD ‘;‘.-|Bif U A anal

Receiver Hotes are here !

e Cancal

@ =

Figure 87: Receiver Notes Entry Dialogue

This text is stored in the file, and displayed in the report's Receiver
Notes section every time the file is opened. Use the dialogue toolbar's
controls to format the text.

The Events Info section lists all events that have taken place during
the trip. You will see if a recorder has been previously downloaded ,
when an inspection mark was placed, when readings were paused or
when the clock was manually changed on a recorder with a display.

For each block of paused readings in USB recorders only the
first and last reading are listed.
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Multi-Chart Reports
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A Multi-Chart can also be viewed in the Report tab, where you can see
a brief summary for each recorder and a smaller version of the chart.
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Data Display

When you click on the data tab, the readings are displayed in a
spreadsheet-like list in chronological order from top to bottom,
including index, date & time and elapsed time.

The data tab only displays readings shown on the corresponding chart.
If the chart is zoomed in, the data tab only shows those zoomed
readings. You cannot use the scroll bar or arrow keys to display
readings before or after the currently zoomed readings; to expand the
number of readings switch to the chart and zoom out.

On the list you can also identify any special marks attached to the
reading, such as download marks (identified through purple
background) and inspection marks (identified through red background).
The text colour identifies if a reading has been above the upper alert
value (red), below the lower alert value (blue) or within specification
(black). You can scroll through the readings with the arrow, page
up/down, home and end keys, or use the mouse wheel.

You can sort the list by clicking on one of the column headers. This can
be useful, for example, when you want to look at all Events and the
times they occurred.

You can add a comment for each reading. This comment will be stored
against the reading when you save the file. In the row for which you
wish to add a comment, click in the Comment column and type your
text.

The list grid can be copied to the Windows clipboard and pasted into
other windows applications such as Excel. Copied data always include
the header row, even if it is not highlighted, and are always sorted by
index. When a a single row is highlighted, press CTRL-C to copy the
currently displayed list. You can also click Copy from the Edit menu, or
right-click on a row and click Copy All. You can also copy only the
highlighted rows if you click Copy Selected. You can select as many
rows as you wish using the mouse. Point to the first row you want to
select. Press and hold the mouse button, drag the pointer to the last
row you wish to select, and release the button.
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Figure 90: Data tab
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Summary Display

The summary tab offers a brief statistics overview of some of the
important trip data. You can customise the statistical data you wish to
include in this tab in the Options dialogue for the Summary Statistics
on page 124.

The first section shows the data for the complete trip, regardless of
whether or not the chart is zoomed in. The second section is only
displayed if the chart is zoomed in, and displays the statistics for only
the zoomed readings.

If there are readings beyond the limits of the sensor within the time
interval displayed, the statistics for this interval will show "**".

The zoom controls available for the chart tab are inactive in the
summary tab.
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4  Statistics for Started readings

LogTag ID

Description

Battery status

Time zone

Reading interval
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MNon alert range
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Time above/equal 15.0°C
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Figure 91: Statistics tab with summary for all readings
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If inspection marks are present in the data, statistics summaries for
each of the inspection mark groups in the data can be seen amended
to the end.

The list grid can be copied to the Windows clipboard and pasted into
other windows applications such as spreadsheets, including the list
header row.

Displaying statistics

The statistics displayed on the Summary tab can be configured in the
Options dialog. Refer to the topic on Summary Statistics on page 124.
By default, all statistics are displayed on the Summary tab.

Statistics can also be displayed on the chart, in a Chart Statistics
Annotation. Refer to the topic on Chart Statistics on page 125 for more
information about configuring the chart statistics.

If there are readings beyond the limits of the sensor within the time
interval being displayed, the statistics for the relevant interval will be
displayed as "**".
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4 Statistics for between the first reading and inspection mark #1

First reading 10/1/2003 12:00:31 PM

Last reading 10/1/2003 1:1221 PM
Elapsed Time 1 Hour 12 Minutes
Readings range -81 to 126°C
Average reading 10.7 *C

Standard Deviation (S) 3.7

Time below/equal lower alert None

Time above/equal upper alert 1 Hour 12 Minutes
Time notin alert None

Degree Minutes below lower alert 0.0 *C-Minutes
Degree Minutes above upper alert 1657.5 *C-Minutes

Mean Kinetic Temperature 113°C

¥ 4 |Statistics for betweeninspection mark #1 and inspection mark #2

First reading 10/1/2003 11251 PM
Last reading 10/1/2003 4:12:221 PM
Elapsed Time 3 Hours

Readings range -144 to 145°C
Average reading -125°C

Standard Deviation (S) 47°C

Time belowfequal lower alert None

Time above/equal upper alert 26 Minutes 30 Seconds

Time not in alert 2 Hours 33 Minutes 30 Seconds
Degree Minutes below lower alert 0.0 "C-Minutes

Degree Minutes above upper alert 2244 *C-Minutes

Mean Kinetic Temperature -92°C

Figure 92: Statistics tab when inspection marks are included
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Day Summary Display

The day summary tab is displayed for
LogTag®s with an integrated statistics
Mmemory.

LogTag® recorder products with display
For these recorder models the day summary
display shows the history of up to 30 days,
arranged into 24 hour periods, with
information about maximum and minimum
values for the day, and if alarms have been
triggered on those days.

The Day summary grid can be copied to the
Windows clipboard and pasted into other
windows applications such as spreadsheets,
including the header row.
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Figure 93: Day summary for recorders with display and
statistics memory
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LogTag® indicator products with display
These indicator products typically have
multiple alarm levels. Time above or below
each alarm level is displayed, with
information about maximum and minimum
values for the day, if alarms have been
triggered on those days and how much time
elapsed on that day until the alarm was
triggered.

The Day summary grid can be copied to the
Windows clipboard and pasted into other
windows applications such as spreadsheets,
including the header row.

LogTag Analyzer User Guide

Oay | MILAHO0 M| ri sbcmieaiat | THINH |l o TioOmed]
13 1na 838 9 Hours 25 Minutes = 3 Howrs 30 Minutes
14 1 97 20 Hours 15 Haurs 50 Minutes
15 124 0o 1 Day 19 Houwrs 50 Minutes
1% 14 102 108y 19 Figs

1w 124 106 1 Day 19 Hours S50 Mif

1& 114 a1 & Howrs 20 Minutes

9 1"z 94 10Hours

20 (53 88

21 101 0 50 Minutes 2 Hours 20 Minutes
2 $s 82

23 83 18

24 4z 22

25 18 22

26 58 4

rr 47 24

28 45 3

29 45 26

30 33 A

n 49 18

32 A4 23

n 47 25 ¥

= Elspsed Time 32 Days 21 Hours

Time

35 Minutes

10 Minitas

el

Triggered

Alarm duration and trigger time

summary Grid

Total time monitored

21 Howrs 10 Minutes
1Day
1 Day
22 Hows 35 Mimtes
1 Day
1 Day
1 Day
1 Day
1Day
1 Day
21 Howws 55 Minutes

Triggered

Day summary header row

2 Hours 40 Minutes
2 Hours 43 Mintes
2 Hows 40 Minvtes
4 Hours 5 hnutes
4 Howrs § Mirutes
4 Houwrs 5 Minutes
4 Howrs 5 Minutes.
4 Hours 5 Minutes
4 Hours 5 Manutes
4 Howrs 3 Mindtes

page 108

Report | Day Summary

Figure 94: Day summary for indicators with statistics

memory



Using LogTag® Analyzer

Day Summary Chart

iSo°Tag indicators show a tab not available for
other types of indicators or recorders. It shows
the minimum and maximum recorded
temperature values for each day the indicator
was running in form of a 2D line chart.

What you can do on this chart is almost
identical to the Chart tab, tooltips show the
data for each you can zoom in and out, you
can place annotation marks and manually
scale the chart. There are, however, some
exceptions:

« There are no download marks. To download
an iSo°Tag with LogTag® Analyzer it must
first be stopped, hence a download mark
can never be recorded.

« Real time shows an approximation of the
date in which minimum and maximum
values were recorded. The iS0°Tag's 24
hour day period starts at the time of the
day the indicator is activated, not at
midnight.

« The data points are linked by a line for
visual appearance only.

« An inspection mark is recorded against a
day, not a specific sample.

« Average and multichart buttons have no
effect on this tab.

« Since the data points don't represent
readings, there is no chart statistics display
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Printing the results

Printing from LogTag® Analyzer is similar to printing from other
Windows software.

Before you print for the first time, however, we suggest you take some
time to set-up your preferred page settings.

Page Setup

Click Page Setup from the File menu, the Page Setup window will be
displayed.

You can set page margins, paper size and orientation. You can check
what the print will look like by clicking Print Preview from the File
menu, as described on page 306.

Printing a single document

Click the Print icon () on the toolbar or click Print from the File

menu to display the Print window.

Choose a printer and, if required, adjust its properties.

Choose the range of pages to be printed:

« All - All pages will be printed

« Selection - Prints the range of readings you selected, for example
by highlighting rows in the data tab.

. Current page - Prints only the current page.

« Pages - Prints only the pages you specify in the text entry.

Please note that LogTag® Analyzer will try to print charts and reports
on a single page where possible.

Printing multiple documents

You can print all currently open documents at once.

Click Print All from the File menu; the printer dialogue will be
displayed. After you have made your selection click print, and each
document's currently active tab will be printed with the respective
zoom settings.
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Automatically calculated statistics

When displayed recorded data, the software will automatically
calculate and display some statistics calculated from those data. These
statistics are shown on the summary tab and are also calculated for
each sequence of data points between the inspection marks.

If any readings within the time interval are beyond the limits of the
sensor, the values for Average Reading, Standard Deviation, and Mean
Kinetic Temperature will not be displayed for the relevant time
interval .

Average Reading

The Average Reading is the arithmetic mean of the sequence of data
points. It is calculated by adding all the data point values together and
then dividing the total by the number of data points. Mathematically
this formula can be expressed as illustrated.

For example, if there were 5 data points to calculate the arithmetic
mean of and they were, 12.3, 15.9, 16.2, 14.7, 14.9, then the arithmetic
mean would be 14.8.

The number of decimal places displayed can be set to 1, 2 or 3 by
clicking Options from the Edit Menu, then navigating to the Summary
Statistic section and selecting the number of decimal places from the
Decimal Places entry. Please note this setting is shared amongst all
statistics calulations.
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Figure 98: Formula for average reading

av s the calculated arithmetic
mean

I is the number of data points
to include in the calculation

tj are the sequence of data

points to include in the
calculation
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Degree Minutes

Some products and materials change their characteristics or degrade, if they are exposed to
temperatures outside the ideal conditions for extended periods. For example, some products
may experience freezer burn if they experience an extremely cold condition or experience a
colder than ideal temperature for a long period of time. LogTag® Analyzer will automatically
display the results of two separate Degree Minutes calculations. The result of the first is based
on the readings recorded below the "ideal conditions", the second on the readings above the
"ideal conditions". The "ideal conditions" used in the calculation of the Degree Minutes
formula are represented by the non-alert range based on the upper and lower alert values
entered during configuration of the LogTag®.

Mathematically the formula for calculating the degree minutes above alert can be expressed as
illustrated.

For example, if there were 5 data points to calculate the degree minutes of and they were, 12.3,
15.9, 16.2, 14.7 and 14.9 degrees, each of these temperatures were recorded at 2 minute intervals
and the high alert temperature threshold was 12.6 degrees, then the degree minutes
temperature above the upper alert threshold would be 22.6 degree-minutes.

page 112
n

degmin = ) abs(t; —a) X s
1=1

Figure 99: Formula for degree minutes

deg min Total Degree Minutes spent
above/below the alert
threshold.

ti The temperature that was
above/below the alert
threshold.

a The alert temperature
threshold.

S The duration of time, in

minutes, the temperature was
sustained.
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Mean Kinetic Temperature

Some products and materials have accelerated rates of degradation at higher temperatures. For AH

example, perishable food items and pharmaceutical products can degrade and many forms of mkt = R_ — 273.15
bacteria grow exponentially as the environmental temperature increases. Mean kinetic —_AH :
temperature is a calculation that accommodates the non-linear thermal effect, which Eo exP( Rx (t;+273.15) )

temperature can have on products. Mean kinetic temperature is represented as the equivalent —In n

temperature the product was thermally subjected to during the time the various temperature
readings were recorded.

Mathematically the formula for calculating the mean kinetic temperature can be expressed as Figure 100: Formula for mean kinetic temperature
Hlustrated. ‘ . . o mkt is the mean kinetic

For example, if there were 5 data points of which to calculate the mean kmepc temperature, temperature, in degrees

they were, 12.3, 15.9, 16.2, 14.7 and 14.9 degrees Celsius, then the mean kinetic temperature Celsius

would be 14.9 degr;es Celsius using the d_efaglt AH. AH s the activation energy.

By1 delfatl_ﬂtrl LogTag® Analyzer uses an activation energy value of 83.144 KJ/mol for the R s the the universal gas
caiculation. ) . . ] constant, which is 0.0083144
To enter a custom value for AH, click Options from the Edit Menu, then navigate to the KJ/mol K

tSéJXr?;rileag Statistic section where you can enter the desired value in the Use the following value n is the number of data points

to include in the calculation

represents the data points to
include in the calculation, in
degrees Celsius

Charts and the Statistics page display the AH parameter if it is different to the default value, ti
. . 1
and display Logger deltaH if the parameter from the recorder was used.
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Standard Deviation

The standard deviation is a useful measure for determining how spread out the readings are
from the arithmetic mean (Average Reading). Most controlled environments typically try to
keep the environmental conditions at a stable and consistent humidity and/or temperature. The
standard deviation can be used to help indicate how stable the environmental conditions were
maintained. One standard deviation (sometimes expressed as "one sigma") away from the
mean, positive or negative represents approximately 68 percent of all the readings. Two
standard deviations, or two sigmas, away from the mean represents approximately 95 percent
of the readings. Three standard deviations represent about 99 percent of the readings.

For example, if the arithmetic mean of the readings was 50.6°C and the standard deviation was
2.3°C, then approximately 68% of the readings were between 48.3°C and 52.9°C, 95% of all the
readings were between 46.0°C and 55.2°C and 99% of the readings were between 43.7°C and
57.5°C. Further more, if all the readings were recorded over a span of 1 day (24 hours) then the
temperature was between 48.3°C and 52.9°C for approximately 16 hours and 19 minutes during
the recorded period of time.

Mathematically standard deviation can be expressed as illustrated. Figure 102: Population based standard deviation
LogTag® Analyzer allows the calculation of sample or population based standard deviation.

Which of those is used for the calculation can be set by clicking Options from the Edit Menu, § the calculated sample based standard deviation
then navigating to the Summary Statistic section and selecting sample based or population SN the calculated population based standard deviation
based. n the number of readings to include in the calculation
Here you can also adjust the number of decimal places used to display the result, but please av  the calculated arithmetic mean

note this setting is shared amongst all statistics calculations. ti a reading to include in the calculation

For a more detailed explanation of the various ways to calculate standard deviation please
consult the relevant literature related to statistical and probability calculations.
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Sharing recorded data with others

You can share data downloaded from a LogTag® device with other users in a number of
different ways.

« If the person you wish to share the data with has access to the same software version of
LogTag® Analyzer as you, you can send the latest *.1tdx file via email, or upload it to an FTP
server.

You can find more details about sending files automatically or upon request in the sections
about Automatic emailing and uploading to FTP sites on the next page and Sending a file by
email directly from LogTag® Analyzer below

« If they have an earlier copy of LogTag® Analyzer prior to version 3, it may be easier for them
if you send a legacy file, such as the *.1td format. You can use the Save As function, then
send the file manually via the Send Mail function.

« If the other user does not have access to a version of LogTag® Analyzer, you can send the
data in various export formats, such as spreadsheet files, PDF files and various other text
format files. You can find the relevant information in the sections about Saving a file for use
in spreadsheets on page 117, saving bxports and Reports on page 147

Sending a file by email directly from LogTag® Analyzer

You can email files to someone else directly from inside LogTag® Analyzer.

When you click the Send Mail icon from the toolbar, a new email message will be created in

your default email program, with the currently active file already attached to the message. @

Type the recipient's email address, add a message that you wish to include and then click Send. S

Clicking on Send in the File menu will achieve the same results as clicking the Send Mail icon. Figure 103: Send Mail Toolbar Iconkk

Note, the recipient of the file will need to have LogTag® Analyzer software installed to open
and view the file you sent. LogTag® Analyzer software is free and can be downloaded from
http://logtagrecorders.com/software/Ita2/download.

If you want to send data in file formats other than the LogTag® Analyzer format, specify the
desired file formats in the Exports and Reports section in the Options Window (Exports and
Reports on page 147). The data files will automatically be attached to your emails in the desired
formats.

To send a Multi-Chart, it must first be saved to disk (Saving a Multi Chart file on page 79).
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Note: You can automatically send emails and upload files to ftp sites using LogTag®
Analyzer's automated SMTP and FTP functionality. Please see Automatic emailing and
uploading to FTP sites below for further details.

Automatic emailing and uploading to FTP sites

In the same way that LogTag® Analyzer files are saved to a local hard drive, they can be
automatically uploaded to an FTP site and automatically be emailed every time data from a
LogTag® are downloaded.

FTP (File Transfer Protocol) is a standard which describes how files are transferred between
different computers and networks. SMTP (Simple Mail Transfer Protocol) is used for email and
describes how electronic mail is distributed across networks. Detailed explanations of how both
FTP and SMTP work are beyond the scope of this manual, however if you wish to learn more
about FTP, SMTP, email and networking please refer to one of the many good articles available
on the Internet, such as the ones on Wikipedia or the various FTP and SMTP client providers.

In the Automation dialogue you can select for both FTP and email whether you wish to make
the process automatic, on request, or allow both. If you activate manual uploading/emailing,
but not automatic uploading/emailing, you need to click he Upload button on the toolbar to
upload or send the file in the currently active window.

If the button is inactive, neither email nor FTP options are enabled.

When neither box for emailing has a tick, no emailing will be possible. Similarly, when neither
box for FTP upload has a tick, no uploading via FTP will be possible, however in both cases any
settings entered in the Settings windows will remain stored.

Clicking on the FTP or Email settings buttons brings up the dialogue windows for the FTP_
settings or the Email settings. Usually this information will be provided by your network
administrator. If your company has specific IT policies you may not be allowed to configure the
settings yourself. In this case, or if your network administrator has already created a company
wide access for multiple users, you may be provided with a file containing the required settings.
Your network administrator will detail instructions how to import these settings into LogTag®
Analyzer.

When uploading or emailing files a status window is displayed Upload Status on page 39.

E-Mail
E-mail downloaded files: D automatically

Clear Queue D on request

FTP
Upload downloaded files to FTP Server: I:‘ automatically

Clear Queue I:‘ op request

)

Uplaad

Figure 104: Upload Toolbar Iconll
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Q Tip: The manual email function described here is different from the "send mail" button

on the toolbar. The Send mail button invokes your standard email program, attaches
the data file, requires you to fill in an email address and press the send button. The
manual email function via SMTP does not use your standard email program, but the
configured SMTP settings and requires no further action once the Upload button on the
toolbar is clicked. You can, however, not change the recipient without changing the
SMTP settings.

Note: Automatic upload via FTP and automatic emailing only work if a file is created by
downloading data from a LogTag® in the interface. If the uniqueness settings in the
File and Folder Settings are set so that certain conditions do not result in creation of a
new file, no file is uploaded or emailed either.

Files with formats other than the native LogTag® Analyzer format will only be emailed
or uploaded automatically if specifically selected in the FTP or SMTP basic settings.
This may be different from the settings in the Exports and Reports option dialogue.

Note: If you upload a file via the manual or automatic FTP function, any file that
already exists on the server with the same name will be overwritten without warning.
It is up to you to make sure files are created with unique file names.

Saving a file for use in spreadsheets

Occasionally you may wish to export a LogTag® data file so you can analyse it in more detail
using a spreadsheet program such as Microsoft™ Excel. You can choose between a few different
options to achieve this:

« You can use the File - Save as command from the menu, and select the *.csv option.
CSV files can be read by most spreadsheet programs.
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Please note that files created by LogTag® Analyzer may not always be true CSV files
( Comma Separated Values), as they use the list separator from the Windows
operating system. It does however mean the file can be opened with MS Excel
without going through the data import facility. To create a true CSV file select "Use
custom list separator" and enter a comma in the adjacent field. You can also use the
custom list separator to generate files for applications which require other list

separator characters.

(& J

« Select the Data tab and press CTRL-C or click Edit - Copy from the menu. Open an empty
worksheet in your spreadsheet program and select CTRL-V or click Edit - Paste from the
applications's menu. The data will be pasted in the cells and you can save the file in the
format of your spreadsheet program.

« Automatically export the data into a CSV file when a recorder is downloaded. Please Exports
and Reports on page 147 for further details.

LogTag® Recorders also offer a conversion program, which you can use to bulk convert legacy
* 1td files to *.csv files. You can download this utility called LogTag® Convert from the software
download page at http://logtagrecorders.com/software.

PDF files

LogTag® Analyzer can save the currently active LogTag® file to a PDF file. One single file will
be generated, which contains the report, chart images, summaries and a data list.

PDF files can be generated automatically, or by selecting Save as from the File menu. Select a
file name and location for your PDF file. Automatic generation of PDF files is enabled in the
section about Exports and Reports on page 147. Here you can also define the composition of the
PDF file.

Click the button; the PDF Export Settings dialogue is displayed, allowing you to
select which content of the PDF file will be created.

Note: The report page is always included in the PDF.

If a chart is zoomed, the PDF file will also contain a zoomed setting.

Saving a file as text

Occasionally you may wish to export a LogTag® data file so you can import it into other
software as text. You can either do this manually using Save as from the File menu, or
automatically when you download a recorder.

PDF Data Settings
D Show readings beyond specification as blank

Include the following
[ ] chart image
Data
[] summary
|_\ﬂ Day Summary

PDF Layout Settings

Paper Size: | A4 v

®) Fortrait () Landscape

Orientation:

@ =
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You can choose between different text formats:
« You can save the file as a *.txt file.

This file is a tab delimited file that can be opened in any text editor on a PC.
« You can save the file as a *.txtm file.

This file is a tab delimited file that can be opened in any text editor on a Mac.
« You can save the file as a * html file.

This file is a mark-up text file that can be opened in any browser.

You can define the contents of these files by clicking Options from the Edit menu and selecting
the Exports and Reports tab.

LogTag® Data files (*.Itd)

The legacy file type *.1td is the main file format of LogTag® Analyzer software before version 3
was introduced.

You can open these files with LogTag® Analyzer version 3 without loss of information.
Annotations, chart titles and receiver notes will all be converted and visible when saved using
the new *.1tdx format.

You can also save data in the *.1td format using LogTag® Analyzer version 3, so they can be
accessed by LogTag® Analyzer version 2 or earlier. However, none of the additional settings
such as annotations, zoom and notes are saved.

You can decide which file format you want to be the default format in File and Folder Settings
on page 139.
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Chapter 3
Customising the Software

This chapter explains in detail how to customise the software to your needs.
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Many of LogTag® Analyzer's features can be customised to suit your specific requirements.

This is done in the options dialogue, which you can open by clicking on the Options icon in the
toolbar or by selecting Options from the Edit menu.

Options
Figure 106: Toolbar Icon

To change any of the options, select the corresponding category in the left pane of the options
window. You will the see what can be changed in the right pane. Most of the options available
will be applied as soon as you click ‘ For example, if the language selection or the date

format are changed, all windows that are open will be updated without the need to restart the

software.

Some of the display settings, such as decimal point and date/time formats, are controlled by
the regional settings of the Windows™ operating system. These can usually be found in the
Control Panel under "Regional and Language Options". Please refer to your Operating
System's documentation for further assistance.

Edit | LogTag Window
u Copy Ctri+C
Zoom Out

Real Time

@ Elapsed Time

Figure 107: Edit Options Menu
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General Settings

The General Settings options allow you to change various preferences that will effect the

overall appearance of the information shown by LogTag® Analyzer.
58 cenersi serves Optiorss - General Settings Weset 4l To Detvalty
Show temperatures in... [ F—— Showtemprsersn |G 70 v
Here you set the unit used for temperature values displayed in the software's dialogues, lists, e e —— :
charts and reports. The options are: g"’w =smsse———
«» Fahrenheit (°F) T
« Celsius (°C) .
» Kelvin (K) § o
) s
For recorders with a display and USB PDF recorders the temperature unit used on the [ ovue
display or in the PDF is set during configuration. It is independent of the temperature
unit chosen here. e
Default time interval to display ' & - 10— ————
Here you set the default time zoom level. This is zoom is applied when a file is opened or a :
recorder is downloaded. You can set this to: Figure 108: General settings

« All readings
« From first reading to first inspection/download mark
« From last inspection/download mark to last reading

The section about Inspection and download mark zoom on page 89 explains in more detail how
this feature works.

Language

This setting determines which language the software uses. Supported languages are:
« English US

« English (UK)

« German

« Russian

« Spanish
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Enable automatic checking for a newer version

The LogTag® Analyzer software can periodically check to determine if a newer version is
available for download from the LogTag® Recorders website.

To enable this feature select Enable automatic checking for newer version and set the number
of days between checks by entering or selecting a number in "Check every XX days". To disable
the feature, clear the box.

If you enable the automatic check, and a new version is available, a window with an overview of
the update will be displayed. Please see Upgrading LogTag® Analyzer on page 20

page 123

|0
|@

LogTag Analyzer
Version 3.0.3

Dovnlaading information trom Intenvet about the latest version. Mo personal ifarmatian is being sent.

4 newer version of Analyzer (3.0 Build 4) is available for downboad. Click the = Download™ button if you want
to download the software now.

If in fulure you $8@ this message you know theie & an vpgiade svailable!

Figure 109: A software update is available
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Summary Statistics

This option allows you to specify which statistics are displayed in the Summary tab.

page 124

Automatically calculate and display following data (B cownsngs  Optlons- Suratiey St
Select all options you wish to be shown, and clear all options you wish to hide. R %f;.}';:i“""' -
For the calculated statistics data you can specify additional parameters. These settings are g(:?" % ;mi.:”“m«m
shared with the Chart Statistics. Bsis E mﬁm::;:;mm
] Tima Desowyequatiower Jlert

Decimal Places B o
Select the number of decimal places displayed for Mean Kinetic Temperature (on page 113), *:éum
Average Reading (on page 111), Standard Deviation (on page 114) and Degree Minutes (on § commaricaonors e
page 112). | A FR—

[ tesains () Use defaunt alue (33,144 Kimel)
Standard Deviation T e
Select the basis for the method used to calculate the Standard Deviation. The default is Sample e
Based (S)
Mean Kinetic Temperature @ = @ ow [[ oews [

You can select the value for the activation energy or use the default value of 83.144 KJ/mol. Figure 110: Statistics Options dialogue

Ignore paused readings when calculating statistics
If you enable this, any readings marked as paused will not contribute to the overall statistics
calculations. This is the default setting. If disabled, all values will be included.

9 Help
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Chart Statistics

This window allows you to specify which statistics are displayed on the chart tab.

Display the following statistics in Chart Statistics annotations

Select all options you wish to be shown, and clear all options you wish to hide.

Insert chart statistics annotation when a new document is

created

Select this if you wish to include the statistics you selected automatically when a new chart is
generated. Initially the box will be placed in the upper left corner of the chart, but you can drag
it to a different location if desired.

Clear this box if you want to do this manually for each chart.

Panel Transparency Setting

Set the level of transparency for the chart statistics box. The lower this value, the more
transparent the box will be, so you can see the chart behind the box, and vice versa.

Annotation font defaults

This group of settings determines the default look for the font used in annotations. You can set
the font, size, style and colour. you can later change these parameters in the annotation panel.

HAXO-8 statistics

Here you can set if you wish to insert only the statistics for temperature, only the statistics for
humidity, or both when you download or open HAXO-8 recorder data.
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Figure 111: Chart Statistics Options dialogue
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Charts

In the Chart Options window you can influence how charts are being displayed in the chart tab.
@ General Settings Options - Charts Restore Defaults [ pisable chart anti-sliasing [faster)

Heading |%PRODUCTID: 3SERIALNUM Started %START-DATE, Finished %FINISH-| [ v
estore aerauits @ svmman sunsic

Chart Defaults Inspection Marks
. . . . . . . Chart Statistics Tempera‘ture Markers

Clicking this will re-set all controls and values on this window to the default settings. Qe Dontag e

@Amnmatmn

E File and Folder

Paused Marks
.
Heading =

X-Axis Grids
e
253, Date and Time

Y-Auis Grids
Show only validated

Mark Mon vaildated readings | ]
Above Alert Shade

Man Alert Shade

Relrvus Blart Sharls

A< Il d< <

You can combine a number of different variables and your own text to create a chart title. The

Marker Style v Marker Size v
5 Communication Ports

controls work the same as described in the section about the File Name on page 140. g s Ry [ EEEEEEEN
ot Line Width | Moderate (3 Point) v EEEEEEER
E‘“D”mg Default Zoom: |Range of readings v

Chart defaults [t pendoamers o eapors e shve
Mouse Zoom: | Left Mouse Button v Mouse Pan: |Right Mouse Button v
The various settings can be enabled or disabled by clicking the check box for the relevant item X e e

in the list. If ticked, an item is enabled. -
When you highlight an item, relevant controls below the list will become active.
You can click on the colour selection box to change the colour. Figure 112: Chart options

Some items cannot have their colour set, for example the axes. In this case the colour selection
box will not appear.

@ =« |0 o opnomon V| (@ e

Markers:
Aside from turning markers on and off you can select colour, style and size.

Shaded areas

You can set the chart background so different colours are used for the regions "at or above high
alert limit", "between high alert limit and low alert limit" and "at or below low alert limit".
This allows out-of-range and in-range data to be recognised easily on the listed or charted data.
Select the shading for each area independently, and select a colour.

By default these settings are enabled, with red for "above alert", blue for "below alert range"
and green for the non-alert range.

By selecting a line style for the "above high alert limit" and "below low alert limit" regions you
can improve the readability of the charts on black and white printouts.
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Gridlines
Enabling the grid lines displays vertical (x-axis) or horizontal (y-axis) lines which help you
identify readings relative to each other. By default both grids are enabled.

Non-validated readings

You can choose to include or exclude non-validated data from the chart display by clearing or
selecting the "Show only validated" check box. If non-validated data is to be displayed, it can
either appear just like validated data, or you can define a different colour and marker style to
be used. Select "Mark non-validated readings" to display non-validated data in the selected
colour/style.

Readings beyond specifications

Sometimes the (missing or bad snippet) can record readings beyond the specified measurement

range. In this case

« the Chart and report tabs will not show the out of range values and the chart curve will
appear with broken lines

« the Data tab will include "<" or ">" for each reading that is beyond the specification range

. the Statistics display will include "**" for each statistic that includes readings that are
beyond the specification range.

If the option "Show readings beyond specification" is enabled, all recorded reading values will
be displayed, even if they are beyond the operating range of the (missing or bad snippet).

For example, the TRIX-8 has a published minimum temperature of -40°C. Temperatures down
to —41.5°C may be displayed if the Show readings beyond specification is enabled, however the
accuracy of recordings between -40°C and -41.5°C is unknown. -41.5°C will be displayed even if
the temperature falls to a much lower actual value.

(missing or bad snippet) provides no guarantee of temperature reading reliability or accuracy
beyond the published range for any product; enabling this option for general use is not
recommended.

Chart Palette Colours
Select the colours for the chart lines. In single charts the first colour is used for temperature,
the second for humidity.

In Multicharts the colours are used in the order the charts are opened. The same colours are
also used when the Multichart is switched to display average/min/max.

When you choose custom you can set your own colours.
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Some experimentation with these settings will show very quickly how they work. Select a colour
in the colour panel, click and go to the Data screen to see the resulting change.

Default Zoom

You can define the minimum and maximum y-axis values initially displayed when opening the
chart.

« Range of readings: this scales the chart so the maximum and minimum temperature
displayed is just above/below the highest/lowest temperature reading recorded by the
(missing or bad snippet). If you choose this option the maximum screen area is used to
display all recorded readings.

« Range of sensor: this scales the chart to show the full temperature measurement range of
the recorder.

« Custom range: When you select this option, an additional dialogue appears. Here you can
enter two temperature values and two humidity values, which are used as maximum and
minimum values for the chart's y-axis, regardless of the value of the recorded readings. frox: X

0 oK 0 Cancel 0 Beip
Regardless of these settings, you can always zoom in or out using the various zoom settings
(see Zoom Control on page 1). When using the context menu in the chart tab you can also Figure 113: Custom range selection window
temporarily override the manual settings with new ones.

These settings are stored when the software is closed.

Multichart Series ID

Here you select which property of the file is listed in the legend for a Multichart next to the
colour code for the chart. You can choose from the following pre-selected combinations of
properties:

. Filename

« Model and Serial Number

« Model and Description

« Serial Number and Description

« Model, Serial Number and Trip number

« Model, Description and Trip number or

« Serial Number, Description and Trip number
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Auto-hide Chart Menu

If you wish to see more of a chart when it is first opened, you can select this feature. The Chart
Control Panel will then be minimised when a chart tab is first opened. If selected, you need to
click the toggle button in the lower right corner of the screen to view the chart panel.

Disable chart anti-aliasing

Selecting this option will enable charts to draw faster on the screen, however they will not look
as smooth and have more ragged edges.

Figure 114: Anti-Aliasing turned on

Reset all open documents
When selected the options as entered will be applied to all open documents when the clicking

on @ «

Figure 115: Anti Aliasing turned off

Zoom and Pan Controls

These settings control how you pan and zoom using the mouse's wheel and buttons. You cannot
use the same control for different actions, i.e. you cannot use mouse zoom and mouse pan with
the same button.

Mouse Zoom
By default you zoom in by dragging a rectangle on the chart while holding down the left mouse
button. You can change this to the right or middle button, or disable the function.
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Mouse Pan
By default you pan by holding down the right mouse button and dragging the chart. You can
change this to the left or middle button, or disable the function.

Wheel Zoom

By default you can use the mouse wheel to zoom in and out without holding a key on the
leyboard. You can change this so you need to hold the CTRL key or the SHIFT key while rotating
the wheel, or you can disable the function.

Wheel Pan.

By default you can use the mouse wheel to pan left and right (when the chart is already
zoomed in) by holding the CTRL key while rotating the wheel.

in and out without holding a key on the keyboard. You can change this so you need to hold the
SHIFT key while rotating the wheel, requiring no key, or you can disable the function.
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Automation

The Automation options determine what the software does automatically when it detects a
LogTag® in the Interface Cradle.

Enable automatic download of readings from LogTag®

When enabled, LogTag® Analyzer will automatically retrieve the recorded data from any
LogTag® product as soon as it is connected to the computer, either via an interface cradle or via
USB. While the software is retrieving the recordings you will see this window:

o A new LogTag has been detected in the interface. Please

wait while its readings are downloaded.

With this function enabled, it is not necessary to go through the download wizard procedure.
This function is very useful when working with multiple LogTag®s.

This function can be temporarily disabled by holding down the CTRL key on the keyboard while
placing the LogTag® in the interface.

You can also easily enable or disable this function by clicking the button in the top right of the
toolbar. It changes colour and shows whether auto download is currently on or off.

Auto-download is

Reconfigure with same settings after automatic download

When this is selected, a LogTag® will be automatically re-configured with the same settings
that were used for the previous trip, once the data have been downloaded. You can also disable
the re-configuration warning that appears if the recorder is still taking readings by selecting
Disable Warning (this field only appears once you have selected the automatic re-configuration
option).

This option can only be selected if Enable automatic download of readings from LogTag® is also
enabled. -
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Display readings after successful download

If selected the software displays the downloaded data immediately after the download has
finished, either after an automatic download or when downloading using the Wizard.

Only show the latest set of readings after download

When selected only the most recently downloaded data set is display on the screen. If multiple
windows are being displayed, they will be automatically closed and only the most recently
downloaded readings will be shown.

Automatically save data files to default folder if source is

read only

If selected, LogTag Analyzer creates a permanent copy of any *.1tdx file opened from a read-
only source. This copy will be stored in the folder specified in File and Folder Settings on

page 139. This is useful if for example you open a file directly from the mass storage device of a
USRIC-8 or from an email you received. In this case you do not have to explicitly create a copy
of the file yourself to retain a local copy, and you will be able to make and save annotations.

Clear the check box if you do not wish to create these copies. In this case you will need to copy
a file manually from a read-only folder to a read/write folder if you wish to make annotations.

Tip: If you open a *.1td file from a USB recorder's mass storage device directly, you will
not be able to save the file after you have unplugged it. Therefore we recommend
turning this option on, particularly if you do not use the automatic download option.
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SMTP and email settings

A Disclaimer

SMTP Server Settings

The distribution of unsolicited emails provides huge inconvenience to anyone with an e Sl
email account. LogTag® Analyzer's email function allows the automated emailing of @ no authentication O ssums
files to a large number of recipients simultaneously without user interaction. Some © Use Gmail authorization
organisations consider this as spam and may blacklist your account. L)X e Nome s Fesemond
User Name
It is therefore of the utmost importance that you as the sender obtain permission from A
the recipients to send these files. LogTag® Recorders provides this functionality as a e
o o c o o o . 0 . . s mai ings
feature assisting in the distribution of information between various users within an s
organization and will not assume responsibility for any misuse of its software. s
. o . . . . . Subject Line |
Setting up automated emailing requires two main pieces of information: e
« The name of the SMTP server which you wish to use to send the emails and add
« A valid user name and password for the SMTP server. Serd test email
Once you click on the SMTP Settings button a dialogue window will appear, allowing you to Auncillein e kel owins formas
. . . . . . . (] LogTag File (itd / Jtlx /it [ JHT™L
enter the configuration data for the SMTP email function. A lot of these settings will be familiar oV ke sl Cleipies
to you from your standard email program. IjPDF.’PorlsbleDoLumeM Format) [ ] Text (Tab delimited)
Table 18: SMTP Server settings Advanced Settings
Field What tO entel" DLQQ uploads, log file in folder DLag connection errors
. L D Store pending uploads between sessions,
SMTP Server Enter the name of the SMTP server you were given by your network administrator automatically resume uploads on program startup
SSL/TLS SSL stands for Secure Sockets Layer, TLS for Transport Layer Security. You may be @ « Q o @ =

required to tick this box if your SMTP server requires a secure connection. Most
SMTP servers now use TLS; your network administrator will provide you with the
required information.

SMTP settings for automatic emailing

Port Number The default port for providing SMTP connections is 25. Some network administrators
change the port number on their SMTP servers to increase security and stop hacking
attacks. If your network administrator has advised a different port for connection,
please enter it here.

In this case you may also need to change the settings of you firewall.
If you wish to learn more about this topic please see any of the published articles
on networking and TCP/IP available on the Internet.

No authentication =~ When selected, no authentication will be used.
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Field

Use Gmail
authorisation

Use User name
and password

User Name

Password

Field
Sender Name

Email address

Subject Line

Recipients

LogTag Analyzer User Guide

What to enter

LogTag® Analyzer supports Gmail's OAuth authorisation method for sending email
via their SMTP server.If you use this method, please see the separate section about
Connecting to Gmail on page 166 for a detailed explanation.

Even without SSL or TLS most SMTP servers require an authentication method,
especially if the SMTP server you are using is not provided by your ISP, e.g. if you
are using email accounts from a hosted site. In this case you need to tick this box
and provide login data for this SMTP server.

Enter the user name you have been allocated by your network administrator
required for Authentication. Please note that for authentication this often needs to
include a full email address rather than just the SMTP login.

Enter the password you have been given by your network administrator required for
Authentication.

Table 19: Email settings
What to enter

Enter the name as it should appear in the recipients email program. This can be
your name or someone else's name.

Enter the email address that recipients can reply to by pressing the reply button of
their email program. This can be your email address, or someone else's address.

Text entered in this line will be displayed in the subject line of the email when
displayed on the recipients' email programs. Clicking on the ®* button will allow
you to specify some file related information which will be entered into the subject
line at the time of sending. You can enter your own text with the file related
information.

Enter the email addresses of the intended recipients. Pressing the "add" button
will bring up a new entry window where you can enter a recipient's name and
email address.

Name

E-mail Address

Add e Cancel

You can also highlight a recipient's name and edit the data or remove it from the
list.

As a minimum you only need to provide an SMTP server address and one recipient email
address for this function to work.
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Every time you make changes to these settings you should perform a test by clicking the Send
Test email button. LogTag® Analyzer will

« check you have provided valid connection data,

. send a test email to the email addresses in the recipient list.

If any of these actions fail, LogTag® Analyzer will display the following error message:

Some common errors are:

« The SMTP server requires authentication, and the data provided were not correct. Please
enter the correct authentication data.

« LogTag® Analyzer could not connect to the specified SMTP site because it could not find it.
This could be due to internet connectivity issues, due to an incorrect port number or a mis-
spelt server name.

« One or more of the addresses in the recipient list have an incorrect mail format (i.e. are not
in the format a@b.c). LogTag® Analyzer can only check for the correct format of the
addresses, but not for correctness of the recipients email addresses. Please note if you do not
provide a correct return address, you may not know that intended recipients are not
receiving the messages

We recommended you add your own email address to the list of recipients. This way
you get feedback if your email has been sent correctly in your email program. It is also
good practice to enter a valid and correct email return address for yourself. Some ISP's
will not relay messages without a sender's address.

Table 20: Additional settings
Field What to enter

Attach file in the  Select all files that you wish to attach when the email is sent. Each file ticked here
following formats  will be created, regardless of the settings made in Edit - Options - Exports and
Reports.

When first using LogTag® Analyzer, the LogTag File entry will be automatically
selected. You can, however, use any combination of files to transmit, including
none.

Log uploads If a tick is placed in the box next to "Log uploads" the message exchange between
the SMTP server and LogTag® Analyzer is recorded into a file. These files are
automatically named "YYYY_M_D_LogTag Analyzer SMTP.log" and are stored in
the location specified in Logging.
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Field What to enter

Log Connection Tick this box if you wish connection errors to be logged. This is recommended if

errors you frequently experience upload errors and you wish to discuss this issue with your
network administrator.

Store pending This feature is selected by default.

uploads between  [f emailing files is interrupted due to a network error, a temporary copy is stored

sessions locally, and LogTag® Analyzer will attempt delivery when it is next started. If you

no longer wish to send these files, click the Clear Queue button in the Automation
window to delete the temporary copy. Your generated data files will not be affected.

If the feature is disabled, files not sent when the software is closed will have to be
manually re-submitted.

FTP settings

Following information is required to upload data to an FTP site:
« The name of the FTP site and a directory on the site in which the files will be stored once

FTP Server Settings
uploaded and FIP Server Port: |21
« A wvalid user name and password allowing you access to this directory. L Sl L
Password =
. . . . . . (O)sst
Once you have clicked the FTP Settings button a dialogue window will appear, allowing you to oy B Conte rolie Ones
enter the configuration data for the FIP site access. Py SETP
Table 21: FTP Server settings B
Field What to enter (®) Use Internet Explorer settings from Registry
. . .. () Use custom settings Proxy Method | Auto-detect ¥
FTP Server Enter the name of the FTP site you were given by your network administrator = ,
oxy Server Port: @
User Name Enter the user name you have been allocated by your network administrator . A R
ser Name
Password Enter the password you have been given by your network administrator Password
Port Number The default port for providing FTP connections is 21. Some network administrators e oy e
change the port number on their FTP servers to increase security and stop hacking (] Logag e g /s / it Ll
attacks. If your network administrator has advised a different port for connection, []¢s¥ omma dedmited) []Test (Macincosny
please enter it here. [ ] POF (Fortable Document Format) [ Text (Tab delimited)
In this case you may also need to change the settings of you firewall. Advanced Settings
If you wish to learn more about this topic please see any of the published articles [0 i foa Se i Fider L lips mmectokedos
on networking and TCP/IP available on the Internet. Dﬁf:":::':',:’,';'::,:°:;§Z"f::f,’g‘2:fm e
Security Protocol ~ Choose between none, SSL or TSL 1.0 |° i Q) cnn @ o
[ — £

Basic FTP settings screen
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Field
Remote folder

Create Folder

Field

Firewall/Proxy
Settings

LogTag Analyzer User Guide

What to enter

Enter the folder in which the data files should be uploaded. Please note that not all
FTP servers allow creation of files or folders in the root directory. Please discuss any
of your requirements with your network administrator.

Select this if the remote folder is not yet present on the FTP site and you wish to
create it.

Table 22: Firewall/Proxy settings
What to enter
Use the settings from the registry or choose your own settings. Explaining these

settings in detail would go beyond the intent of this user guide, so please discuss
these settings with your network or IT administrator.

All of the above settings are required to make a successful connection to an FTP server.

Every time you make changes to these settings you should perform a test by pressing the Test
connection button. LogTag® Analyzer will

« check you have provided valid connection data,
« if necessary create the folder you have specified and
. put a small test file in the selected location.

If any of these actions fail, LogTag® Analyzer will display an error message:

Some common errors are:

« The remote folder could not be created. Please select a different folder name or change to a
permitted location.

« LogTag® Analyzer could not connect to the specified FIP site because it could not find it.

This could be due to internet connectivity issues, due to an incorrect port number or due to a
mis-spelt name.

« User name or password are incorrect.

Field

Attach file in the
following formats

Table 23: Additional settings

What to enter

Select all files that you wish to attach when the email is sent. Each file ticked here

will be created, regardless of the settings made in Edit - Options - Exports and
Reports.
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Field
Log uploads

Log Connection
errors

Store pending
uploads between
sessions

LogTag Analyzer User Guide

What to enter

If a tick is placed in the box next to "Log uploads" the message exchange between
the SMTP server and LogTag® Analyzer is recorded into a file. These files are
automatically named "YYYY_M_D_LogTag Analyzer SMTP.log" and are stored in
the location specified in Logging.

Tick this box if you wish connection errors to be logged. This is recommended if
you frequently experience upload errors and you wish to discuss this issue with your
network administrator.

This feature is selected by default.

If emailing files is interrupted due to a network error, a temporary copy is stored
locally, and LogTag® Analyzer will attempt delivery when it is next started. If you
no longer wish to send these files, click the Clear Queue button in the Automation
window to delete the temporary copy. Your generated data files will not be affected.

If the feature is disabled, files not sent when the software is closed will have to be
manually re-submitted.
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File and Folder Settings

The File and Folder Settings options help you manage the LogTag® data files.

swmm\-m Optians - File and Folder Settings.
FileBame ‘SPRODUCTIO. SSEAIALNUM Stasted SSTART-DATE, finished SFINEH e v

r;LE— ooy AN

Folder |COUsTEMaNesFOocmerntsuy LogTi Datay =]
@(Mn Statintics e

Diplay 12 = | items in the most recently opened lirt
E,{n-m

Deplay ‘Cran v

@mmmn

Delault Formal | Stnaard [154) -
B e wravorae
= Unsiquenes | g .
:';1 Expaits anakepadts - e -
e AutoSave | Prompt t9 5K document changes oo ciose v
e ana Time -
Eﬁ [/] When apering|10 = | o4 more duuments, open &5 & mulli-chant
[j Commerication forts [/] Dispiay Save Az disiag whensaving rew MulbCharts
ﬂ User Server
15 Lops
[ \eaging

0= O o= [ 0w

Figure 117: File and folder settings Option dialogue
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Whenever information is downloaded from LogTag® products it is always automatically saved

on your PC.

The file name entry helps you to give meaningful names to the files, so you can identify them
easier if you have to open them at a later date, or share them with others.

You can mix normal text and pre-defined place holder elements in this definition field. When a
new file is created, the normal text appears as entered, and the place holder elements are
replaced with the corresponding information from the recorder data or your computer

environment.

Use the button at the end of the edit control (®*) to display a list with available elements.
Selecting an element will insert place holder text representing this element at the cursor
location; alternatively you can enter this text directly.

You may use one or more of the available elements in any order. If you type additional text into
the definition field, you must not add it inside an element's place holder text. If you manually
enter placeholder text, the letters must be in upper case as shown in the following table (for
example, "%ID" not "%id") and include the % marker.

Table 24: Description of available file name elements and their place holder text

Element

Date File
Created

%DATE

Date LogTag %FINISH-DATE

Finished

Date LogTag %START-DATE

Started

Date of first %FIRST-DATE

reading

Date of last %LAST-DATE

reading

Placeholder Text File name shows...

The date when the LogTag® information was originally
retrieved.

The date of the last reading recorded after being started.
If the LogTag® was not started then this information will
be blank.

The date the LogTag® was started to record information.
If the LogTag® was not actually started and only pre-
start information was recorded then this information will
be blank.

The date of when the LogTag® began recording
information, even if it was under pre-start conditions.

The date of the last reading recorded, even if there are
only pre-start recordings.
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Date File Created
Date LogTag Finished
Date LogTag Started
Date of first reading
Date of last reading
LogTag ID

Model ID

Number of Times Started
Serial Number

Time File Created
Time LogTag Finished
Time LogTag Started
Time of first reading
Time of last reading

Description

Figure 118: Available file name elements
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Element

Date/Time

LogTag Finished

LogTag ID
Model ID

Number of
Times Started

Serial Number

Time File
Created

Time LogTag
Finished

Time LogTag
Started

Time of first
reading

Time of last
reading

Description

Placeholder Text

%FINISH

%ID
%PRODUCTID

%START-COUNT

%SERIALNUM
%TIME

%FINISH-TIME

%START-TIME

%FIRST-TIME

%LAST-TIME

%USERID

LogTag Analyzer User Guide

File name shows...

The date and time of the last reading recorded after
being started. If the LogTag® was not started then this
information will be blank.

The unique LogTag® identification value.

The product identifier (part number) for the LogTag®
used to record the data.

The number of times the LogTag® has been started since
manufacture.

The unique serial number of the LogTag®.

The time when the LogTag® information was originally
retrieved.

The time of the last reading recorded after being started.
If the LogTag® was not started then this information will
be blank.

The time the LogTag® was started to record information.
If the LogTag® was not actually started and only pre-
start information was recorded then this information will
be blank.

The time of when the LogTag® began recording
information, even if it was under pre-start conditions.

The time of the last reading recorded, even if there are
only pre-start recordings.

The user defined identifier for the set of information
recorded by the LogTag®.

You may use the \ character to specify that a file name definition includes a sub folder name.
This is useful if you want to group/sort files automatically together and it cannot be done using
the folder name controls (for example if you want sort the files by User Id).

Characters not supported by the operating system such as : * ¢ < > | are not permitted. If you
do include one of these elements they will be replaced with the _ character.
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Any date or time element will use the formatting settings defined in the Date and Time
options.

Folder Name

Here you define the directory where files are automatically stored after data have been
downloaded from your recorder or indicator. This can be a local folder on your hard drive or a
network drive path. UNC folder names are supported. You can:

« Browse the directory structure with the (.. button and select the desired directory.
. Enter the path manually.

You can mix normal text and pre-defined place holder elements in this definition field.
When a new file is stored, the normal text appears as entered, and the place holder

elements are replaced with the corresponding information from the recorder's data or your

computer environment.

Use the button at the end of the edit control (®¥) to display a list with available elements.
Selecting an element will insert place holder text representing this element at the cursor

location; alternatively you can enter this text directly.

You can insert following variables, provided the final resulting name is a valid UNC folder
name:

Table 25: Available elements and their placeholder text for the storage folder
Element Placeholder text Path name shows...

Current full year %YYYY The year in which the file was created, using a four digit

number.

Current short year = %YY The year in which the file was created, using a two digit

number.
Month Name %MMMM The month in which the file was created, using its full name
Abbreviated %MMM The month in which the file was created, using a three
month name letter abbreviation (such as Jan)
Month &MM The month in which the file was created, using a two digit
number with a leading zero where required.
Day name %DDDD The day on which the file was created, using its full name

Abbreviated day %DDD The day on which the file was created, using a three letter
name abbreviation (such as Wed)

Current full year
Current short year
Maonth name
Abbreviated month name
Month

Day name
Abbreviated day name
Day

Day of the week

Houwr (24)

Hour

Week of the year

User domain
Computer name

User name

User home path

User home drive

User documents

Figure 119: List of available variables
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Element
Day

Day of the week

Hour (24)
Hour

Week of the year

User domain

Computer name

User name

User home path

User home drive

User documents

Placeholder text
%DD

%D

%HH

%H

%USERDOMAIN

%COMPUTERNAME

%USERNAME
%HOMEPATH

%HOMEDRIVE

%DOCUMENTS

LogTag Analyzer User Guide

Path name shows...

The day of the month on which the file was created, using a
two digit number with a leading zero where required.

The day of the week on which the file was created, using a
single digit number from 1-7. (The first day of the week is
obtained from the regional settings in your OS)

The hour of the day using a two didgit number between 1
and 24

The hour of the day using a two didgit number between 1
and 12

The week in which the file was created, using a two digit
number with a leading zero where required.

The domain name of the network the user is
connected to.

The name of the computer as entered in the system
description.

The user' user name as required for logon.

The path (excluding the drive letter) of the user's
home directory.

The drive letter on which the User 's documents
directory is stored.

The path (excluding the drive letter) of the user's documents
directory.

A valid storage directory would be %HOMEDRIVE\%HOMEPATH\Documents\My LogTag
Documents. You do not need to enclose the string with quotes.

You need to make sure you have write access to the resulting directory. If LogTag® Analyzer is
unable to write to or create a directory, a warning message will appear when you next download
a recorder and you will then need to select a different directory.
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Note: Some Network Attached Storage Devices (NAS Drives) use versions of SAMBA
(Server Message Block) file servers which do not correctly report back whether a file
exists or not. Consequently, LogTag® will overwrite without warning an already
existing file with the same name, regardless of the settings made in the Automation
options.

Display X items in my most recently used list

This determines how many of the most recently accessed files are listed in the File menu for
quick access. Once this number of files has been reached, the reference to the oldest file
opened will be removed and the most recently opened file will be added to position 1. Only the
file reference is removed from this list, the actual file is not deleted. Changing this setting will
take effect the next time LogTag® Analyzer is started.

Display
This determines which view tab will initially show when a file is first opened.
« Chart; this will display the data in a time versus humidity and/or temperature chart.

. Data; this will display a list grid (spreadsheet style) of the time versus humidity and/or
temperature data.

« Report; this will display a condensed overview of the data including averages, ranges, alert
results, LogTag® identification data, and a small chart.

. Summary; this will display a summary of the data, including averages, ranges, alert results,
LogTag® identification data, and other information.

Default File Format

Select if downloaded data are stored in the * Itdx format, or as the legacy * 1td format.
« The *.ltdx format includes
chart control panel settings
zoom settings
annotations
receiver notes
... file event information
This file format cannot be opened by LogTag® Analyzer versions earlier than 3.0.
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« The legacy *.1td format can be read by earlier version of LogTag® Analyzer, but does not
store any of the additional settings above.

You can open a file in * ltdx format and store it in *.1td format, but you will lose the extra
information.

We recommend you select the *.1tdx format, and only save the *.1td format if you need to send
the data to someone without the latest version of LogTag® Analyzer.

Uniqueness

With this setting you decide what the software should do when a LogTag® is downloaded, and
the file name settings File Name on page 140) would result in duplicate file names in the
selected storage location. This is important if for example you have kept the default file name
settings, and download a recorder more than once a day.

The options available include:

1. Always create a unique copy of files (recommended)

The software will automatically append " Copy n" to the end of the file name, where "n"
will be a unique sequential number.

2. Overwrite file if the file already exists

The existing file is replaced with a file that contains the information just downloaded. The
old file will no longer be accessible. This is only recommended if you do not use
"continuous operation" (Continuous operation on page 65).

3. Prompt if an existing file already exists.
A message will appear asking you whether or not you want to replace the existing file.
If you answer Yes the existing file is replaced as in option 2.

If you answer No the software will append " Copy n" to the end of the file name as in
option 1.
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This setting only takes effect if the file that is being saved is different to the file that is
already stored. If you download a recorder that has already stopped, the resulting file
would have the exact same content as the file already stored. In this case no additional
files are generated, regardless of what settings you have made here. You will see a
change in date for the "Last modified" property in Windows Explorer, as it is opened by
LogTag® Analyzer for comparison. The only time such a file would be re-generated is if
someone had added a digital signature to the original file, and downloaded the recorder
again. In that case the uniqueness settings would determine if a file would be

generated again, and what name it would be given.

Auto-Save on Exit

This setting determines what happens when you make changes to a chart, such as changing
zoom settings or annotating, and you exit the software or close the file.

« Save document changes on close

Any changes you make to the zoom settings, annotations, chart settings or receiver notes are
automatically saved. This is the recommended setting.

« Prompt to save document changes on close

If you make changes to the file, you will be asked whether or not you wish to save the
changes.

« Do not save document changes on close
When you choose this setting you will need to save any changes yourself.
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Exports and Reports

In addition to the native *.ltdx file you can automatically create files in other formats every
time a LogTag® is downloaded. You would use this for example if you wanted to perform
further analysis of the downloaded data in MS Excel, or email a PDF file to someone who does
not have LogTag® Analyzer installed on their computer.

Automatic file creation

To automatically create an additional file of a different type, place a check mark in the tick box
next to the file type in the list. You can select more than one additional file type.

Autamatically export new files to the following format(s)
[ esv icomma delimited) [ POF Portabie Document Format)
DL [ Test (Tab delimited
[ ] Test pacintosh)

The additional files will be automatically saved when downloading a LogTag®, using the file
name and folder location defined in File and Folder Settings on page 139. If during the download
no new file is created (for example when downloading a unit that has previously been
downloaded), no export data are generated either.
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These file formats cannot be imported back into LogTag® Analyzer. It is also not
possible to detect any manipulation to these files since they can be edited with third
party software.

Figure 120: Export Options
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You can select which extra information will be included separately for each of the different

export formats. Click the down arrow in | ™= ¥/ 3nq select the export format you wish to
adjust.

In the dialogue window displayed adjust the options to suit and click to save your selection.
Clickif you wish to discard any changes you have made.

You can include or exclude...

pre-start logged data

column headings

the trip summary

readings beyond specifications

the day summary for recorders and indicators which store this type of data

reading time, elapsed time, or both
For CSV files you can additionally select a custom list separator and a file extension. CSV files
normally use a comma as a separator between individual values of a row. By default, LogTag®
Analyzer uses the list separator from the "Regional and Language Options" in the Windows
Operating System. For some regions the resulting file is strictly speaking no longer a CSV file,

however it maintains compatibility with the import of CSV files into MS Excel. You can also use
a self selected separator instead.

The options for the PDF files are more extensive than for other files, please see PDF files on
page 118

Attaching files to emails
Here you select the file formats for the email attachment created through the Send Mail
command when Sending a file by email direct from Analyzer.

[ atways include pre-start log data

D Include each column heading
[ ] show summary
[_l Show readings beyond specification as blank

D Incluede Day Summary

@hExport Reading Time nllExport Elapsed Time
() Export Reading Time and Elapsed Time
(9‘;- Use list separator from Windows Regional Settings

'Z;!__l Use custom list separator: File extension: .osv

o oK - G Cancel e Help

Note: If you select an item in the list of Send Mail file formats, the format is
automatically selected for export, if you have not already selected it.

g )

Please also be aware any formats selected here will neither be automatically uploaded
to an FTP site, nor emailed through the automatic emailing function. Files to be
automatically sent or uploaded are enabled in the FTP settings (as described on

page 136) and the SMTP and email settings (as described on page 133).

|\ J

Copying Charts
You can copy the contents of a chart to the Windows clipboard by pressing CTRL-C while the
chart tab is active.

Figure 121: Customising Export Options

Send Mall command automatically attaches a copy of the file in the following formatis}

LogTag File (itd / Ftdix / muitix)
[wlcsv (Comma detimited)
[Jrmae [ rext (Tab delimited)
[ rext paacintosn)

Figure 122: List of file formats for attaching via Sendmail.

|:| FOF [Portable Document Format)
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Here you can select which format the data should have, and which resolution.

Report appearance

The remaining fields on this page influence the apperance of the report tab. You can decide the
default zoom level (Full page, Page Width and Custom), as well as a custom percentage. You
can also define the alternating row colour.
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Date and Time Format

Here you can set how dates and times are displayed in all tabs, reports and exports.

Short Date, Long Date and Default time use the settings from the Regional and Language
settings of the Windows operating system, accessible through the Windows Control Panel.

You can customize how the date or time information is displayed by selecting Custom Date or
Custom Time and combining the elements as listed in the tables Mean Kinetic Temperature on
page 113. The letters must be in the correct case (for example, "MM" in the date string, not

"mm" as you would use for time value). You can use the characters '.', '/, ', or

'-' to separate

elements, but you cannot add text.

Element

d

dd
ddd
dddd

MM
MMM
MMMM

Table 26: Date options
Meaning
Day of month as digits with no leading zero for single-digit days.

Day of month as digits with leading zero for single-digit days.

Day of week as a three-letter abbreviation.

Day of week as its full name.

Month as digits with no leading zero for single-digit months.

Month as digits with leading zero for single-digit months.

Month as a three-letter abbreviation.

Month as its full name.

Year as last two digits, but with no leading zero for years less than 10.
Year as last two digits, but with leading zero for years less than 10.

Year represented by full four digits.
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Table 27: Time options

Element Meaning

h Hours with no leading zero for single-digit hours; 12-hour clock.
hh Hours with leading zero for single-digit hours; 12-hour clock.

H Hours with no leading zero for single-digit hours; 24-hour clock.
HH Hours with leading zero for single-digit hours; 24-hour clock.

m Minutes with no leading zero for single-digit minutes.

mm Minutes with leading zero for single-digit minutes.

S Seconds with no leading zero for single-digit seconds.

ss Seconds with leading zero for single-digit seconds.

t One character time-marker string, such as A or P.

tt Multi character time-marker string, such as AM or PM.

For example, if the date was 2 January 2012 and the date format was defined as yy-M, dd the
date would be displayed as 12-1, 02.

A sample of the chosen date and time format is displayed in the sample box.

This setting does not affect how the date and time information is stored in a *.1tdx file,
only how the information is shown.

Time zones

Each LogTag® stores a time zone along with the real time. This allows recipients to view data
from a recorder in their own local time, even if it originated from a different time zone. Most
recorders store the time zone of the computer used for configuration, but for some the time
zone can be specifically defined during configuration, for example in USB PDF recorders, where
it is often desirable to set the time zone of the recipient.

The Display Time Zone field allows you to select which time zone LogTag® Analyzer will use. It
can be accessed by clicking Options from the Edit menu and selecting the Date and Time tab.
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Time zone

Local PC Time
Zone

Download Time
Zone

Configuration
Time Zone

UTC/GMT Time
Zone

Use logger
display clock
when available

Use PDF time
zone for USB
loggers

LogTag Analyzer User Guide

What is displayed

All times are displayed in the time zone of the computer used for viewing the data.

This is the most commonly used option, as it displays the dates and times on
screen in your local time zone.

Note, that this is not the same as the download time zone, if you were sent a file
from a recorder downloaded in a different time zone.

All reading times are displayed relative in the time zone of the computer
used for downloading the data.

All reading times are displayed in the time zone of the computer used for
configuring the LogTag®.

You would use this option if you wanted to view the data in the same way
the sender of the recorder would see it.

All times are displayed in Universal Time Coordinates, or Greenwich Mean
Time representation.

This is the best option when comparing different recorders from different
senders in different time zones.

If selected, all times are displayed relative to the clock that is showing on

the display of the recorder, if it is equipped with a display that has a clock.

You would typically select this option, if you want the recorder's display
clock to show the same time values as the Report generated by LogTag®
Analyzer.

If selected, reading times are displayed in the time zone set in the USB
PDF recorder.

Regardless of the option you select, the recorded data inside the LogTag® are not affected.
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Communication Ports

LogTag® Analyzer supports communication with multiple ports simultaneously, so it is possible
to connect and use more than one interface cradle at the same time. Each time you use
LogTag® Analyzer to configure, download or hibernate a recorder it needs to check each enabled
port to see if an interface with a recorder is attached to that port. In this dialogue you can
define, which communication ports should be checked for connected interface cradles. The more
ports you leave enabled, the longer it will take LogTag® Analyzer to establish which ports have
interfaces connected, and which don't.

You should therefore only enable ports you plan on connecting an interface to. Ports not used
for communication with LogTag® products should be excluded, which speeds up
communication.

When you first install LogTag® Analyzer, all COM ports are disabled by default, as the most
common method of communicating is via USB interfaces.

This is especially useful if you have Bluetooth devices connected to your computer, which
generate a large number of virtual COM ports. It can take LogTag® Analyzer a long time during
download or configuration to detect if these virtual ports have an interface connected, so
disabling the ports significantly improves communication time. Any new COM port established
after you disable all serial ports will also be automatically disabled.

If you wish to use an RS232 serial interface, you can clear the check box Disable all serial ports.
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User Server

The User Server options define if and how LogTag® Analyzer should connect to the LogTag®
User Server software. If you do not have LogTag® User Server software installed on your
computer or network, you will not need to changes these settings. Connection to the LogTag®
User Server software is typically only used in multi-user environments or if your organization
requires compliance with the US FDA 21 CFR Part 11 regulations for use of digital signatures that
are controlled by a central administrator.

The settings required in these fields will be provided by your network administrator. You will
also need to select I agree to be able to store these settings. Once a valid connection to the
LogTag® User Server software has been established, you will be required to provide a valid user
name and password (How users log on on page 164) to continue using LogTag® Analyzer.

A Note: If the LogTag® User Server software runs on a different computer, you need to be
connected to that computer via a LAN or WAN to use LogTag® Analyzer software or

make any changes to these settings. You will not be able to use LogTag® Analyzer if
you cannot establish a connection to the User Server software.

For more information please refer to the Digital Signatures Suite web page, which can be
accessed via the LogTag® website.

To enter or change these settings LogTag® Analyzer must be started from a user account with
local administrator privileges. If you normally start it from a standard user account, please close
LogTag® Analyzer, right click its shortcut and click Run as administrator. Make the changes
after you have provided Administrator credentials, then close LogTag® Analyzer and start as
usual.
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Activity Logs

[t can sometimes be useful to keep a record of the configuration and download logs of a
LogTag® recorder. LogTag® Analyzer can store a number of different logs in text files. Settings
for what is stored and where are made in the Logging window.

When the Log configuration data option is ticked, the selected parameters are written into a
text file, which is named "Analyzer_config_log YYYY_TTT.txt". When the Log download data
option is ticked, a second file is generated, named "Analyzer_download_log_YYYY_TTT.txt"

YYYY is the current year, and TTT is a string, the composition of which is dependent on the
frequency of the log generated. You can opt to generate a new file every day, every week or
every month. We recommend to choose this depending on the frequency and quantity of
recorders configured and downloaded, the default is every week.

Clicking on the button will allow you to select a Log folder of your choice where the log files
will be stored. This folder is also used for the FTP and SMTP logs. For each recorder configured
or downloaded a new line is started in the corresponding text file; individual entries in each line
are separated by the character specified in the Field separator text field, and you can choose to
also enclose each value in quotation marks by selecting Add Quotes.

You can view the files by either browsing to the log folder and opening the file with a text
viewer, or you can click VIEW and open the log for viewing in LogTag® Analyzer's internal
browser.

Different parameters are available for configuration and download logging.

You can change the order of the entries in each line by highlighting the entry and clicking on
the up or down buttons. Clicking the tick box enables all parameters to be included in the log
file.

For diagnostics purposes you can select Log Communication Messages. This generates an
encrypted log file which you can send to LogTag® Recorders for analysis. The feature will be
disabled when you next re-start LogTag® Analyzer.
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Importing and Exporting Option
Settings

LogTag® Analyzer's option settings can be exported and then imported into other installations
of LogTag® Analyzer. This is useful if you want to distribute settings to multiple users on the
same computer or copy settings from one computer to another. You can also use this if you are
upgrading your computer, and want to transfer the settings to the new computer.

You can access these functions from the Edit - Options dialogue.
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Exporting the Options Settings

With LogTag® Analyzer open, select Edit - Options and click on [Export Options) If the button
displays Import Options, click the down arrow, then click | Export Options .

A window will open, where you can select the option settings that will be exported.

Select all applicable check boxes, or choose Select All to export all settings. Only settings with
the check box enabled will be exported.

You need to enable at least on option, or you will receive an error.

Click and in the file explorer window that opens browse to a directory and enter the file
name of the export file. The * asxml file extension will be added automatically.

+ [+ ThePC 1 Demements
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1 This
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B Ma Wy Packites
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e p e Anabaer SeSngs ke sl
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Figure 131: Selecting the export file name and location

Once you click , the export file will be written to the folder specified, and you will receive a

confirmation message of the successful export.

Options export to file Dr\ Users), User' Docurments | My
LogTag Data), All Settings asxml complete

Figure 132: Successfully exported settings file
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Figure 130: Selecting the options settings to be exported
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Importing the Option Settings

You can use one of the following methods to import option settings into LogTag® Analyzer.

. With LogTag® Analyzer open, select Edit - Import Options.
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o

Figure 133: Import options dialogue

Browse to a previously stored *.asxml file and click on Open.

« Double click on a *.asxml file in Windows Explorer, on the Desktop or in an email
attachment.

» Drag and drop a *.asxml file onto the LogTag® Analyzer icon on the desktop.

« Open the file via the File - Open dialogue in LogTag® Analyzer.

Only settings present in the *.asxml file will be imported. If a setting already exists in LogTag®
Analyzer, and a different setting is imported, the new setting from the imported file will
overwrite the existing setting.

Once the import is complete, you will see this dialogue.

o Settings import from file completed successfully.

Figure 134: Import successful
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If there are any problems with the import file, for example a file format incompatibility, an
error message will be displayed showing the import failed.

o Unsupported File Format
All Settings aswenl

@ = |

You cannot import a settings file generated with LogTag® Analyzer version 2. You will receive
the following error message:

Unsupported File Format

Italoptiondtest asml
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Appendix

Code Pages

A computer determines which character to display based on a table of
values, which is specific to a written language. This table is often
referred to as the code page.

A small number of characters are independent of a computer's input
language. These are '1-9', 'a-z', 'A-Z' and some special characters, for
example punctuation and brackets. These are listed in the ASCII table
as shown.

An additional 128 characters are available, which are specific to each
code page. The following examples show the differences between the
available characters for the Latin and Thai code pages.
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Figure 135: ASCII Table of printable characters
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Figure 137: Code page 1252, Western languages Figure 136: Code page 847, Thai language
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In LogTag® Analyzer password and user ID fields are text entry fields.

The code page is used to determine the characters LogTag® Analyzer i
displays on screen and stores inside a recorder. Which code page is Programs (1)
selected depends on which input language you have selected for your | %7 charmap.exe
computer. When the LogTag® is downloaded in a different country, the

user ID is displayed with the characters from the code page who's

reference is stored in the recorder. This is possible because all Windows

code pages get installed as part of the operating system, although only

one is used at a time to display characters.

Passwords are always displayed with the asterisk character, but you
will need to type them into a confirmation dialogue (especially if the
password on download feature is enabled). You can use the Windows
character map to enter characters that are not available in your
language. To access the Windows character map, enter charmap.exe in
the "Search" or "Run" box of the Start menu, depending on your
operating system, and press Enter.

Some code pages make more than these extra 128 characters available,
but this requires more storage in the recorder's memory, which
reduces the number of characters available for password and user ID.
These languages are Chinese (Traditional), Chinese (Simplified),
Korean and Japanese. For every character not in the ASCII character
table A computer determines which character to display based on a
table of values, which is specific to a written language. This table is
often referred to as the code page. on the previous page the number of
characters that can be stored is reduced by one. This means a password
can be as short as 3 characters, and a description as short as 19
characters (or 18 characters for a TRID30-7 or TRED30-7).

' See more results

| charmap.exe

Figure 138: Accessing charmap.exe on Windows 7
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These samples shows the extended character overview and a character

subset.
B2 | =2 88 |22 | 84 | 8B | 8C | ap | BE | &F

5o | 51|82 |83 98 |59 | 24|98 |2¢| oD | 9K | oF
R I I R
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R R R R
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P07 [ T S S R I O O I I .
FFez | FFas | FFe4 | Fres | Fras | FRe7 | Fras | FFsa | FRea | FFSE | FRec | FRSD FF&F

FF3E

I

Figure 140: Code page 932, Japanese language

You can find more information about the history and technical

background of code pages via a number of online references.

Note: Although you can use the Windows character map to
confirm a password on download, you cannot enter characters

as a new password or description that are not available in your
chosen input language with this method. If you want to use
different characters you must switch the input language of
your computer. Please refer to the instructions relating to

your specific operating system how to do this.
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Figure 139: Code page 932, Japanese language, subset 91
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Connecting to LogTag® User Server

To use Digital Signatures, LogTag® Analyzer must be connected to the LogTag® User Server
software. When connected, all users are required to log on to LogTag® Analyzet before they can
use the software. To find out how to connect LogTag® Analyzer software to the LogTag® User
Server software please see User Server on page 154

How users log on

If LogTag® Analyzer is connected to the User Server, the logon screen as shown one on the right
® o o E:

. . . . . m . ..?" You are required to logon before you can continue.
is displayed when LogTag Analyzer is started. You can also click the Logon icon ‘ese" in the 7 Please enter your usernameand password.
toolbar or click Logon from the User Server menu. For users to successfully log on to the bomtactstr dminenatorbs R therass e

software for the first time, they must enter the username and password assigned to them by e |y
the User Server administrator. The password can be changed after the user has logged on (See '
How users change their password on the next page) but not the Username.

Password: |sewsanass

. L. . " o K Gwrﬂ\ 0 Help
Usernames are typically not case sensitive, however passwords are, which means that "Bob =
Smith" is the same username as "BOB SMITH" and "bob smith", however, entering a password Figure 141: Logon request when connected to User Server
of "bob" rather than "Bob", for example, is considered to be different.
Once logged on, you will be able to use all functions to which the User Server administrator has
given you access.
If your logon failed, you will see the Logon Failed message.
Every log on attempt, whether successful or not, will be recorded automatically in the audit
logs. As a security measure, the network administrator may configure LogTag® User Server so
that a user account becomes blocked after a certain number of consecutive failed log on
attempts. Please contact your network administrator if you have problems with the log-on
process.

password are correct. Letters in passwords must be typed using the comect

0 The software could not log you on. Make sure your Username and
case. Make sure that Caps Lock is not accidentally on.

T« Figure 142: Unable to log on to User Server software

To log off, click the Logoff icon on the toolbar ‘=== | or click Logoff from the User Server menu.
When you exit LogTag® Analyzer you will automatically be logged off.
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How users change their password

The User Server administrator may permit you to change your logon password.To do so click
Change Password from the User Server menu. You will need to supply your current logon
password, then enter the new password and a confirmation.

The User Server administrator may enforce certain password rules. For example, they may
require a minimum number of characters (digits, letters or symbols) or a minimum number of
digits to be included in the password, or both. Please contact your User Server administrator if
you have problems with the password change process.

Passwords should be chosen so they are difficult for someone else to guess. Following are a few
points to remember when changing a password:

1. Do not use something that is personal to the user. Birth dates, license plate numbers,
names of family members, types of vehicles owned, favorite foods and address of
residence are all examples of passwords that should NOT be used.

2. Do not write your password down.
3. Change your password on a regular basis.

If users forget their password, the User Server administrator will be able to change it. However,

administrators will not be able to see and therefore inform users what their current password is.

Username: User

Current Password:
New Password:

Confirm Password:

g OK e Cancel 0 Help

Figure 143: Changing a User Server password
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Connecting to Gmail

LogTag® Analyzer has the ability to connect to Gmail's SMTP server using your Gmail account.

Analyzer now supports the OAuth2 authorisation method, which makes it more secure to
connect but requires a few simple steps extra when you initially set up automated email
sending.
If you already connect to Gmail with an earlier version of Analyzer you will have enabled the
option Allow less secure apps in your Google account settings. You can continue sending
emails this way without changing any of the settings in Analyzer, however, we strongly
recommend to use the more secure OAuth2 authorisation method, as described below.

To use this method, select from the Automation tab in Options. You will see the
Email and SMTP settings dialogue. Click Use Gmail authorisation - the SMTP Server, Port and
SSL/TLS fields will now be set up automatically.

Do not enter anything else in the SMTP Server Settings section of the dialogue. Complete the
remaining entries in the Email Settings, Attach file... and Advanced Settings sections.

Once complete, click . Have your Gmail logon and password details ready.
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SMTP Server Settings
SMTP Server  smtp.gmail.com | Port: |587
(O No authentication B3 ssums
(8) Use Gmail authorization
O Use User Name and Passward

User Name

Password

Email Settings

sender Name | Your name

Emall |yourname@email.com |

Subject Line %PRODUCTID was successfully downloaded 'b w
Recipients | recipient@email.com
Add

Send test email

Attach file in the following formats

LogTag File (itd / ftdx / muitix) [ HmmML
[ ]esv comma gelimited) [ ] Text (Macintoshy
[]POF (Partable Document Format) [ | Text Tab delimited)

Advanced Settings

[¥] Loo uploads, log file in folder [ | Log connection errors

I:‘ Store pending uploads between sessions,
automatically resume uploads on program startup

o oK | Q Cancel 0 Help

Figure 144: Gmail settings selected
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Your default browser will now open. You will be asked to select which Gmail account you wish
to connect to. Enter the details of your Gmail account address.

Click Next and enter the account password.

LogTag Analyzer User Guide
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Google
Sign in

to continue to LogTag Analyzer

logtagrecorders@gmail.com|

Forgot email?

English (United States) = Help Privacy Terms

Figure 145: Enter your Gmail account details

Google
Hi LogTag

o logtagrecorders@gmail.com

To continue, first verify it's you

English (United States) = Help Privacy Terms

Figure 146: Confirming the account password
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Click Next and confirm that you agree to giving LogTag® Analyzer permission to send email
from your Gmail account.

Click Allow and your browser will show a message that it has successfully communicated with
LogTag® Analyzer and set up the appropriate permissions. Hi LogTag

. logtagrecorders@gmail. com
You can now close the browser window. 0 e o

Google

LogTag Analyzer wants to

®  sendemail on your behalf @

Allow LogTag Analyzer to do this?

s m

English (United States) - Help Privacy oIS

Figure 147: Giving LogTag® Analyzer permission to send email on your behalf

Received verification code. You may now close this window.

Figure 148: Success message
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At the same time LogTag® Analyzer will inform you that the connection to the Gmail SMTP
server was successful. (%]
When you now use the automated email function, the Gmail email will appear as the sender. Successiuy connected o fhe SMITP serverspearied
For security reasons this process needs to be completed within one minute. If you exceed the
allowed time LogTag® Analyzer will display a time-out message. ® =
0 Unless you have other applications that need to connect to your Google account, you Figure 149: Successfully connected to the Gmail SMTP server

can now switch the setting Allow less secure apps to Off. You can check which other
applications access your Google account in the section Apps with access to your
account in the account settings.

%)

SMTP Server srrorn Sending the Test Email Failad Chac your
SMTP and Email Settings: SMTP server authorication timeout

octurred

9 -

Figure 150: Time-out from SMTP server
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Getting more help

If you run into a problem with your recorder, you can click Request
help... from the Help Menu to contact the support team at LogTag®
Recorders. When you select this command, LogTag® Analyzer will
collect information from your system, that assists in diagnosing issues.

LogTag® Analyzer generates some or all of the following files:

« diagnostics.txt.gz
This file includes information about your operating system version,
installed languages, temporary folders, LogTag® Analyzer version
numbers and other system related information in a compressed
format

« UserProfile.profile.gz
This file contains the settings for LogTag® Analyzer in a compressed
format and can help identify issues with path names and sharing
settings

« AnalyzerErrorLog.dat
This file contains LogTag® Analyzer's error log

« XXDownloadFilenameXX.ltm
LogTag® Analyzer generates a special download file for any USB
recorder and any recorder or indicator in an interface attached to the
PC. These file(s) will have a *.1tm file extension (Logger Total
Memory), which can only be viewed with special diagnostic software
by LogTag® Recorders, but not with LogTag® Analyzer software
While the software is collecting this information, a message is
displayed. It is important you do not remove any recorders during
this process.

LogTag Analyzer User Guide

mm\p Topics
A user Guide

oﬂu Analyzer Home Page

O Request Help

@ Check Internet for updates

o About Analyzer

Figure 151: Requesting Help via the Help Menu

Please wait while diagnostic data is collected from your system, Please
do not remove loggers from the interface cradles until this process has
completed.

PP E RIS TP RS AT DI IIAI TS,

Figure 152: Diagnostic Data collection.
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LogTag® Analyzer will then open a message window, allowing you to
enter of your details.

Field What to enter

From Your email address, so we can contact you about
the problem

cc Email addresses of anyone you wish to share this
information with.

Message body Include as much detailed information in your
email as possible about the problem, such as what
you were doing at the time, or what application
the LogTag® product is used in.

Add file You can add files that help to describe your problem,
such as a screenshot or a specific LogTag® file that
causes the issue. You can easily generate a screen shot
with Windows' own snipping tool and save it to a file
before attaching it.

Once you have entered all details, click Send to submit the message to
LogTag® Recorders.

Note: When you click Request help... from the Help Menu
again, any existing files in the Diagnostics folder will
automatically be deleted. If you wish to keep a copy of the
files and the report LogTag® we suggest you put your own
email address into the cc field of the message.

LogTag Analyzer User Guide

From \youraddress@email.com
To software@loglagrecarders.com
Cc

Subject Analyzer Diagnostics Email

[ Please enter any additional information about the problem you are experiencing here:

Attachments -ﬁ;\-ﬂéeﬂ\:l-.l.se.lup p IZ-):!.t;’.ql-Rcan:\ir-\.g-\l:né'l’;g.;;h:-:al.ﬁ.e.l-E.l:rori..og,d..;t;ﬁ:-\;.l;el.'s{EJ-l.er-\;\i;)ﬂﬂ-a-ta-\..l.?-om;i-n:]‘

Add File

0 sed | QCamel

Figure 153: Diagnostics email message
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